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Basics

Discontinuations

Discontinuation of Windows® 7 and Windows® 8

Microsoft® has discontinued support for the Windows® 7 operating system in January 2020. For compatibility
reasons, HiCAD 2020 SP2 and HELiOS 2020 SP2 were the last versions of our CAD or PDM system to support
Windows© 7. HiCAD 2021 and HELiOS 2021 no longer run under Windows© 7, Windows© 8 and the cor-
responding server operating systems (Windows Server 2008 R2, Windows Server 2012 and older) are also no
longer supported. If an attempt is made to install HiCAD 2021 or HELiOS 2021 on a computer with Windows©
7 or Windows© 8, a message appears.

Discontinuation of "old" HiCAD itemization

As of HiCAD 2019 the “old” itemisation, i.e. the itemisation that was used up to HiCAD 2017, will only be avail-
able for model drawings that were already itemized with these functions. From HiCAD 2021 onwards, only the
“new” itemization will be supported. Please also read the information given in the Conversion of Old Itemisa-
tions topic.

Discontinuation of "old" OpenGL versions

From HiCAD 2021 on, only OpenGL version 4.3 is used in all HiCAD modules. Until now this was only the case
with the module HiCAD Point Cloud. This means that HiCAD 2022 can no longer be run on computers without
a separate graphics card. To avoid possible problems with onboard graphics cards, we recommend using a
stand-alone graphics card.

Discontinuation of old figure format (FIG)

The following notes regarding FIG-FGA conversion are unnecessary if HELiOS is used in conjunction with the
HELiOS Vault Server.

Since HiCAD 2017 we support FGA as figure format (before that FIG). From HiCAD/HELiOS 2021 or HELiOS
2021 as an update for HiCAD 2019/2020 onwards, we require that all figures stored with HELiOS have been
converted to the new FGA format beforehand. To convert existing 2-D FIG files, the tool Converter_FIG_To_
FGA.exe is available in the exe directory of the HiCAD installation.

If there are still unconverted FIG files in the HELiOS document database at the time of the database update, you
will be informed of the outstanding conversion of these files before the database update. In this case, the con-
version must be carried out before or at the latest directly after the update using Converter_FIG_To_FGA.exe.
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Discontinuation of the "old" Create detail drawing function

With the release of HiCAD 2012, the previously valid workshop drawing functionality in Steel Engineering had
been extended to a function for general drawing derivation. The previous functions for detail drawings in Steel
Engineering were still available in the Detail drawing section of the Drawing menu. As of HiCAD 2022 (Version
2700.0) these functions are no longer supported.

Discontinuation of HELiOS 32-Bit and HiCAD Viewer 32-Bit

As of HELiOS 2022 (Version 2700.0), a 32-Bit version for HELiOS and the HiCAD Viewer will no longer be avail-
able. However, the interface to 32-Bit applications such as Office will still be possible and is not affected by the
discontinuation of the 32-Bit installation of HELiOS.

Discontinuation of CADENAS PARTdataManager

As of HiCAD 2022 SP2, the CADENAS PARTdataManager will no longer be supported. Thus, the functions
Insert main part, PARTsolutions (CADENAS program) and Import PARTsolutions part will no longer be avail-
able from SP2 onwards.

Discontinuation of 3-D projection grid

As of HiCAD 2023, the 3-D projection grid function is no longer available.
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Service Pack 2 2023 (V 2802)

Automatic data save with higher performance
As of SP2, when using the automatic data save, the polygon models of parts are no longer saved, but are only recal-
culated when a drawing is restored. This improves the performance of automatic data save for drawings with very
many parts

The behaviour can be influenced in the Configuration Editor at System settings > Data save via the checkbox Quick
data save The checkbox is active by default

Please note the following:

n The polygon models of reduced loaded parts are always saved - regardless of whether the checkbox is active or
not.

n In rare cases it can happen that users change the display accuracy of individual parts. In this case, the rep-
resentation would have to be re-adjusted after the restoring. If you work specifically and frequently with display
accuracy, you should deactivate the checkbox.

Itemisation

Itemisation - minor text changes

The term "Itemisation mode Standard" has been replaced in SP2. In this context, the function "Switch to standard
itemisation" has been renamed Switch from itemisation up to HiCAD 2017.

In addition, texts have been adapted in Configuration Editor at System settings > Itemisation or System settings >
Itemisation > Migration:

up to HiCAD 2023 SP1 as of HiCAD 2023 SP2

Presettings that are entered as drawing prop-
erties when fixing the itemisation mode Stand-
ard..

Default settings are entered in the drawing properties in the
first situation in which they become relevant.

When switching to the itemisation mode Stand-
ard, use the stored default settings.

When switching from the Itemisation up to HiCAD 2017, do
not perform a conversion, but use the stored default set-
tings.
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Itemisation - HELiOS Article reference attributes

As of SP2, the article reference attributes defined in HELiOS can also be used as a sort criterion in itemisation, for
example Tensile strength. These are offered in the selection list on the Attributes tab when adding and editing attrib-
utes.

In practice, frequently used article reference attributes are

n Customer,

n Material and

n Manufacturer.

Note that if you have not already done so, you must first define these as reference attributes in HELiOS.
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Itemisation - Sort numbers

In practice, a sorting is often desired in which the numbers are not sorted as text, i.e. alphabetically, but as num-
bers. Therefore, as of SP2, it is possible to specify for many attributes how the sorting should be done for the respect-
ive attribute. For this purpose, the Attributes tab has been adapted accordingly. New is the column Options, in
which you can select the sorting mode by clicking on the corresponding symbol:

Compare digits like letters

Example: IPE 100 < IPE 80

Compare numbers as a whole

Example: IPE 80 < IPE 100

The default setting as of SP2 is Compare numbers as a whole .

A simple example:

Please note:

n The setting of the sorting mode Compare numbers as a whole is lost if the drawing is opened and saved with
HiCAD 2023 Version 2801.X or 2800.X.

n If a drawing is loaded that contains itemisations from an earlier HiCAD version (before HiCAD 2023 SP2), the set-
tings used there are active.
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Itemisation - User-defined sorting for HELiOS attributes with Predefined lists

Item numbers can also be sorted by HELiOS attributes with Predefined lists. Until now, however, the order resulted
from the alphabetical order of the language-dependent texts. As of SP2, it is now possible to change the order indi-
vidually. For this purpose, two new icons are available on the Attributes tab.

Sort alphabetically

This icon is only displayed for HELiOS attributes with Predefined lists. These are multilanguage attributes, such as
the part type (COMPONENT_Type) and - if defined accordingly in HELiOS - string or integer attributes. With a click

on the icon you switch from alphabetical sorting to user-defined sorting. The icon representation changes to . In

this case, the Determine user-defined order icon is also displayed.

Determine user-defined order

With a click on the symbol you can individually change the sortting order for HELiOS attributes with Predefined lists,
e.g. for the article attribute Part type (COMPONENT_TYPE):
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Behaviour of BOMs when updating derived drawings
BOMs that are aligned to the drawing frame (option Quantity list in drawing frame.../Structure list in drawing
frame...) are only rearranged when updating derived drawings if the views are also rearranged. This means that the
checkbox Rearrange views must be active.

If no rearrangement takes place, HiCAD still ensures that the fixed point of the BOM corresponds to the settings of
the drawing derivation.

Example:

If the BOM is arranged in the top right corner, then the top right corner of the BOM will still be in the top right corner
of the view frame. If the BOM has become longer or wider, then - to ensure this - it is moved if necessary.

What's new? 21 / 382

News Overview

../Werkstattzeichnung/Werkstattzeichnungeinstell.htm
../Werkstattzeichnung/Werkstattzeichnungeinstell.htm


Dimensioning Rules Editor - Development view
In the Dimensioning Rules Editor, as of SP2, the rules for the development view of Sheet Metal parts can also be
defined. For this purpose, the dialogue window has been extended by a corresponding tab.

Please note:
In the drawing derivation, these rules are only taken into account if the options for dimensioning are
activated accordingly in the settings for sheet developments, e.g. like this:

New dimensioning rules for agraffes

For the two dimensioning rules, an isolated point was added to the agraffe in the bore pattern. This point serves as a
dimensioning point and has the designation Dim.
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(1) Dimensioning point of the agraffe in the sheet, side view from left; (2) Dimensioning point of the agraffe in
the sheet development
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ICN Part structure display with grid lines
To further emphasize the levels of the part structure, grid lines can be displayed by activating this checkbox.

Left: with grid lines, Right: without grid lines

Customise context menus
The Maximum number of buttons per row in the context menus for parts etc. is now preset to 12. This only applies to
new installations. Customised menus do not change during an update installation.
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Change assembly coordinate system
Like every part, an assembly also has a part coordinate system. Until now, this coordinate system could either be
determined automatically by HiCAD or by you when creating the assembly. A corresponding parameter is available
in the Configuration Editor at Modelling > Part creation > Assembly.

As of HiCAD 2023 SP2 you can also move the part coordinate system of assemblies with the new function Change

assembly coordinate system (Drawing > Others > World CS > ...).

Note that this can also change the geometry and position of the parts in the drawing. Referenced parts
will change at all points of use.

Please also see the examples for Feature and Parametrics.
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Extension of the Design Checker for Sheet Metal parts
By setting the part orientation you can determine which view of a part should be the front view or the top view. This is
also evaluated when creating the production drawings. Since SP1 it is possible to check for Sheet Metal parts during
the creation of the production drawings whether the part orientation has been set accordingly. To do this, the check-
box Check part orientation for Sheet Metal parts must be activated in the Configuration Editor at Automatic drawing
derivation > Production drawing.

As of SP2, this can also be checked via the Design Checker - independent of the setting in Configuration Editor. The
Design Checker has been extended accordingly.
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Updating mounting drawings
When updating mounting drawings that were created with the setting

New view group via active assembly(-ies)

only the parts of the view group that belong to the selected assemblies are taken into account from SP2 and not all
parts that lie within the bounding box.

Support of the new SpaceMouse®

When working on 3-D drawings, you can use a SpaceMouse®in addition to the standard mouse. HiCAD supports
the current models from 3Dconnexion. To connect to HiCAD, install the current software 3DxWare from 3Dcon-
nexion GmbH on your computer.

By pressing, pulling, rotating and tilting the controller cap (control knob), you can rotate, move and enlarge or
reduce your 3-D drawing in HiCAD, regardless of the SpaceMouse type. The navigation in the Object Mode of the
SpaceMouse® behaves as if you were reaching for the 3-D part and holding it in your hand.

The rotation point for stabilising the rotation is automatically placed on the nearest part. If you move the standard
mouse, the rotation point also changes.

The MENU button on the SpaceMouse® or 3Dconnexion Home (on your Desktop) will take you directly to the
3Dconnexion Settings. Via Advanced Settings you can configure the default behaviour of the controller cap in
HiCAD.

Some HiCAD functions (such as Save drawing) are pre-assigned to the buttons of the SpaceMouse®. With the
SpaceMouse® Enterprise, the HiCAD functions are shown with text and icon in the display of the mouse. To cus-
tomise the function keys for your company, call up the 3Dconnexion Settings. Then click on Buttons. Click on the

arrow next to the function name and select a different HiCAD function. Click on Close to save the new assign-
ment of the function button.
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HiCADGUIReset - Restore defaults
The functions of HiCADGUIReset can now also be executed automatically by specifying various options, i.e. without
displaying the dialogue window.

Analogous to the functions of the dialogue window, the following options are possible:

Option Effect Example

-Save  Date iname Save GUI settings HiCADGUIReset   -Save  D : \GUI \GUI1 .h icadgu i

-Load  Date iname Load GUI settings HiCADGUIReset   -Load  D : \GUI \GUI1 .h icadgu i

-ResetA l l Restore DUI delivery state HiCADGUIReset -ResetA l l

-Reset IDs Reset button IDs HiCADGUIReset -Reset IDs
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Service Pack 1 2023 (V 2801)

Product extension
The Coating function is now also part of the basic HiCAD creator and HiCAD solution models. This means that the
function is also available in all industry suites.

Part filter extension

The Find function in the transparent toolbar has been extended to include filters for profile installation. With the
new rule Properties > Profile sub-part type (Profile Installation) the sub-part types
n Contour, cut,
n Contour, uncut,
n Sandwich panel, outside sheet,
n Sandwich panel, inside sheet,
n Insulation and
n Others, e.g. sealing chords.

can be easily selected.

.
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Units in the Configuration Editor
In the Configuration Editor, under Extras, you can set whether the values specified there for length and weights
should be displayed in metric units (millimetres and kilograms) or in imperial units (inches and pounds).

The numbers are displayed rounded, with the unit following. If the values are edited, no rounding will occur, but the
numbers will be displayed exactly.

Examples:
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If the setting under Extras is changed, the values will be converted accordingly, e.g.

The setting of the units of measurement under Extras only affects the display in the Configuration
Editor. When drawing in HiCAD, the values are always converted to the unit of measurement of the
drawing.
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Sheet name - Placeholder during printing
In the printer output there is now a placeholder for the Sheet name called <SheetName> which can be used in the
XPS and the ISD FilePrinter output to generate the file name. For this purpose, the context menu under Post-
processing Command line has been extended on the PS/XPS Settings tab.

This concerns the functions

Drawing > Save/Print > Print > Active drawing and

Drawing > Save/Print > Print > Selected model drawings.

Examples:

n C:\Program Files\gs\gs9.54.0\bin\gswin64c -dNOPAUSE -dBATCH -dPDFA -sDEVICE="pdfwrite" -sOut-
putFile="<FilePath><SheetName>.pdf" <CurrentFile>

n C:\Program Files\gs\gs9.54.0\bin\gswin64c -dNOPAUSE -dBATCH -dPDFA -sDEVICE="pdfwrite" -sOut-
putFile="<FilePath><FileName><SheetName>.pdf" <CurrentFile>

.

Regarding the Sheet name, i.e. the placeholder <SheetName>, please note the following:

n All not allowed characters are replaced by an underscore _ in the sheet names. Not allowed characters
are:\:/\"<>?*|.

n If the sheet names are the same, a new name will be generated automatically, e.g. MySheet -> MySheet(2) ->
MySheet(3) ...

n For merged PS files, the name is composed of the output sheet names (separated by commas). The length is
limited to 32 characters. E.g. MySheet1,MySheet2,MySheet3.pdf
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Hatching settings

New under Drawing > Properties is the Hatching settings function.

Use this function to define the default settings for the hatching of cut surfaces created by sectional views, cut-outs
and detail views. The settings apply to hatchings in the current drawing and are saved together with the drawing.

The previous functions

n Acc. to material catalogue,

n Parallel lines and

n Scale-dependency

have been integrated into the new function.

A new feature is that it is now possible to specify how neighbouring parts are to be visually delimited from each other
in a sectional view. This can be done by rotating the hatching angle or by vertical mirroring.
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Sometimes, however, changing the hatching angle is not sufficient to clearly delimit neighbouring parts from each
other. This can be the case, for example, when several parts touch each other (see example). If the Reduce hatch-
ing distance if required checkbox is active, the hatching distance is also used for delimitation. This means that the
hatching distance of individual parts is reduced.

Example

We consider four cuboids that touch each other. We want to create a sectional view with the sketch shown as the
section path.
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The following image shows that not all parts can be clearly distinguished from each other using only the hatching
angle.

In this case, it is recommended to activate the Reduce hatching distance if required checkbox.
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Easier identification of plug-in arrows
The plug-in arrows - as used, for example, when defining a detail view of type cuboid or when clipping point clouds -
are now easier to identify. The arrows are already identified when the cursor is in the "vicinity".
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Mounting drawing - View group above assemblies
When creating mounting drawings, it is now possible to create the view group above the active assembly or the selec-
ted assemblies.

The view group is determined by selecting/defining a processing plane when calling the function for the active
assembly or the selected assemblies. The same options are available for selecting/defining the plane as for the 3-D
processing plane function. The box is created by extruding the processing plane to the front and back - considering
the offset specified in the extended settings. The size of the box is determined here by the active assembly or the
selected assemblies when the function is called.

Example:

A mounting drawing of the two selected assemblies is to be created.
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The XZ plane of the world CS is selected as the plane.
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Result:
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Derived drawings - Check part orientation for Sheet Metal parts
By setting the part orientation you can determine which view of a part should be the front view or the top view. This is
also evaluated when creating the production drawings.

For Sheet Metal parts, you can check whether a part orientation is set when creating the production drawings. To do
this, the new checkbox Check part orientation for Sheet Metal parts must be active in the Configuration Editor
under Automatic drawing derivation > Production drawings. If the default setting is used, the checkbox is inactive.

If the checkbox is active and if bending plates without part orientation are found when creating the production draw-
ing, a corresponding message appears:

If you choose Yes, the drawings will be created anyway, if you choose No, the drawing creation will be cancelled.

This parameter also has an effect on the Drawing Management.

Itemisation - Automatic conversion of the "old" itemisation with default favourites
The conversion of previous itemisation of drawings (before HiCAD 2018) to the HiCAD standard itemisation can now
also be performed automatically, i.e. without displaying the itemisation dialogue. For this purpose, the checkbox
When switching to the itemisation mode 'Standard', use the stored default settings is available in the Configuration
Editor under System settings > Itemisation > Migration.

If the checkbox is inactive, then the dialogue of itemisation with options will be started, as before.

If the checkbox is active, then the conversion will be started directly - without displaying the dialogue of the standard
itemisation. The Favourites file selected in the Configuration Editor under System settings > Itemisation > Updating
will be used.
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Major Release 2023 (V 2800)

Units of measurement

Drawing - Free choice of unit of length

The previous version HiCAD 2022 only supported drawings with the unit of length millimetre. As of HiCAD 2023, the
unit of length can be selected under System settings > Units > Unit of length in the Configuration Editor. This
means that designing in non-metric units is now also possible.

Please note the following:
The settings selected under System settings > Units only apply to newly created drawings. These set-
tings cannot be changed in the drawing itself.

Please note:

All values inputs in HiCAD are evaluated in the currently set units of measurement. It is also possible to use mixed
units. For example, if you have set mm as the unit of length of the drawing and used 1 3/4" + 12.5 mm as the value
in a function, the value will be converted to mm, i.e. the result will be 56.95 (mm). If you point to an input field in the
dialogues with your cursor, the system will show in which unit the respective value is, e.g.:
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In the value inputs where no formulas, fractions, variables, units and spaces are supported, e.g. in the Part attrib-
utes dialogue, such inputs will be rejected with an error message, e.g.

Units of the model drawing

New in the Help Topics and Information is the Units of the model drawing function, which can be used to display
the current settings for units, e.g. length, surface, volume etc.
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Selecting the region in the parameter configuration

Both during installation and during subsequent parameter configuration with the ParKonfigComp.exe tool, you can
now select the region.

Please note the following:

If you activate North America as the region, the system will automatically switch to imperial, i.e. non-metric
units. This applies to:

n units of the drawing,

n dimensions and

n scales.

This means that settings made in the Configuration Editor may be replaced if necessary!

This applies analogously to the region Europe. Here, a conversion to metric units, dimensions and scales takes
place.
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Constraints in drawings with a unit of length different from mm

If you have selected a unit other than millimetre mm as the unit of length of the drawing, individual functions will not
be available. These functions will be greyed out in the ribbons and menus and a corresponding message will be dis-
played in the tooltip.

This applies, for example, to the functions

n Information > 3-D, Further > Cylindrical pin calculation,
n

Information > 3-D, Further > Radial pin calculation,
n

Steel Engineering > Plate, new > Rectangular plate,

n Steel Engineering > New > Insert series, via DB document master,

n Steel Engineering > New > Insert series, via DB article master,

n Metal Engineering > Others > 2-D section of 3-D facade,

n Metal Engineering > Metal Engineering, 2-D > Sealant/Foil,

n Metal Engineering > Metal Engineering, 2-D > Sheet,

n Metal Engineering > LogiKal, 2-D > Insert facade + inserts from existing LogiKal project,

n Metal Engineering > Interfaces > Create WinIso2D part,

n Metal Engineering > Interfaces > Export to eluCad,

n Sheet Metal > New > Pipes + Vessels

as well as individual Plant Engineering and P+ID functions.
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Drawing frame for North America
If North America is selected as the region during installation or during subsequent parameter configuration, addi-

tional drawing frames are available in the Insert drawing frame function.
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Formulas, mixed numbers and units when entering points
In the numerical point options, you can enter the numerical values required for the point option in one step, e.g. rel-
ative coordinates. Formulas and mixed numbers are now also permitted, e. g. (a+b), 1/2, 1 3/4" + 12.5 mm. In this
case, you must note the setting in the Configuration Editor under System settings > Miscellaneous > Pocket cal-
culator.

n Space
With this setting, the different entries must be separated by spaces. If formulas, mixed numbers or mixed units
are used, they must not contain spaces. This is the ISD default setting.

n Semicolon
If you want to use formulas etc. with spaces, you must select this setting. The different entries must then be sep-
arated by semicolons.

Example:

You want to use the coordinates X=(a+b)/2 y=70, z= 90 for the point option R, where a and b are part variables with
the values a=50 and b=7.

Setting Entry Result

Space R (a+b)/2 70
90

28.5 70 90 correct

Space R (a + b)/2 70
90

Returns 0 as X value and queries the other
coordinates

false

Semicolon R (a +
b)/2;70;90

28.5 70 90 correct
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Mark-up and Redlining
The HiRedLine tool allows you to add comments or modification suggestions to a HiCAD drawing, without changing
the original file.

As of 2023, this tool is only available as part of a HiCAD/HELiOS installation. In case of a standalone installation of
the HELiOS Desktop, starting it will no longer be possible.

Ribbon adjustments
The Drawing, Views and Sketch ribbons have been slightly modified and tightened. The most important adjust-
ments at a glance:

Drawing

n The print functions have been combined in a pull-down menu.

n You can now send drawings via e-mail under Save as.

n The Variant Editor has been moved to the Extras menu.

n You can find the functions for the creation and updating of mounting drawings as well as the templates and
dimensioning rules/settings for the drawing derivation in the pull-down menu of the drawing derivation.

n The insertion of drawing frames has been moved to the Itemisation/Detailing area. You can complete the title
blocks using the functions of the pull-down menu.

n Showing/hiding by element type has been moved to the Properties area.
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Sketch

n You can close internal corners and lengthen/shorten lines directly via the Sketch ribbon.

n You can directly access the functions for setting/deleting auxiliary geometry from the Sketch ribbon.
n The functions under Transform/Clone have been arranged differently.

Views

n The functions for hiding and freezing have been each combined in a pull-down menu.

n The functions for updating cut-outs, sectional views and detail views have been combined in a pull-down menu.
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User libraries
As of 2023, the functions for part and macro libraries are no longer available in the Drawing ribbon during a new
installation. Existing customers who wish to continue using their existing libraries can switch on the functionality in
the Configuration Editor under Compatibility > User library up to HiCAD 2022 by activating the corresponding
checkbox.

When updating from a version prior to HiCAD 2023, the user library is still switched on for existing customers. In the
case of an update from HiCAD 2023, the current setting from the Configuration Editor will be adopted.

Moving the screen display
The screen display can now also be moved by holding down the right mouse button and dragging the display to the
desired position. This corresponds to the behaviour of the CTRL + middle mouse button combination. If the right
mouse button is simply pressed, the 3-D view context menu will be called instead.
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Derived drawings

Annotation of identical bores

You can use the Dimension Settings function to combine individual bores which do not belong to a bore pat-
tern on the Annotations tab by activating the Specify number of bores checkbox. The annotation will then occur
only once with specification of the number.

If only one annotation is to be set for all identical bores - regardless of whether they are individual bores or bore pat-
terns- this can be set via the Annotate each hole diameter only once checkbox.

Left: Model with (a) bore pattern 3 x Ø2 as well as (b) two individual bores Ø2 and (c) two individual bores Ø1
Right: Detail of the workshop drawing
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New usage for sheet metal assemblies

A new usage is available for sheet metal assemblies, i.e. assemblies with a sheet as the main part: Sheet Metal
Assembly. For this purpose, the Factory standards > Usage catalogue has been extended accordingly.

For assemblies with this usage, usage-dependent configurations can be used for drawing derivation, which are man-
aged in the ISD Configuration Editor, as for other usages. By default, the configuration ASSEMBLY_SHEETMETAL is
predefined for assemblies with the usage Sheet Metal Assembly.
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Production and mounting drawings - Drawing frames

As of HiCAD 2023, two additional parameters are available for production drawings in the Configuration Editor under
Automatic drawing derivation > Production drawing > Drawing frames.

Use frame

This checkbox determines whether the frame should be offered for selection in the Drawing derivation dialogue or
not. The ISD default setting is yes, i.e. the checkbox is active.

Detail of the Drawing derivation dialogue
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Automatic determination of geometric data for the drawing frame

For each drawing frame,

n the distance of the insertion point from the centre of the frame,

n the size of the usable area (frame height / frame width) and

n the size of a blocked frame area (for the title block, BOMs or comments)

can be defined. If the blocked area is specified incorrectly or is missing, the automatic drawing derivation may cause
views to collide with the title block.

If the blocked area of a frame is to be determined automatically during drawing derivation - including the width and
height of the usable area - this can now be achieved by activating the Automatic determination of geometric data
for the drawing frame checkbox. This is the ISD default setting for the drawing frames included in the delivery. If the
checkbox is active, only the figure name can be specified if required. All other settings can be omitted.

Please note:
The prerequisite for this automatism is that the FGA file of the drawing frame fulfils the following criteria. This
must be taken into account when using custom drawing frames:

n The figure contains a point withpoint number 1000, which is located inside the frame (insertion point).

n The textblock is called SCHRIFE.

Analogously, the parameters listed above are also available for mounting drawings under Automatic drawing deriv-
ation > Mounting drawing > Drawing frames.
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Using frame/scale lists

During drawing derivation, there is often a desire to display everything on one sheet if possible. Sometimes it is also
desired that sectional views, developments or axonometries should have different scales than the main view. Addi-
tionally, there are situations where the customer wants a certain drawing frame to be filled with views at an optimal
scale. For example, a drawing frame DIN A2 should be used and the scale of the views should be adjusted accord-
ingly. However, if the scale falls below 1:10, another drawing frame should be used.

This cannot be configured in the options of the drawing derivation. Here the new function Frame/scale list is
the ideal solution.

Similarly to the dimensioning rules, this function can be used to define separately for each purpose, for example for
assemblies, I-beams, sheets, etc., which drawing frames combines with which scales should be used. This also sig-
nificantly increases performance when creating drawings, as HiCAD does not have to search through all drawing
frames and scales.

Example of a frame/scale list for sheet metal parts
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But what is the effect of the example shown above?

If the list is activated, then during drawing derivation, instead of the other settings for frame sizes and scales the list
entries will be checked in sequence until a drawing fits on a sheet.

Thus, in our example, the following is checked for the detail drawings of sheets:

1. Does the drawing fit into the DIN A3 frame if main views and developments are shown at a scale of 1:2.5, axono-
metries at a scale of 1:1 and sectional views at a scale of 1:5? If yes, the drawing will be created and not checked
further. The figure shows an example of the corresponding view structure.

If no, step 2 will be executed.

2. Does the drawing fit into the DIN A3 frame if main views and developments are shown at a scale of 1:5, axono-
metries at a scale of 1:1 and sectional views at a scale of 1:10? If yes, the drawing will be created and not
checked further. If no, step 3 will be executed.

etc.

If the drawing does not fit any of the frames, a corresponding message will be displayed:

Please note:
Frame/scale lists are only taken into account during drawing derivation if

n the Use frame/scale list checkbox is active for the respective usage and

n the Drawing parameters from configuration option is active in the drawing derivation dialogue.
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New system attributes
In HiCAD, new system attributes are available for sheet metal parts and coated surfaces:

Attribute name Attribute description Type

§CW Weight from rectangular surface of development DOUBLE

§S2D Rectangular surface of development DOUBLE

§SC Coated surface DOUBLE

§SOC Surface from development contour DOUBLE

New docking window for variables
The docking window for variables docking window for variables has been completely revised for HiCAD 2023. In con-
trast to the old variable window, the entries no longer have to be saved or discarded using OK or Cancel. Instead, you
can activate or deactivate the automatic feature recalculation. If it is activated, a recalculation takes place after every
action in the variable window. An exception is the change of the comment.
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2-D

Major Release 2023 (V 2800)

Modifications of the Ribbons
The Ribbon tabs Drawing, Views and Sketch have been slightly modified and streamlined. As a result, the 2-D func-
tions for Visualisation can now be found at Drawing > Properties > Visual. > 2-D Parts: Visualisation....
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3-D

Service Pack 2 2023 (V 2802)

Cams and cam processings
The cam creation creates cams on one part and slots (holes) in which these cams fit on another part. In doing so,
you can specify how the cams and corresponding slots should look and how they should be arranged along the
selected parts. The following functions are available as of HiCAD 2023 SP2:

Cams

With this function, a part is provided with cams.

Cam processing
This function creates slots or holes on one part into which the cams of another part fit.

In contrast to the previous design variants to cam connections, the new functions cover significantly more practical
cases and are suitable for a fully referenced working method. For example, individual cams can be placed freely
here, the cams can also be distributed unevenly and they can have different edge distances on the sides. Fur-
thermore, not only sheet metal is supported but cams can be applied to almost all types of parts - also on thin-walled
solids.

The image shows different cams and the corresponding cam processings.
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Part orientation and dimension alignment
The part orientation functions have been extended. With the functions under Drawing > Orient... > Part orientation
can now be used to set or reset the part orientation of multiple parts one after the other without having to call the
function again.

After calling the Front view or Top view function, first select the part whose orientation you want to
change and then the desired plane for the front view or top view. The same functions (right mouse button) are avail-
able for the determination of the plane as for the determination of processing planes. If the dimension alignment dis-
play is also active, the enveloping cube and the orientation symbol will be updated immediately. You can then
change the orientation of further parts or correct the orientation directly by selecting the previously selected part
again. You can terminate the function with the middle mouse button.

The corresponding functions in the context menu apply only to the active part and are automatically terminated.

In addition, the display of the part orientation has been extended. If the orientation display is active, the orientation
of the part will be indicated by a space cube and an additional symbol for the source of the orientation.
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Meaning of the annotations

The orientation corresponds to the part coordinate system.

The orientation results from the bearing bar direction (only for gratings DIN 24537).

The orientation results from the processing direction.

The orientation was set manually.

The orientation results from the part coordinate system of the assembly main part.

The orientation results from the bearing bar direction of the assembly main part (only for gratings
DIN 24537).

The orientation results from the processing direction of the assembly main part.

The orientation of the assembly main part was set manually.

During the calculation of dimensions, the bearing bar orientation of gratings is assigned to the Length attribute
($03). The bearing bar orientation is ignored in the calculation of dimensions if the direction is set manually for the
grating. This concerns the following cases

n The dimension direction is set.

n The part orientation is set.

n The processing direction is set.

As with the part orientation, the bearing bar orientation is also taken into account when annotating the dimension ori-
entation.

The dimensions are current, the dimension orientation results from the bearing bar direction (only
for gratings DIN 24537).

The dimensions are current, the dimension orientation results from the bearing bar direction of the
assembly main part (only for gratings DIN 24537).
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Dimension calculation of beams and Steel Engineering plates
Beams

If the automatic calculation of dimensions is active in the Configuration Editor under Modelling > Part properties,
then as of SP2 the dimension calculation can be restricted via the checkbox Calculate only length for beams. If the
checkbox is active, only the length is determined by the automatic calculation of dimensions when it comes to
beams. This means that any values for width and height from the catalogue are retained.

By default, the checkbox is inactive.

Steel Engineering plates

If the automatic calculation of dimensions is activated in the Configuration Editor, then length, height and width are
calculated and assigned to the attributes Length ($03), Width ($02) and Height ($04).

If the automatic calculation of dimensions is deactivated, then length, height and width are assigned by the Steel
Engineering functions. Length and width are sorted. This means that the largest value is assigned to the length.
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Dimensioning

Changed default setting for dimension assignment

The ISD default setting for the dimension assignment has changed. As of SP2, 3-D dimensions are assigned by
default to the part to which the first dimension base point belongs. The default setting can be changed in the Con-
figuration Editor under System settings > Annotations > Dimensioning, 3-D > Interactive dimensions. The changed
default setting applies to new installations only.

New dialogue for form/positional tolerances

The functionality for generating form and positional tolerances has been completely revised.

With the new Form/Positional tolerances (3-D) function, tolerances with reference symbol (DIN EN ISO
5459) as well as form/positional symbols (according to DIN EN ISO 1101 and 14405-1) can be conveniently cre-
ated.

The previous functionality Form/Positional tolerances is still available in the menu under 3-D Dimensioning
+ Text > Symbols > Form/Pos. If a drawing contains tolerances that were created with this function, the "old" dia-
logue will be displayed for editing these tolerances.
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Variable dimensioning - Removal of structure dimensions

Previously, variable dimensioning could also be used to generate structure dimensions, although the waiting times
here were significantly higher than for the corresponding functions in the Parallel, Direct, Angle and Arc function
groups in the 3-D Dimensioning+Text ribbons.

For this reason, the creation of structure dimensions with the Variable dimensioning function is no longer
possible as of SP2.
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Extension of the dimension tables

As of SP2, additional functions are available under 3-D Dimensioning+Text > Tools > Extras in the Further table
functions menu:

DIN EN ISO 13920 Table 1 - Limit dimensions for linear dimensions

DIN EN ISO 13920 Table 2 - Limit dimensions for angular dimensions

DIN EN ISO 13920 Table 3 - Straightness, flatness and parallelism tolerances
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In addition, the tooltips in the menu have been revised and are now more expressive, e.g.
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Views

Transfer part representation in view

In addition to the "normal part properties, parts can also be assigned to properties that apply only to a specific view.
You assign these view properties of parts with the functions under Properties > Properties in view of the context
menu for parts. In addition, individual edges of parts can be shown/hidden on a view-by-view basis using the Views
> Properties > Elements function.

With the new Transfer part representation in view function, the above-mentioned view properties of a part
can be transferred to other views as of SP2. The dialogue window shown in the image is displayed for this purpose.
The image shows the ISD default setting.

The function is only available in the context menu for 3-D views. Right-click on a view frame or on the
name of a view in the ICN.

The dialogue depends on whether an individual view is active (1) or multiple views are selected in the ICN (2) when
the function is called.

Individual view

If an individual view is active, then this view is the initial view. The name of the view will be displayed in the dialogue.

To change the initial view, click on the symbol. If the initial view is correct, select the target views, i.e. the views
for which the properties of the initial view are to be applied. If an already selected target view is selected again, it will
be removed from the selection list.
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Multiple selection

If multiple views are selected, then these are the target views. If you want to add or remove target views, click on

. When the target views are selected, select the initial view in the drawing by clicking the view frame.

After selecting the initial and target views, select the properties to be considered. To do this, activate/deactivate the
corresponding checkboxes. You can also use the following buttons for selection:

Activating all checkboxes

Deactivating all checkboxes

Activating the default settings

Only when you click OK, the transfer will be started and executed.

Highlighting view lists

As of SP2, disabling the view marking in the Configuration Editor only affects the active view. If a view list is active,
i.e. at least one view is highlighted in blue in the ICN, then the views in this list will always be marked by a wider
dashed frame.

This affects the parameters

n Highlight active view in model area and

n Highlight active view in drawing sheets

under System settings > Visualisation > Views > Frame of active view in the Configuration Editor.
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View captions - Multiple selection

As of SP2, the functions

Create/edit/delete view caption(s) and

Delete view caption(s)

support multiple selection of views. This means that if multiple views are selected in the ICN, the functions act on all
selected views. For example, the orientation of multiple views can be changed in one step or the caption can be hid-
den.

When using the Create/edit/delete view caption(s) function, note the following:

If multiple views are selected in the ICN when the function is called, the View designation is greyed out, since it gen-
erally does not make sense to give multiple views the same designation.

If none of the selected views has a caption, then all views will automatically receive a caption. The caption of the indi-
vidual view can be further edited afterwards.

If at least one of the selected views already has a caption, the existing captions can be changed. Views without a cap-
tion initially remain without a caption. By activating the Show caption checkbox, however, captions can also be cre-
ated and further edited for these views.

The functions are also available in the context menu when a multiple selections are made in the ICN.
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Example:

In the image 4 views - all without caption - have been marked (1). If the Create/edit/delete view caption(s)
function is then called, all views receive a caption - here the view designation (2). If the position of the caption is now
changed and edited as shown, the orientation and caption of all selected views will be changed (3).
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Sectional/detail views, cut-outs - hatching of adjacent parts

Since HiCAD 2023 SP1, it has been possible to define in the hatching settings of the drawing how neighbouring
parts are to be visually separated from each other in a sectional view. This can be done by rotating the hatching
angle or by vertical mirroring. Previously, parts had to be contiguous without gaps for them to be considered adja-
cent. As of SP2, smaller gaps between parts are now also possible. This means that the visual borders also apply to
"almost neighbours".

What's new? 71 / 382

News Overview

../../../hicadbasics/Content/Konstruktion/Konstruktionseigenschaften/koneigensch5.htm


Sketches

Transform/clone sketch elements - isolated points

When transforming and cloning sketch elements and isolated points, isolated points were previously not considered
if the elements were selected via a rectangle. As of SP2, isolated points are now also considered for this selection
type. This affects the following functions in the function groups Sketch > Transform and Sketch > Clone:

Transform Clone

Move sketch elements
Clone sketch elements, move

Move sketch elements, move+rotate Clone sketch elements, move+rotate

Rotate sketch elements Clone sketch elements, rotate

Scale sketch elements Clone sketch elements, mirror

Mirror sketch elements Clone sketch elements, scale

Clone, copy line elements

The context menu of the line/point selection has been adjusted correspondingly.
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Revision of the Move + Rotate and Rotate functions

The Rotate sketch elements function has been revised. Here the input of the rotation angle in the dialogue
window is omitted.

As of SP2, after selecting the line element to be rotated, the rotation is determined as follows:
n Planar sketches

HiCAD requests the selection of the rotation point and another point. The angle to the X-axis can then be determ-
ined dynamically with the cursor on an angle grid.

New in the context menu is the Angle reference function. This function does not determine the rotation
angle to the X-axis, but to a line between the rotation point and a second point.

n 3D sketches
After the direction has been determined, the angle on an angle grid can be determined dynamically with the
cursor. If the Angle reference function is selected here, the perpendicular is rasterized from the selected point
to the selected axis. The angle is then referenced to this line.

By tapping the cursor with the left mouse button, the rotation is applied directly.Instead of dynamically determining
the angle of the rotation, it can also be entered explicitly in the HiCAD calculator. To do this, press the space bar,
enter the desired angle and press OK. After the rotation has been executed, the dialogue window will remain open
so that further lines can be rotated directly.
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These changes have also been incorporated into the Move and rotate sketch elements functions.
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Automatic scaling of planar sketches

Automatic scaling of sketches when setting HCM constraints has been optimised further. If the first length, distance
or radius constraint is assigned to a sketch, it is checked whether angle constraint (also aperture angles) have
already been assigned to the sketch. If so, the 3-D C-edge HCM scaling dialogue window will be displayed.

Sketch technology - Grid angle

The ISD default setting for the grid angle has changed. As of SP2, the default setting for the grid angle in the Con-
figuration Editor under System settings > Identification > Grid is 5°. Note that these grid settings apply not only to
the sketch technology, but also to other functions that use distance and angle grids. The changed default setting
applies to new installations only.
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Deactivate HCM for active sketch

The automatic setting of HCM conditions for sketches can now also be switched off on a sketch-by-sketch basis, i.e.
for the active sketch. This can improve performance for sketches with many lines. For this purpose, the HCM set-
tings for sketches have been extended accordingly.

Alternatively, you can also use the function in the context menu of the ICN.

If the active sketch already contains HCM constraints when you deactivate it, the following message appears:

When you click OK, all constraints of the sketch will be deleted.
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If the HCM is disabled, the HCM functions in the Sketch Ribbon will be greyed out.

Automatic deactivation of the HCM

As of SP2, the HCM for sketches will be automatically deactivated if it exceeds a certain number of lines during
3-D DXF import or when converting 2-D sketches. The number of lines is determined in the Configuration Editor
under System settings > Sketch HCM. The ISD default setting is 1000.

When importing or converting to HiCAD, the HCM functions of the Sketch Ribbon are then greyed out for
sketches that exceed this number of lines. If the HCM is activated for such a sketch, the following message will
appear:

Click Yes to activate the HCM.
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New part from 3-D sketch - optimised algorithm

The algorithm of the New part from 3-D sketch function has been optimised and now leads to better results
and ensures smoother surfaces.

Example:

Let us consider the 3-D sketch shown, which obviously represents a staircase - albeit a somewhat skewed one. Until
HiCAD 2023 SP1, it was not possible to convert this sketch into a solid, since the sketch contains lines enclosing
non-planar surfaces. As of HiCAD 2023 SP2, this is now possible, since the new algorithm automatically adds the
missing lines here.
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Extended functionality for processing planes

The Processing plane function now makes it easier to create processing planes tangential to non-planar, i.e.
curved, surfaces. After selecting such a surface, a preview of the processing plane will "hang" on the cursor. The
position of the plane can then be explicitly defined by selecting a point, e.g. by selecting a point on an attached part
or by using the 3-D point options. The point is projected onto the surface and its projection to the origin of the pro-
cessing plane. The processing plane is tangential to the selected surface.

(1) Selected surface, (2) Point in the centre of the rounding
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Furthermore, the context menu has been extended.

Plane perpendicular to screen plane

This function creates a plane perpendicular to the screen plane. The Z-direction of the plane is
determined by selecting two points or by selecting a line, and depends on the order in which the
points are selected or on which line end is closer to the cursor during the selection.

Tangential to surface with direction

The function replaces the previous function Tangential to surface, parallel to plane

With this function, you can place the processing plane tangentially to a surface. However, the dir-
ection must first be selected. This can be done by selecting two points, a straight line, a surface or
a processing plane. Once the direction has been determined, select the surface to which the pro-
cessing plane is to run tangentially. Only analytical surfaces are permitted.

(1) Direction, (2) Selected surface
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Execution of standard processing during the drawing derivation
Standard processings that are inserted using the functions under

Bores, Threads or

Through hole, variable

can be assigned a processing ID via the Feature log, which defined where the standard processing is to be per-
formed - on the site or in the workshop. The Type parameter is available for this purpose. During the drawing deriv-
ation, no distinction was previously made between the different versions when annotating standard processings.
This is possible as of SP2.

If this is desired, the following requirements must be met:

n Different annotation templates for workshop and site must be available as FTD files.

n In the Configuration Editor, under Drawing> Annotations > Annotation template, the checkbox Different annota-
tion for workshop and site must be activated. In the lines below, the annotation templates must be specified
including the path. The path can be a HiCAD drive letter or a Windows path.

If these requirements are fulfilled, then during the drawing derivation, standard processing operations are annotated
differently depending on the processing ID.
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Coat 3-D part

In addition to sheet metal parts and beams, the Coating function can now also be used to process general 3-D
parts. However, it is not possible to select a different coating for the back side here.

You can find the function under Sheet Metal > Process > Coating.
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Service Pack 1 2023 (V 2801)

Locking parts with multiple selection
Multiple selection is now also possible when locking or unlocking parts against processing.

Part and dimension orientation
Previously, the functions for determining Part orientation and Dimension orientation were only available in the con-
text menu for 3-D parts. As of SP1, you can also find them on the Drawing tab under Positioning/Detailing > Ori-
ent.... At the same time, the function icons have been modernised.

Calculation of dimensions - Sorting the attributes length, width, height
If the automatic calculation of dimensions is active, the dimensions of assemblies and parts are automatically cal-
culated by HiCAD and assigned to the attributes
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n Length ($03),

n Width ($02) and

n Height ($04)

of the part / assembly. As of HiCAD 2023 SP1, it is now possible to assign the dimensions to these attributes sorted
by size, i.e. the largest value is assigned to the length, the smallest to the height. To do this, the new checkbox Sort
dimensions must be activated in the Configuration Editor under Modelling > Part properties. By default, the check-
box is inactive.

Example:

Case 1:
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In the following example, the automatic calculation of dimensions is active, but the sorting is inactive. (1) shows the
initial situation. Now the height of the extruded solid is changed in the Feature (2). This changes only the Height
attribute.

86 / 382 What's new?

3-D



Case 2:

We consider the same example, but now both the automatic calculation of dimensions and the sorting are active. (1)
shows the initial situation. Now the height of the extruded solid is changed in the Feature (2). This makes the height
the largest value and assigns it to the Length attribute. The length value from step 1 becomes the width, the width
value becomes the height. This means that all attribute values change.

Switching on the sorting will only take effect after HiCAD has been restarted.

What's new? 87 / 382

News Overview



Itemisation

Transferring the part orientation during the itemisation

Parts with the same item number now have the same part orientation - analogously to the dimension orientation. In
detail, the procedure is as follows:

n If a part orientation is manually assigned to a part that has not yet been itemised, this orientation will also be
transferred to all existing geometrically identical parts, provided that they have not yet been itemised.

n If parts with manually assigned part orientation are present during the itemisation, it will be transferred to all
parts with the same item number.

n If new parts are inserted or changed in the drawing, the system will check whether identical parts with a manu-
ally assigned orientation already exist. If so, their orientation will be transferred to the new/changed part,
provided that no manual orientation has been assigned to this part. If, on the other hand, the new part has a
manually set part orientation, it will be adopted for the already itemised identical part.

88 / 382 What's new?

3-D



Itemise parts according to part filters

In the Itemise part function, the filters defined for automatic part annotation can now also be used for annot-
ating templates. The dialogue window has been extended accordingly for this purpose.

By selecting this option, you can, for example, use different annotation templates for beams and sheets, sheets and
plates or different beam types. The filters that can be set in the Configuration Editor correspond to the filters of the
part search via the transparent HiCAD toolbar. To learn how to use these filters, refer to the section Using part filters
for automatic part annotation and itemisation.
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In connection with this extension, the setting of the filters in the Configuration Editor has been moved. As of SP1, you
can find the settings under Drawing > Annotations > Annotation template.

Itemise part - Increment range of numbers

The Increment range of numbers now takes the By top level assemblies itemisation mode into account. This
means that if the By top level assemblies itemisation mode is active, only the numbers of the parts that were also
itemised in this mode will be increased.

90 / 382 What's new?

3-D

../3DTextundBeschriftung/3dbeschriftung7.htm
../../../hicadbasics/Content/Positionierung_neu/pos_neu_ab.htm


Sketches

Configuration of the graphic display

When working with sketches, especially when drawing sketch elements, various information is displayed in the
model drawing, for example, the length of the line, the angle or the radius of the arc.

The colour display and text height of these displays can now be changed in the Configuration Editor, e.g.
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You can find the settings at System settings > Identification.

Please note that the settings apply not only to the Sketch Technology, but also to other functions that
use this type of text display. For example, the change of the display height is also considered for the
Change route function.

92 / 382 What's new?

3-D



Extension when moving and cloning sketch elements

The functions

Move sketch elements and

Clone sketch elements

have been extended.

n If a straight line, a surface or an axis is selected to determine the displacement, the distance will now be dis-
played directly in the calculator and not in the dialogue window as before.

n Undo is possible when the dialogue window is open.

n The Cancel button has been removed from the dialogue windows. You now use the middle mouse button to can-
cel the function.

n The graphical representation of the part coordinate system is hidden during the execution of the function.

Views

Move annotation

The context menu of view markings has been extended. The Move annotation moves the complete view marking,
i.e. symbol and text.
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Detail views cuboid/sphere - Conformity with initial view

Analogously to the "normal" detail views, as of SP1 it is now also possible when creating detail views cuboid/sphere
to specify whether the detail view should be associative to the initial view or not. For this purpose, the dialogue win-
dow has been extended accordingly.

Associativity to the initial view means that the detail view inherits certain changes from the source view. These are:

n cut-outs (including the creation and deletion of cut-outs),
n the section path (if the initial view is a sectional view) and

n hatchings of cut and cut-out surfaces.
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Moving master views

A master view, i.e. a view that is superordinate to other views, could previously only be moved together with all linked
views. In the detailing process, however, it may be necessary to move only the individual view.

As of SP1, this is now possible. For this purpose, the Do not move linked views function is available in the
context menu of the Move view function.

You activate the context menu during dragging (i.e. while the views are hanging on the cursor) by right-clicking.

Update view caption

New in the context menu for view captions is the Update view caption function. This function allows you to
update the position and content of view captions.

The function is useful for sectional/detail views, for example. Here the captions are normally centred above the view.
If annotations are then set or changed, the caption will no longer be centred. It will adjust its position only when the
view is updated. Here the function can be used to restore the alignment. Additionally, the content of the caption will
be updated if necessary.

Set fixed view point

New in the Required position menu is the function

Set fixed view point

Use this function to fix the active view at a point associative to the geometry.

You must determine this point with a point option (Autopilot, keyboard or point option menu). Taking
over the current cursor position by mouse click is not a point associative to the geometry and therefore
not possible as a fixed point.

If a fixed point is already defined for the active view, it will be highlighted in colour in the drawing.
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The fixed point is stored by HiCAD in associative form, its projection in 2-D natural coordinates. After changes to the
part geometry, the preliminary new projection of the 3-D point is calculated and the view is shifted to that the pro-
jection falls back to the previously saved 2-D natural coordinates.

In detail, the following applies:

n If the geometry changes, HiCAD moves the view so that the specified fixed point, which may be in a different loc-
ation in 3-D, is in the same location in the drawing (2-D). This means that the coordinates of the point in the
cartesian XY coordinate system (natural coordinates) do not change.

n If the scale changes, the same applies as for geometry changes. However, this only applies if no fixed point is
specified interactively for the scale change.

n If you move the view explicitly, for example manually via Drag&Drop or via the API, the fixed point in the drawing
also moves.

n If you rotate the view dynamically around a point (mouse or space mouse), the fixed point in the drawing will
shift unless the view is rotated around the fixed point. The fixed point will also shift when you rotate around an
axis of the active coordinate system. For all other changes of the projection - even when you rotate around an
axis of the world or image coordinate system or when you rotate incrementally - the fixed point will keep its pos-
ition in the drawing.

.

Example:

Let us consider the beam shown.

If you set the fixed view point to the start point of the beam axis (1) and select the left beam end (2) for the length
change (e.g. 500) then the position of the fixed point will be retained.
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Without a fixed point, the result would look like this:

The function is also available in the context menu for views.
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Major Release 2023 (V 2800)

Calculation of dimensions and orientation
Until now, automatic calculation of dimensions was only possible for assemblies. As of HiCAD 2023, this feature will
also be supported for 3-D parts. If the dimensions of assemblies and parts should be calculated automatically and
assigned to the attributes

n Length ($03),

n Width ($02) and

n Height ($04)

of the part / assembly, this must be set in the Configuration Editor.

In addition, you can specify whether the dimensions should also be shown in the drawing.
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The display is in the form of the so-called bounding box (1). This is the smallest cuboid that completely encloses the
part. In addition, the coordinate system (2) is displayed on the bounding box. The coloured arrows of the coordinate
system indicate the direction of the dimensions:
n Red: x-axis (length),
n Green: y-axis (width),
n Blue: z-axis (height).

Additionally, the bounding box is marked by a symbol (3) that indicates the up-to-dateness of the dimensions as well
as the source of the orientation.

The orientation of the bounding box (dimension orientation) plays a role in the calculation of dimensions, because it
determines which values are assigned to the Length, Width and Height attributes. The dimension orientation is
determined according to the following priorities:
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1. The orientation is set manually. As of HiCAD 2023, the corresponding features are available in the context menu
for parts and assemblies under Properties > Dimension orientation:

orientation of the dimension by selecting the front side

orientation of the dimension by selecting the top side

Reset dimension orientation (for manually set orientations)

2. The orientation results from the part orientation.

3. The orientation results from the processing direction.

4. The orientation results from the part coordinate system.

The following table contains an overview of the possible markings on the bounding box.

Symbol Meaning

The dimensions are not up-to-date.

This occurs, for example, if you have selected the Only for automatic itemization setting under
Modelling > Part properties > Calculate dimensions, since in this case the dimensions are
only calculated / updated during the itemisation.

The dimensions are up-to-date, the dimension orientation corresponds to the part coordinate
system.

The dimensions are up-to-date, the dimension orientation results from the processing dir-
ection.

The dimensions are up-to-date, the dimension orientation results from the part orientation.

The dimensions are up-to-date. The dimension orientation was set manually.

The dimensions are up-to-date, the dimension orientation corresponds to the part coordinate
system of the main part of the assembly.

The dimensions are up-to-date, the dimension orientation results from the processing dir-
ection of the main part of the assembly.

The dimensions are up-to-date, the dimension orientation results from the part orientation of
the main part of the assembly.

The dimensions are up-to-date. The dimension orientation of the main part of the assembly
was set manually.
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If parts/assemblies are to be excluded from the calculation of dimensions, this can be specified - as before - by
assigning the Ignore for dimensions (#NDR) attribute.

Restrictions on the calculation of dimensions

Not all parts/elements are included in the calculation of dimensions.

Excluded from the calculation of dimensions

Parts / Assem-
blies

n Sheets, if dimension attributes are filled via the development calculation.

n Parts and assemblies of pipeline constructions. Here the attributes are determined
according to a separate logic as before.

n Structure assemblies

The above-mentioned parts / assemblies are considered in the calculation of dimensions of
superordinate parts / assemblies.

Geometrical ele-
ments

n Free edges,

n bore / bolting axes,

n isolated points.

These elements are generally not considered.

Parts in assem-
blies

n CONTOUR parts of series beams,

n dummy parts,

n sketches and 3-D sketches,

n standard and purchased parts with the production type Site assembly,

n standard and purchased parts in compresses representation,

n standard grids,

n parts that are marked as not relevant for dimensions. These are parts that have been
assigned the Ignore for dimensions (#NDR) attribute.

These parts are not considered when calculating the dimensions of assemblies.

Restrictions on the dimension orientation

Changing the dimension orientation is generally not possible for parts that are locked against processing. However,
they are considered when calculating the dimensions.

There is also a restriction for steel engineering plates, glasses and beams.

n Steel engineering plates, glasses
The height must point in the direction of the sheet thickness.

n Beams
The length must point in the direction of the beam axis, the height corresponds to the web.
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Lock parts against processing
Until now, locking parts against processing was only possible for externally referenced parts. As of HiCAD 2023, this
is now also supported for non-referenced and internally referenced parts. Locking against processing can be useful,
for example, to protect an adjacent structure from unintentional processing.

This extension means that the functions for locking parts against processing are now available in a separate menu
and not in the Referencing functions menu as before. You can access the function via the context menu for parts
and there via the entry Lock against processing.

Dimension parameters

Saving the dimension parameters with the drawing

As of HiCAD 2023, the current settings of the Set parameters for new dimensions function are saved together
with the drawing, i.e. in the corresponding SZA file, when a drawing is saved. When the drawing is loaded again,
these parameters will then automatically be active.

After starting HiCAD, when creating a new drawing and when loading drawings saved with a version prior to
HiCAD 2023, the parameter values set in the Configuration Editor under Drawing > Annotations > Dimensioning, 3-
D will be active.

Selecting the bracket type for the 2nd unit of measurement

The 2nd unit of measurement was previously marked with round brackets. As of HiCAD 2023, the bracket type can
now be selected:

n Round brackets,

n Square bracket or

n Without brackets.
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You can change the setting on the Dimension figure tab of the dialogues for the units of measurement. This applies
to general dimensions as well as to parameter and HCM dimensions.

The preset can be defined in the Configuration Editor under System settings > Annotations > Dimensioning, 3-D.
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Edge state - Dimension unit
The dimension unit selected in the Configuration Editor under Drawing > Annotations > Edge state is used to dis-
play the edge state. It can be selected independently of the dimension unit of the drawing.

Example:
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The dimension unit selected for the edge state in the Configuration Editor applies to subsequently created annota-
tions. Annotations that already exist in a drawing and that were created with different settings will not be auto-
matically converted. When editing these annotations, the corresponding values will be marked in the dialogue.

The dimension unit is not output if millimetres "mm" is selected for both the unit of length of the drawing and the
dimension unit of the edge state.

What's new? 105 / 382

News Overview



Improved surface cuts between torus and cone/cylinder/torus
The algorithm for surface cuts between toruses and cones, cylinders or further toruses has been revised. This res-
ults in significantly fewer free-form points, which leads to improved performance and better quality results.

In the image, the intersection of the cone and the torus has been created. (1) shows the number of free-form points
before HiCAD 2023, (2) shows the number in HiCAD 2023.
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3-D grid
The dialogue window of the 3-D grid function has been modernised.

Another new feature is that you can use formulas instead of values when specifying the distance - even in mixed
units. The value will then be converted to the unit of measurement of the drawing.

Example:
Unit of measurement of the drawing: mm; Distance: 1 3/4" + 12.5 mm   Result: 56.95 (mm)
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Sketches

Sketch technology - Presets distance/angle grid

The value for the angle grid when drawing planar sketches and 3-D sketches can now be preset in the Con-
figuration Editor under System settings > Identification in the Grid area.

In this context, the preset for the distance grid has also been moved to this area.

Please note that the specified grid settings not only apply to the sketch technology, but also to other
functions that use distance and angle grids. One example is the new insertion function for beams.

Transform sketch - Move line elements and points

The functions

Sketch > Transform > Move and

Sketch > Transform > MovePts

have been revised and optimised. The distance of the displacement is now no longer specified in the dialogue win-
dow, but can be set dynamically on a distance grid in X and Y direction. In addition, you have the option to freely
select the displacement direction via a context menu.
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Clone sketch - Clone, copy line elements

The function icon of the Clone GE, Move function has changed .

New is the function

Clone, copy line elements.

This function creates a copy of line elements/isolated points of a sketch that can be placed multiple times at dif-
ferent locations.

Referenced parts and itemisation
If an already existing referenced part is inserted in a drawing that is an itemised source model, the item number of
the part (if present) will be invalidated and thus be shown crossed out (or marked with *). When subsequently

itemised, the part receives a change marker in the ICN. This also applies to all its identical parts. Thus, further
updates of the referenced part and its item number are always guaranteed.

If the current drawing is not an itemised source model, the item number of the part will be loaded/updated accord-
ing to the corresponding KRA file.
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Background cut-outs for annotations
In the case of background cut-outs of annotations, the interruption area was always rectangular up to now. As of
HiCAD 2023, the frame selected in the annotation settings is taken into account. This means that circular inter-
ruption areas are also possible, for example.

n Background cut-outs are possible for all annotation functions. After HiCAD has been started, the setting defined
in the Configuration Editor under System settings > Annotations > Part annotation > Interrupt background

lines will be used for new annotations. The ISD default setting is Exclude background. If this setting is
changed during the current HiCAD session when a new annotation is created, this will apply as the new default
setting for subsequently created annotations.

110 / 382 What's new?

3-D

../3DTextundBeschriftung/3DTeilebeschriftung/3dbeschriftung1.htm


n For annotations from drawings created with HiCAD 2022, the setting from the Configuration Editor is used when
drawing or editing for the first time. Annotations from versions prior to HiCAD 2022 must be converted for this
purpose. Whether and when the conversion should take place can be defined in the Configuration Editor under
Compatibility> Annotations > Part annotation, 3-D.

n Background cut-outs can also be set or removed in one step for multiple annotations. Corresponding functions
are available under 3-D Dimensioning + Text > Text > Part annotation, with free text and leader line > Activate
background cut-out or 3-D Dimensioning + Text > Text > Part annotation, with free text and leader line >
Deactivate background cut-out.
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Associative detail views
As of HiCAD 2023, when creating detail views, you can specify whether the detail view should be associative to the
initial view or not. For this purpose, the New detail view and Change detail view dialogue windows have been exten-
ded accordingly.

Associativity to the initial view means that the detail view inherits certain changes from the initial view. These are:

n cut-outs (including the creation and deletion of cut-outs),

n the section path (if the initial view is a sectional view) and

n hatchings of cut and cut-out surfaces.
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Please note the following instructions if the checkbox is active (ISD default setting).
n Associativity must be set when defining the detail view. It cannot be set subsequently.

n Cut-outs and section paths that are inherited, i.e. originate from the initial view, cannot be edited in an asso-
ciative detail view. This is only possible in the initial view. However, the detail view can also have its own cut-
outs, which can then of course also be edited in the view.

n An associative detail view cannot change its initial view. Marking the detail outline is possible only in this specific
initial view.

n When deleting the initial view, the associativity of the detail view is lost. However, the detail view itself does not
change.

n The associativity of a detail view can be removed with the Change detail view function. This does not change the
detail view, it just no longer follows the changes of its initial view. Cut-outs ans section paths originally "inherited"
from the initial view become the detail view's "own" cut-outs and section paths.

Example:

The figure shows a section view A-A with an associative detail view Z derived from it (1). Subsequently, a cut-out has
been inserted into the sectional view (2). This cut-out is then transferred to the detail view after updating (3).

Existing detail views from older drawings (before HiCAD 2023) are non-associative and cannot be set to
associative.
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Catalogue Editor

Service Pack 2 2023 (V 2802)

Paint/Powder coating RAL
The table Paint RAL has been extended by an additional column BZ_COLOR which contains the name of the
respective RAL colour.

The same applies to the new table Powder coating RAL. Both tables can be found in the catalogue Factory stand-
ards > Surface treatment.

114 / 382 What's new?

Catalogue Editor



The additional column simplifies the colour selection in the catalogue for the function Coating. A preview of the col-
our and the colour name is now displayed next to the colour name during the colour selection in the catalogue. The
number of the RAL colour is displayed in the lower left corner of the dialogue window.
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FLUTZ profiles
The catalogue Factory standards > Factory beams > FLUTZ profiles has been expanded by round pipes. The cor-
responding table is HR-QR.

New columns for table Grid (DIN 24537)
The table Grid (DIN 24537) at Semi-finished products > Gratings has been expanded by the following columns:

n S Bearing bar diameter,

n AXB Mesh pitch and

n R Slip resistance.
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Service Pack 1 2023 (V 2801)

Fastenal - Thread cutting screws
The catalogue Factory standards > User-defined fasteners > User-defined bolts+screws > Fastenal > Self-drilling
screws has been extended.

The following tables are new:
n Hex-Unslotted Hex Washer Head *
n Philips Drive Pan Head *
n Philips Drive Flat Head

* The tables replace the previous tables of the same name. The new tables have been created in the unit inch.

Hexagon socket set screws with cup point
The catalogue Factory standards now contains new set screws according to US standard. You can find the hexagon
socket set screws and cup point at Factory standards > User-defined fasteners > User-defined bolts + screws >
User-defined set screws >Hex Drive Cup Point Socket Set Screw.
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ATAS Belvedere profiles
At Factory standards > Series > Roof Wall Facade > Room-closing profiles > ATAS, Belvedere profiles are also
available in the Exposed Fastener catalogue as of HiCAD 2023 SP1.

n Belvedere 6" Short Rib

n Belvedere 7.2" Rib

n Belvedere PenumWall

n Grand C

n Grand V

n Span Wall

Updated SAB profiles
The sandwich panels of SAB have been adapted to the changes of the profile manufacturer. This means that in the
catalogue Factory standards > Series > Roof Wall Facade > Room-closing profiles > SAB, SAB's sandwich panels
have been updated, new profiles have been added and old ones have been marked as deleted. This affects the fol-
lowing tables:

n Sandwichpanels, roof\SAB D,

n Sandwichpanels, wall\SAB W and

n Sandwichpanels, wall\SAB WB.
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Hexagon steel DIN EN 10278
In the catalogue Semi-finished products > Beams+Profiles > Hexagon steel the table DIN 176 (standard obsolete)
has been replaced by the table DIN EN 10278 6KT.
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Major Release 2023 (V 2800)

Units and Unit categories
The Catalogue Editor now supports Unit categories (e.g. Length, Surface area, Volume, Weight) and Units (e.g. mm,
m , in, ft, kg) as Column properties.
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In the future, the units are to be set in all ISD catalogues so that when they are installed in HiCAD, it is evident in
which unit the standard parts are available in the catalogue. In many catalogues, e.g. in the new US standard parts,
this has already been implemented, in the other tables this will be done with the coming Service Packs.

You can also use this option in your own tables. To do this, right-click on the column header and assign the unit cat-
egory and unit to the column.
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New shear connector cartridges
The following, new Hilti objects have been added to the catalogue Purchased/Factory standard parts > Shear con-
nector cartridges:

n HIT-HY 10 Plus at Mortar > Hilti,

n HIT-HY 200 at Mortar > Hilti and

n HIT-SC 16x85 at Sieve sleeve > Hilti.

Other US Fasteners

EJOT Bolt anchors

In the Factory standards > User-defined fasteners > User-defined anchors catalogue, four new tables with bolt
anchors are available under EJOT:

n BA-E PLUS

n BA-E_PLUS HCR

n BA-F PLUS

n BA-V PLUS
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Washers

In the catalogue Factory standards > User-defined fasteners > User-defined washers > Fastenal two new tables
are available:

n Flat Washers > General Purpose Flat Washers and

n Lock Washers > Split Lock Washers.

Bolts+Screws

In the catalogue Factory standards > User-defined fasteners > User-defined bolts+screws > Fastenal new tables
for bolts and screws are available:

Catalogue Table

Bolts n Hex Cap Screw

Lag Screws n Hex Head Lag Screw

Sheet Metal Screws n Intended Hex Washer Head Slot-
ted *

n Phillips Drive Flat Head

n Phillips Drive Pan Head

Machine Screws n Phillips 100° Flat Head

n Phillips Drive Flat Head

n Phillips Drive Pan Head

Thread Cutting Screws n Phillips Drive Flat Head

n Phillips Drive Pan Head

* replaces the previous table
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Processings

The following tables have been added to the catalogue Processings, general > Processing:

Catalogue Table

Bores n ASTM INCH

Countersinks n Countersunk Flat
Head

n Countersunk Socked
Head

Hexagon head screws

In the catalogue Factory standards > User-defined fasteners > User-defined nuts > Fastenal three new tables are
available:

n Hex Nuts

n Hex Jam Nuts

n Machine Screw Hex Nuts

Rivets

In the Factory standards > User-defined fasteners > User-defined rivets > Fastenal catalogue, the previous Rivet
Dome Head table has been replaced. The previous table has been marked as deleted.

The same applies to the table Rivet Dome in the catalogue Factory standards > User-defined processings > User-
defined bores for rivets.

Groove form for easy fiX milling cutter
In the Factory standards > Composite panels, groove form catalogue, the Standard groove form table has been
expanded to include a groove form for easy fiX milling cutter 135°, 3mm. This table is used, among other things, for
attaching and folding flanges with milling edge zones.
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US Materials
The following US materials have been added to the Materials catalogue.

Non-ferrous metals > Aluminium alloys Steel > Structural steels Fine steel > Fine steel alloys

n AA 6060

n AA 6061

n AA 3003

n AA 3004

n AA 3105

n AA 1050A

n AA 5005

n A36

n A283A

n A283B

n A283C

n A283D

n A284A

n A284B

n A284C

n A284D

n A656

n AISI 304

n AISI 316-TI

n AISI 302

Sheet Metal parts according to US standard
New in the catalogue Factory standards > Sheets is the table ISD US sheet. The table contains sheet metal parts of
different thicknesses (in inches) according to US standard.
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ATAS room-closing elements
In the catalogue Factory standards > Series > Roof Wall Facade > Room-closing profiles > ATAS, new Sandwich
profiles will be available from HiCAD 2023 onwards. The catalogue Sandwich panels, wall contains five multi-part
profile types:

Sandwich panels
n Isoleren WL,

n Isoleren IM,

n Isoleren ML,

n Isoleren SL and

n Isoleren TE.
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New usage for Sheet Metal parts
For Sheet Metal assemblies, i.e. assemblies with a Sheet Metal part as main part, a new Usage called Sheet Metal
Assembly is now available. The catalogue Factory standards > Usage has been expanded accordingly.

Further information can be found here.
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New UNC and UNF threads
The previous tables for UNC and UNF threads have been replaced by new revised tables. The previous tables have
been renamed and marked as deleted; fasteners using these threads have been adapted accordingly.

Catalogue Table up to HiCAD 2023 Table from HiCAD 2023 onwards

Processings, general > External thread UNC A up to HiCAD 2022 UNC A

UNF A up to HiCAD 2022 UNF A

Processing > Thread UNC up to HiCAD 2022 UNC

UNF up to HiCAD 2022 UNF

The new tables have been created in the unit "inch".
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Point clouds

Service Pack 2 2023 (V 2802)

Cancelling e57 file conversions
The conversion of e57 files will be instantly cancelled, for example, if the points are so far away from the origin that
display errors occur. Then start the conversion again with the option Move point cloud into origin or change the pos-
ition of the cloud in the e57 file.
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Major Release 2023 (V 2800)

Plane from points

With the function Plane from points the plane is now determined as with the function Select plane from point
cloud, i.e. the Z-direction of the plane points to the viewer. In order to be able to reverse the normal direction if
necessary, the Plane from points dialogue box has been extended by the checkbox Reverse normal direction of
plane.

130 / 382 What's new?

Point clouds

../Pcloud/pcloud_bearbebene_2.htm
../Pcloud/pcloud_bearbebene.htm
../Pcloud/pcloud_bearbebene.htm


Changing the point cloud reference
If a corresponding point cloud was not found under the saved path (the point cloud reference) when opening an

SZA file and this was then changed manually, then the point cloud was provided with a change mark in the ICN,
since it was not ensured that the point clouds were identical.

As of version 2023, HiCAD automatically checks whether the new path contains the same point cloud or a modified
point cloud. The change mark will then only be set in the latter case.
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Feature Technology

Service Pack 2 2023 (V 2802)

Indication of deviating units
If a part is inserted into a drawing created with a different unit, this will be indicated in the feature ICN by displaying
the original unit.

A Sheet Metal part created in an inch drawing is inserted into a millimetre drawing.

The change of values is done with the pocket calculator in the original unit.

The depth of the sheet is changed from 4 to 6.
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If, for example, you change the feature of a cone in the creation dialogue, the original unit will also be displayed
here.

In dialogues, input fields containing deviating units are indicated with a blue info icon.
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Change assembly coordinate system
Note that this may also change the geometry and position of the parts in the drawing. Referenced parts will change
at all points of use.

The isolated point set with the point option K refers to the part coordinate system of the assembly. If you change the
coordinate system, the position of the point and all elements that refer to the point will also change.

Selection of already created variables
From HiCAD SP2 onwards, the part variables that you have already created for the assembly will also be displayed
when choosing the Edit formula function. One character is sufficient for auto-completion.

To display all formulas and variables, place the cursor in the input field and enter the key combination CTRL +
Space bar.
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Automatic recalculation after changes
If the Automatic recalculation is deactivated(off) in the toolbar of the feature window (ICN), from HiCAD 2023 SP2
onwards the automatic feature recalculation in the variable window (ICN) is no longer deactivated as well. The cal-
culation can now be carried out independently of each other.

(1) Automatic recalculation off

(2) Automatic feature recalculation on
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Service Pack 1 2023 (V 2801)

Sketch feature - Element snap mode
The user guidance for the Process sketch feature has been changed.

Previously, in Element snap mode, holding down the SHIFT key while clicking the right mouse button (1) on a
sketch element highlighted the sketch and geometry in colour (2). This made the selection of sketch elements dif-
ficult in many cases. In addition, when editing the sketch, for example, HCM constraints could be set that referred to
elements that did not actually exist, which could lead to feature or HCM errors. The following figure shows such an
example. Here, when changing the sketch of a recess, an HCM dimension (3) was set from the subtraction contour
to the sketch.
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As of HiCAD 2023 SP1, the user guidance changes as follows: If a sketch element is selected in the drawing with
SHIFT+ right mouse button in the Element snap mode and then the Process sketch function is called up in the con-
text menu for edges, then only the sketch is highlighted in colour and calculated to the initial position. This avoids
feature and HCM errors - as shown above - and simplifies the selection of sketch elements. This behaviour also
applies when double-clicking on the Sketch entry in the feature as well as for all cases with which a Sketch feature
can be edited.
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Parameterization of string variables via formulas
Up to now, only variables of type Number in the variable table could be controlled via a formula. As of HiCAD 2023
SP1, String variables can also be parameterized.

To insert a string variable into a comment, for example, proceed as follows:

Create the Number Variables l, b und h for the Length, Width and Height of a cuboid (1). Then create the String Vari-
able Comment (2). Enter the formula for the new variable using the Edit formula function from the context menu
(3).

Enter the formula real_to_string(l) + 'x' + real_to_string(b) + 'x' + real_to_string(h).
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Comments or the Designation of parts can now be parameterized in the Feature.

Please note:

All formulas that are not used for a numerical value can only be entered using the Edit formula function in the con-
text menu. This also applies to string variables. A direct input when creating the string variables with the Value
option is not evaluated.
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Major Release 2023 (V 2800)

Edit feature - Element snap mode

If the identification mode Element snap is active, then clicking with the left mouse button on a geometry will
mark the associated feature in the ICN. Double-clicking this feature opens the corresponding processing dialogue:

You activate the Element snap mode on the transparent toolbar:
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New docking window for variables
The docking window for variables has been completely revised for HiCAD 2023. In contrast to the old variable win-
dow, the entries no longer have to be saved or discarded using OK or Cancel. Instead, you can activate or deactivate

the Automatic feature recalculation . If it is activated, a recalculation takes place after every action in the variable
window. An exception is the change of the comment.
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Part variables / View
variables

With this function you switch between part variables and view variables.

If the Automatic feature recalculation is active, then the views are
recalculated. By including the view variables in the docking window,
the function

View variables at Drawing > Properties > Attr... could be removed.

Activate/deactivate
variables of active fea-
ture log

This filter restricts the view to all variables used in the feature log of the
active part.

Activate/deactivate
variables of active
HCM model

This filter restricts the view to the variables used in the active HCM
model.

Add variable With this function you activate the dialogue for adding variables. The
variables are added to the active part or view variables.

Mark unused variables All unused variables are marked. The user can delete the marked vari-
ables afterwards via the context menu.

Variables, where-used This function opens the Use of variables dialogue window, which lists
for all variables of the selected part where (and whether) they are used
in other places in the drawing.

Recalculate With this function you start the feature recalculation of the active part or
the recalculation of all views.

Activate/deactivate
automatic feature
recalculation

You can switch the automatic feature recalculation or the recalculation
of all views on or off with this function.
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Delete and Clear assignments under Parameterisation
Two functions are now available for deleting the parameterisation of a Design Variant:

n Right-click on the main entry Parameterisation and select Clear. All parameterizations of the Design Variant will
then be deleted.

n Right-click a parameterisation in the sub-menu and select Delete: Then only this parameterization will be
removed.
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HCM

Service Pack 2 2023 (V 2802)

Change assembly coordinate system
Like every part, an assembly also has a part coordinate system. This coordinate system is either determined auto-
matically by HiCAD or defined by you when creating the assembly. For this purpose, a corresponding parameter is
available in the Configuration Editor at Modelling > Part creation > Assembly.

To move the part coordinate system of assemblies, the function Change assembly coordinate system (Draw-

ing > Others > World CS > ...) is available.

Important:

Note that this may also change the geometry and position of the parts in the drawing. Referenced parts change at all
points of use.

Example:

Coincidence (3-D Part HCM) exists between a plane of the cuboid and the XY-plane of the part coordinate system of
the assembly. If you change the position of the coordinate system, the position of the cuboid will also be adjusted.

(1) Coordinate system of the assembly, (2) first plane for the coincidence is the lower surface of the cuboid, (3) second plane of

the coincidence is the XY-plane of the coordinate system

(4) assembly coordinate system changed, (5) (6) coincidence rotates the plane of the cuboid back to the XY-plane of the coordin-

ate system
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Delete all part constraints in an assembly
When deleting the HCM constraints of a 3-D part, you can now also remove the constraints of its subordinate parts.
You can reach the function via the pop-up (right-click after calling the Constraints function).

Deactivate HCM for active sketch
You can now deactivate the automatic placing of HCM constraints for the active sketch. This can improve per-
formance for sketches consisting of many lines. Deactivating the HCM deletes all constraints and greys out the HCM
functions in the Sketch tab.

The option can be found on the Sketch tab at HCM > Tools > Settings. Alternatively, you can call up the func-

tion in the context menu of the HCM ICN with the function Delete and deactivate .

Automatic deactivation of the HCM

The HCM is automatically deactivated when sketches exceed a certain number of lines during 3-D DXF import or 2-
D sketch conversion. You set this number in the Configuration Editor at System settings > Sketch HCM. The ISD
default setting is 1000. If you activate the HCM constraints for such sketches, there may be considerable waiting
times.
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Service Pack 1 2023 (V 2801)

Delete HCM constraints
The Delete functions for HCM-constraints have been merged. With the newly created function, Delete constraint

, you delete individual HCM constraints of the active 3-D part or in the C-Edge HCM of the sketch.

When you identify a constraint, it will be deleted immediately. Use the middle mouse button to end the function.
Alternatively, you can delete constraints directly in the ICN.

With a right-click you call a pop-up menu with further functions:

Constraints in
rectangle

With this function you delete constraints from the active 3-D part in the rect-
angle.

All constraints If you want to start again from scratch when parameterising a sketch, you can
use this function to delete all HCM constraints of an (active) sketch with one
mouse click.

Please note:

This function also removes the HCM constraints for all sub-assemblies of the
active part.
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Symbol for groups
As of HiCAD 2023 SP1, there is only one symbol for a Group and no longer one symbol for each line element of the
group.

(1) Identification beforeHiCAD 2023 SP1

(2) Identification as of HiCAD 2023 SP1
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Highlighting of list views
The deactivation of the parameters

n Highlight active view in model area and

n Highlight active view in drawing sheets

at System settings > Visualisation > Views > Frame of active view only affects the active view as of SP2. If a view list
is active, then the views of this list are always marked by a wider dashed frame.

Automatic data save: Higher performance
The behaviour of the automatic data save with regard to the polygon model of parts can be influenced in the Con-
figuration Editor at System settings > Data save via the checkbox Quick data save. The checkbox is active by
default. This improves the performance of the automatic data save for drawings with many parts.

Default settings changed
The following ISD default settings in the Configuration Editor have changed during a new installation (no changes
during updates). The settings are independent of the selection in ParConfigComp.

n System settings > Identification > Grid angle: The grid angle when drawing lines in sketches has been changed
from 15 degrees to 5 degrees..

n System settings > Annotations > Dimensioning, 3-D > Interactive dimensions > Dimension assignment: 3-D
dimensions are not assigned to the active part, but to the part to which the first dimension base point belongs.

n Steel Engineering > Representation > Type of beam representation: Beams are now created in exact rep-
resentation.

Procedure for dimension calculation
Beams

In the Configuration Editor at Modelling > Part properties there is a new parameter Calculate only length for beams.
This allows the automatic calculation of the beams to be limited to the length as before. Height and width are taken
from the catalogue if necessary. This parameter is deactivated in the ISD default setting. The restriction only applies
if the dimension calculation is activated.

Plates

If the automatic dimension calculation (Modelliing > Part properties > Calculate dimensions) is active, length,
height and width are written with the determined values. If the automatic dimension calculation is deactivated, the
previous procedure applies. Length, height and width are assigned by the steel engineering functions. Length and
width are sorted (Modelling > Part properties > Sort dimensions.
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Production drawings for mounting assemblies
In the Configuration Editor at PDM > Drawing Management > Production drawings the new parameter Production
drawings for mounting assemblies is available. With this parameter, mounting assemblies (Type: Bolted assembly)
can be excluded from the production drawings if required. The default setting is Yes.

Itemisation - small text adjustments
In the Configuration Editor, the term "Itemisation mode, Standard" at System settings > Itemisation and System set-
tings > Itemisation > Migration has been replaced by an explanatory text.

Automatic deactivation of the HCM
The HCM is automatically deactivated if sketches exceed a certain number of lines during the 3-D DXF import or dur-
ing the conversion of 2-D sketches. You set this number in the Configuration Editor at System settings > Sketch
HCM. The ISD default setting is 1000. Please note that if you activate the HCM constraints for such sketches, then
there may be considerable waiting times..

IFC attribute mapping: Display HELiOS attributes
In the attribute mapping configuration for the data transformation between IFC and HiCAD, you can also export
HELiOS attributes as of Service Pack 2.

In the Configuration Editor you can find a new checkbox Display HELiOS attributes at Interfaces > IFC > Attribute

mapping configuration > ISD defaults > Define.

If this is activated, HELiOS attributes are also available for mapping in the pull-down menu of the source attributes.

You can expand and collapse corresponding overviews of the different categories of attribute types.
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Transfer of LogiKal attributes to HiCAD
In addition to the item names for profiles and glass panes, the attribute assignment between LogiKal and HiCAD has
been extended by some numerical and text attributes.

Transferable numerical attributes are [Glass] Acoustic Performance, [Glass] Light Transmittance, [Glass] Solar
Factor and [Glass] Weight for glass panes, as well as the [Insertion] Handle height (from FFL) for profile inserts.

You can assign these LogiKal attributes to corresponding, user-defined HiCAD attributes in the Configuration Editor
at Interfaces > LogiKal.
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Units in the Configuration Editor
In the menu bar of the Configuration Editor, at Extras > Units, you can set whether the values specified there for
lengths and weights are to be displayed in metric units (millimetres and kilograms) or in imperial units (inches and
pounds).

Settings removed

Display of dimensional constraints of sub-sketches

To improve performance, the setting Show dimensional constraints of sub-sketches at System settings > Sketch
HCM has been removed from the Configuration Editor.

OpenGL capacity

Since HiCAD no longer evaluates the setting OpenGL display list capacity at System settings > Visualisation, it has
been removed from the Configuration Editor.

Hatching of adjacent parts in sectional view and cut-out
With the HiCAD function Hatching settings you define the delimitation of adjacent areas in sectional views and cut-
outs by the hatching distance and the hatching angle. You set the default for new drawings in the Configuration
Editor at Drawing > Views.

In order to combine the hatching settings in the Configuration Editor, the option Scale-dependent 3-D hatching (pre-
viously System settings > Visualisation) is now also available at Drawing > Views.

Dimension calculation - Sorting the attributes Length, Width, Height
From HiCAD 2023 SP1 it is possible to sort the dimension attributes (Length ($03), Width ($02) and Height ($04))
of the automatic dimension calculation by size, i.e. the largest value is assigned to the length, the smallest to the

What's new? 151 / 382

News Overview

../benutzerfuehrungkm/extraskm.htm
../../../hicadbasics/Content/Konstruktion/Konstruktionseigenschaften/koneigensch5.htm
../../../hicad3d/Content/3DTeilbearbeiten/Teiletools/BG_abmessungen.htm


height. To do this, the new checkbox Sort dimensions must be activated in the Configuration Editor at Modelling >
Part properties. By default the checkbox is inactive.

Configuration of the graphic display
The display, e.g. when working with sketches, when lengthening sheets or filleting, can be configured. At System
settings > Identification you can set the Text colour, Text background colour, Display height and Line colour for the
preview dimension display.

Itemise parts by part filters
In the Itemise parts function, the filters for automatic part annotation can now be used for annotation templates. In
connection with this extension, the setting of the filters in the Configuration Editor has been moved. You can find the
settings from SP1 at Drawing > Annotations > Annotation template.

Automatic conversion of the "old" itemisation with default favourites
The conversion of earlier itemisations (before HiCAD 2018) into the HiCAD standard itemisation can now also be car-
ried out automatically, i.e. without displaying the itemisation dialogue. For this purpose, the checkbox When switch-
ing to the itemisation mode 'Standard', use the stored default settings is available in the Configuration Editor at
System settings > Itemisation > Migration.

Check Sheet Metal parts for part orientation
For Drawing derivation you can check whether a particular Sheet Metal part has a part orientation. To do this, open
the Configuration Editor, go to Automatic drawing derivation > Production drawing and activate the checkbox
Check part alignment for Sheet Metal parts.

Isometry and pipe spool drawing: Switch off symbol alignment
From HiCAD 2023 SP1 it is possible to switch off the automatic alignment of the symbolic representation of parts in
the Configuration Editor at Plant Engineering > Isometry and Pipe Spool Drawing > Align symbolic representations.
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Major Release 2023 (V 2800)

Free selection of length units in drawings
The previous version HiCAD 2022 only supported drawings with the unit of length millimetre. From HiCAD 2023
onwards, the unit of length can now be selected in the Configuration Editor at System settings > Units > Unit of
length. This means that it is now also possible to design in non-metric units.

Please note the following:
The settings selected at System settings > Units only apply to newly created drawings. These settings
cannot be changed in the drawing itself.
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Sketch technology - Distance/angle grid presettings
The value for the angle grid when drawing planar sketches and 3-D sketches can now be preset in the Con-
figuration Editor - at System settings > Identification in the Grid section.

In this context, the preset for the distance grid has also been moved to this area.

Please note that the specified grid settings not only apply to the sketch technology, but also to other functions that
use distance and angle grids.

Formulas, mixed numbers and units in point inputs
In the numerical point options, the numerical values required for the point option can be entered directly in one
step, e.g. relative coordinates. If you now enter formulas, mixed numbers and units, e.g. (a+b), 1/2, 1 3/4" + 12.5
mm, it is essential to observe the setting in the Configuration Editor at System settings > Miscellaneous > Pocket cal-
culator.

n Space: With this setting, the various entries must be separated by spaces. If formulas, mixed numbers or mixed
units are used, they must not contain spaces. This is the default setting.

n Semicolon: If you want to use formulas etc. with spaces, then you must select this setting. The different entries
must then be separated by a semicolon ;.
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Drawing derivation

New usage for Sheet Metal assemblies

For Sheet Metal assemblies, i.e. assemblies with a Sheet Metal part as the main part, a new usage is available: Sheet
Metal Assembly. The Factory standards > Usage catalogue has been extended accordingly. For assemblies with
this usage, usage-dependent configurations can be used for the drawing derivation, which are managed in the Con-
figuration Editor as for other usages. By default, the ASSEMBLY_SHEETMETAL configuration is predefined for
assemblies with the usage Sheet Metal Assembly.

Production and mounting drawings - Drawing frames

As of HiCAD 2023, two additional parameters are available for production drawings in the Configuration Editor under
Automatic drawing derivation> Production drawing > Drawing frames.

n Use frame

This checkbox determines whether the frame should be offered for selection in the Drawing derivation dialogue
or not. The ISD default setting is yes, i.e. the checkbox is active.

n Automatic determination of geometric data for the drawing frame

If this checkbox is active, the geometric data of the frame including the usable area will be calculated auto-
matically.
For each drawing frame you can define
l the distance of the insertion point from the centre of the frame,
l the size of the usable area (frame height / frame width) and
l the size of a blocked frame area (for the title block, BOMs or comments)

The following settings have been added to place the drawing frame exactly in the sheet:

n Horizontal distance of the upper left point to the inner frame

n Vertical distance of the upper left point to the inner frame

n Total height of the figure

n Total width of the figure

These settings help position the inner frame within the outer frame.

Analogously, the parameters listed above are also available for mounting drawings under Automatic drawing deriv-
ation> Mounting Drawing > Drawing frames.
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Show drawing frame

When selecting the drawing frame of production drawings under Automatic drawing derivation > Production draw-
ing > Usage-dependent > Template or Default, the DIN name will be displayed in a ComboBox as of HiCAD 2023.

Output of PDF data in black and white

PDF files can now also be created in black and white. For this purpose, the settings in the Configuration Editor at
PDM > Drawing Management > Externalproduction documents have been extended by the entry Monochrome
PDF data.

Workflow when creating general documents

As with production drawings, mounting drawings and customer drawings, it is now also possible to select when gen-
eral documents in DXF, DWG and PDF format are to be created. To do this, the setting in the Configuration Editor at
PDM > Drawing Management > External production documents > PDF files for general documents has been
extended by the options

n Upon Checkup and Release,

n Upon creation and update, and

n Upon Release.
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Using Frame/scale lists

The lists for drawing frames and view scale that you create with the new function Frame/scale list are only taken into
account during drawing derivation if the checkbox Use Frame/scale list is active for the respective usage type in the
Configuration Editor at Automatic drawing derivation > Production drawing > Usage-dependent > .... > View group
is active. In the dialogue of the drawing derivation the option Drawing parameters: From configuration must then be
active.

If a frame/scale list has been created in HiCAD for a purpose, it is displayed in the Configuration Editor at Frame/s-

cale list . It is not possible to change the list here.

Updating of part attributes
The settings for updating part attributes have been implemented uniformly for all affected attributes in the Con-
figuration Editor. You can find the settings at Modelling > Part properties.

n (1) Already existing settings

n (2) Settings from the directory System settings > Calculations > Approximation accuracy for weight calculation

n (3) Settings from Sheet Metal > Sheet development > Transfer development dimensions to

n (4) Settings from Steel Engineering > Weight calculations

n (5) New parameters and new attributes (§SC, §SOC, §S2D, §CW)
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Dimension calculation and alignment
Until now, automatic dimension calculation was only possible for assemblies. As of HiCAD 2023, this is also sup-
ported for 3-D parts. For this purpose, the calculation must be activated in the Configuration Editor at Modelling >
Part properties > Calculate dimensions.

If the dimension is to be displayed in the drawing in HiCAD, then activate this at System settings > Visualisation >
Show dimensions of the active 3-D part.

If the sheet is to be calculated instead of the sheet development, then the setting Development attributes must be
selected for Modelling > Part properties > Transfer development dimensions to.

Part-related status check
Since the Part-related status check located under System settings > Miscellaneous in the Configuration Editor is no
longer needed, it is no longer available as of HiCAD 2023.

Edge state - Dimension unit
The dimension unit selected in the Configuration Editor at Drawing > Annotations > Edge state is used to display the
edge state. This can be selected independently of the dimension unit of the drawing.

Selection of bracket type for the 2nd dimensioning figure
The 2nd dimensioning figure was always marked with round brackets in 3-D until now. As of HiCAD 2023, the
bracket type can now be selected. The default setting can be defined in the Configuration Editor at System settings
> Annotations > Dimensioning, 3-D.

2-D DXF/DWG import and export options
The favourite for the default setting for 2-D DXF/DWG exports, e.g. of sheet metal developments, can be set in the
Configuration Editor at Interfaces > Export > 2-D DXF/DWG. You can create the favourites when exporting from
HiCAD by editing the ISD default settings.

User libraries
The functions for part and macro libraries are no longer available in Ribbon Drawing for new installations from
HiCAD 2023. Existing customers who want to continue using their existing libraries can switch on the functionality in
the Configuration Editor at Compatibility > User library up to HiCAD 2022 by activating the corresponding check-
box.
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PDM setting removed
To avoid changes, the settings at PDM > Drawing Management >

n Delete item numbers of project-independent parts (Default =Yes) and

n Itemisation of locked parts (Default = Only project-independent part masters )

have been removed from the Configuration Editor.

HiCAD specific HELiOS settings moved to the Configuration Editor
HiCAD manages some attributes itself, which previously had to be defined in the HELiOS Options on the Database
tab.

A: up to HiCAD / HELiOS 2702, B: as of HiCAD / HELiOS 2800
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Plant Engineering - ROHR2 interface
In Plant Engineering, the part name of the pipeline was previously used as the file name when generating NTR files

via the ROHR2 interface . As of HiCAD 2023, the file name can be configured flexibly via HDB files. For this
purpose, the following parameters are available at Anlagenbau > ROHR2 in the ISD Configuration Editor:

n Configuration of NTR file name (without HELiOS) and

n Configuration of NTR file name (with HELiOS)

The files ICN3D_DESIGNATION and ICN3D_ DESIGNATION_DB are used as ISD default settings. These are the
HDB files which are also used for the display of the column Designation of the ICN window 3D Part Structure. This
means that the part number of the pipeline is used as the file name by default or - if this is not available - the part
name.

Detailed information can be found in the section Plant Engineering > Evaluation > ROHR2 interface.

LogiKal Interface - Transfer of Text Attributes to HiCAD
When importing LogiKal items (called "Positions" in LogiKal), certain LogiKal text attributes can be specifically
assigned to certain HiCAD attributes. The setting is made in the Configuration Editor at Interfaces > LogiKal.

Support of IFC 4 Addendum 2
HiCAD 2023 supports the IFC 4 Addendum2 data format for IFC import.

Important:

Note that as of HiCAD 2023, when importing IFC files, the IFC version specified in the Configuration Editor under
Interfaces > IFC > Interface version is no longer evaluated. The version will automatically be detected during
import. When exporting IFC files, however, the parameter will still be evaluated.
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Edit template for export to Excel
If you want to use a specific template for the export to Excel, activate the option Use template. Then determine

which template you want to use. To modify the selected template in Excel, select Edit template .

Extended Steel Engineering lists
The attribute Coating ($15) has been included in the Steel Engineering lists of the Excel BOM (Hicad_ Stahlbau.xlsx
). If you have parts coated in HiCAD, the coating is transferred to Excel when exporting the bills of materials.

Dimension attributes Length and Width

In the Excel BOM for Steel Engineering (Hicad_ Stahlbau.xlsx), as of HiCAD 2023 SP2, the column for the Length
attribute is before the column for the Width attribute.
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Extended bar list

When outputting the bar list in Excel, the used length is now output in addition to the waste. For this purpose, the
BOM template for Steel Engineering has been extended by the placeholders

n !BarWaste! - Waste

n !BarUsed! - Length used

Templates for DSTV and ERPlus

The new ISD Report Manager 2023 is now used for the BOM exports to Qomet and Proflex.
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New ISD Report Manager
As of Version 2023, there is a completely new, comfortable ISD Report Manager. This ISD Report Manager works
with RM_SETTINGS instead of RMS files. To convert your old RMS files, the function Convert RMS file to RM_
SETTINGS is available at Tools.

Further advantages:

n By importing / exporting the settings in the dialogues, you can save multiple combinations of settings and con-
veniently reuse them.

n The headers and footers are now configured using a graphical interface.

n A Sort sequence can be defined for all available columns.

n You can now dynamically search for attributes in the Column settings.

User interface

1. Menu bar

2. The toolbar has been retained and extended to include the settings.

3. Overview of all BOM-relevant parts in the utilized assembly.

4. Overview of all attributes of the part clicked on above.

5. The unit is automatically displayed in the Quantity list and Structure list and is configurable.

6. Status bar.
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Export

A graphical interface is now available for configuring header and footer templates.

1. Function bar

2. Page parameters

3. Basic elements

4. Document info data, list of usable attributes

5. Workspace

6. Built-in elements

7. Parameters for the element Text format

8. Parameters for the element Pixel graphics

9. Status bar

The Excel export has also been revised::

n There is now a separate function for the Excel export with template or script. An Excel template or a C# script
can be used here.

n There is now the function Create Excel document (xlsx, xls), which transfers the displayed lists directly to Excel
without formatting. The data can be formatted with a Visual Basic Script (.vbs).

n In addition, there is a function that writes the displayed cells to an Excel XML file. The data can be formatted with
a Visual Basic Script (.vbs).
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Column properties

Through the new Column settings dialogue, you can now dynamically search for attributes.

1. Dynamic search

2. Column type

3. Visibility of columns and export of columns

4. Decimal places.

5. Identical part search and column sum

6. Category and Displayed unit are for attributes of type Integer or Double

7. The Displayed unit depends on the category. For length, units such as metres, inches, feet, etc. are available.
The unit is then displayed in the column in square brackets.

8. Attribute name, Category and Displayed unit are visible when the Extended display is active.

9. Displays only the columns marked as visible with the Visualisation checkbox activated.

Head data setting

The ISD Report Manager now offers the function Head data settings. This allows you to set attributes centrally and
comfortably for all possible exports.
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Sort sequence

The sort order can now be set for all available columns. In the old Report Manager, only four columns could be set.
In addition, for the column type String, one of four sorting methods can be selected for the respective column.

n Standard: Sort alphabetically

n Numerical: Sort by numbers

n Logical: As in Windows File Explorer

n Date/Time: By date and/or time

Filter settings

The data displayed in the list window of the Quantity list and Structure list can be filtered, i.e. only the rows of the list
that meet certain criteria - specified in the filter definition - are displayed.

For example, you can

n output only parts with a certain item number or parts whose item number lies within a certain range,

n transfer filters via import/export and save them,

apply the respective JavaScript methods to the data types,

n create regular expressions and

n get direct feedback on errors in the expression.

Filter criteria are defined column by column. Only the rows in the list that meet all the filter criteria specified for the

columns are then output. Columns for which a filter has been defined are marked with .
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User-definable columns

With the function User-definable columns you have the possibility to add additional - freely definable - columns to
the BOM or to change already defined columns.

1. Create new columns by type

2. Copy and paste a column. If none is active, all are copied.

3. Filter which column types are to be displayed in the pool

4. Category and Displayed unit can be defined directly

5. Overview of all available columns, filterable by type

When editing a formula, the column name clicked on is entered there as an attribute.

Excel-BOM with pipe length list
For the new ISD Report Manager (from HiCAD 2023), an XML configuration file adapted for Plant Engineering is
available with the name HiCAD_Anlagenbau.rm_settings . This configuration file allows the sensible creation of bills
of materials (BOMs) of mixed model drawings and also contains a pipe lengths list.

The file is located in the HiCAD sys directory and facilitates in particular the use of a new BOM template for Excel
export. This new template HiCAD_Anlagenbau.2800.0.xlsx can also be found in the sys directory of your installation
(or as HiCAD_Anlagenbau.EN.2800.0.xlsx in the sub-folder bomtemplates).

Adapted configuration files for the new ISD Report Manager are also available for the Plant Engineering functions at
Plant Engineering > Evaluation.
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HELiOS Options: Switching between previous and new ISD Report Manager
HELiOS 2023 or HiCAD 2023 introduces a new version of the Report Manager.

When creating the BOM in HiCAD and HELiOS, you decide by selecting the configuration whether the previous
Report Manager or the new ISD Report Manager opens.

n The old Report Manager uses files with the file extension RMS for the configuration.

n The new ISD Report Manager from version 2023 onwards uses XML configuration files with the file name exten-
sion RM_SETTINGS

You determine the configuration in the HELiOS Options at Database and then Default configuration for product
structure output.

New BOM templates for HELiOS
There are new configuration files for creating bills of materials from the HELiOS product structure. The files (*.RM_
SETTINGS) are located in the SYS directory of HiCAD.

n PRODUCT_ISD.RM_SETTINGS

n PRODUCT_ISD_HiCAD.RM_SETTINGS
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Variant Editor

Service Pack 1 2023 (V 2801)

Saving variants without hollow body and solid body representation
If you have selected a plant engineering industry (Standard Plant Engineering or Air ducts), then as of SP1 (Patch 1)
variants that have neither a hollow nor a solid body representation can no longer be saved. In this case an error mes-
sage appears:

New part type Welding neck
A new part type called Welding neck is available.
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You can find extensive information about this in the Plant Engineering News.
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Function call moved
The Variant Editor has been moved into the Extras function group on the Drawing Ribbon tab.
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HiCAD GUI Creator

Major Release 2023 (V 2800)

Extended toolbar
The toolbar has been extended in HiCAD 2023.

Func-
tion

Description

Hide/Show preview

Shows the currently loaded dialogue in the preview or hides the preview. This allows you to check
how the dialogue would look in HiCAD. The operation of the dialogue can also be tested - for
example, access to the catalogue and changes in the dialogue by selecting entries from one of the
selection boxes.

Example:
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Func-
tion

Description

Display of the preview

Align, horizontal left

Aligns the selected objects horizontally to the left. The last selected object is decisive for the align-
ment.

Align, vertical top

Aligns the selected objects vertically on top. The alignment is determined by the last selected object.

Set equal width

Sets the width of the selected objects equal. The width is determined by the last selected object.

Set equal height

Sets the height of the selected objects. The height is determined by the last selected object.

Set equal width and height

Sets the width and height of the selected objects equal. The width/height is determined by the last
selected object.
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New ToolBox objects
The ToolBox objects EditBox and ComboBox now distinguish between input for numbers (Double) and text (String).
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Expand/Collapse dialogue structure
The dialogue structure can now be expanded and collapsed, like the part and view structure in HiCAD.

Activity condition
In addition to the Visibility condition, an Activity condition can now be assigned to all toolbox objects. This determ-
ines when an object is active, e.g. when input should be possible in an input field.
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Automation

Discontinuation

Discontinuation of the ISD.PDM.API

Before carrying out a HELiOS update for an older HiCAD version, please note that from HELiOS 2022 omwards,
the previous ISD.PDM.API will be discontinued and replaced by the new API from Helios.Interface. If you use
customisations that use functionalities from the previous ISD.PDM.API, you must update the customisations to
the new API before carrying out the HELiOS update. If you use customisations that use functionalities from the
HiCAD API, you should ensure that the HiCAD version used is at least version 2502.5 or 2601.1 or newer. If you
are unsure whether you are using corresponding adaptations, please talk to your administrator or contact the
ISD in case of doubt.

Service Pack 2 2023 (V 2802)

Link development
The HiCAD API provides the following command for deleting links between 2-D and 3-D developments in Sheet
Metal:

n ISD.CAD.SheetMetal.SheetDevelopment.RemoveDevelopmentReference(Figure developmentFigure)
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API

Divide along direction and Divide with sketch

The following functions are now available in the HiCAD API:

n

3-D-Standard > Process > Trim > Divide along direction (DividePartAlongDirection)

n
3-D-Standard > Process with sketch > Subt. > Divide with sketch (DividePartBySketch)

Laminated glass in the API

The following command is available in the HiCAD API for laminated glass (Steel Engineering > Plate, new > Lam-
inated glass and Metal Engineering > New > Laminated glass:

n LaminatedGlassCreator
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Determine base part of a dependent part

Using the HiCAD API (Node.GetDependentNodeSource und Node.ExchangeDependentNodeSource), you can now
determine the base part for a dependent part. This is useful if the dependent and the base part are derived and the
derivations are related to each other.

Set fixed view point

The following API functions are available for the new function Set fixed view point (Views > Transform > ReqPos
>... ), with which you fix the active view at a point associative to the geometry:

n View.SetFixPoint (Set fixed view point)

n View.ClearFixPoint (Delete fixed view point)
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Interfaces

Service Pack 2 2023(V 2802)

Update to CADfix 12 SP2.1
With the update to CADfix 12 SP2.11 the following format versions are now available in HiCAD 2023:

n ACIS 2021 1.0.1 (V5R32)

n CATIA V5 V5-6 R2022

n DWG 2023

n DXF 2023

n Inventor 2023

n JT 11.11

n PLM XML 11.11

n CREO 9

n SOLIDWORKS 2022

What's new? 179 / 382

News Overview



2-D DXF/DWG Export: New settings dialogues
The dialogue windows of the Export options for 2-D DXF/DWG files have been extended with Service Pack 2 by sev-
eral new features.

For example, the transfer of parts as blocks can now be controlled via the Export settings dialogue window. Manual
configuration of the system file keyword "FIGBL" is no longer necessary.
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New setting options for the transfer of layers, colours and line types into the DXF/DWG format can be found in the
new menu window tabs DXF layer assignment, DXF layer definition and Line type assignment.

Other old configuration file keywords that have been dropped as a result are: BYLAY, LAYER, LTDEF, SONST,
TXTLA.
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IFC attribute mapping: Display HELiOS attributes
In the attribute mapping configuration for the data transformation between IFC and HiCAD, you can also export
HELiOS attributes as of Service Pack 2.

In the Configuration Editor you can find a new checkbox Display HELiOS attributes at Interfaces > IFC > Attribute

mapping configuration > ISD defaults > Define.

If this is activated, HELiOS attributes are also available for mapping in the pull-down menu of the source attributes.

You can expand and collapse corresponding overviews of the different categories of attribute types.
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The target attribute determines which HELiOS attributes are offered to you: For a mapping with the IFC attribute Ele-
ments > Name, for example, the attributes of the types HELiOS article attribute and HELiOS document attribute are
available; if the selected IFC target attribute is, for example, Project > Name, then Project attributes and Folder
attributes are displayed for possible mapping.

HELiOS attributes of all four object types are available for other IFC properties.
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2-D DXF/ DWG: New settings dialogues for import and export
The import and export options for 2-D DXF/DWG files have been extended by dialogue windows with the help of
which you can conveniently set, for example, the processing of colours and layers, the conversion of units of meas-
urement or the target version of the DXF format.

Please note the following in this context:

In earlier HiCAD versions the header variable $INSUNITS of DXF files was not evaluated and thus the imported data
was not scaled. Using the import setting option for the Unit of length, the variable is now evaluated, converted into
the current HiCAD drawing unit and scaled accordingly if necessary.

Furthermore, by providing the new dialogue options, some codes that were manually edited in the corresponding
configuration files in earlier HiCAD versions are omitted:

n When importing, the following codes are omitted: INSUNI, BEMAS, LAYFI, LAYNR, LAYNA, COLBE, COLSR,
COLOUR, BLKBE, BLKSR, SPFIG, PROXY, TSCH0, TLEER.

n When exporting, the following codes are omitted: ACDXF, INSUNI, BEMAS, NKST, COLOR.

DSTV-NC: Threads and countersinks
The Others area of the DSTV-NC format export dialogue has been extended by the options to suppress Threads and
Countersinks or to write only a core drilling instead.

By default, threads and countersinks are exported (setting selection is set to Write in each case).
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DSTV-NC - Combining powder marking lines
For the DSTV NC export, it is now possible to specify on the Extended tab whether powder marking lines are to be lis-
ted individually in the NC file or whether the powder marking lines are to be combined into one block per marking
line causing part.
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Example:

In the image below, Parts 101 and 102 cause powder marking lines on Part 100.

Excerpt from the DSTV NC file of Part 100.
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IFC import

Support of IFC 4 Addendum 2

HiCAD 2023 supports the IFC 4 Addendum2 data format for IFC import.

Note that as of HiCAD 2023, when importing IFC files, the IFC version specified in Configuration Editor
at Interfaces > IFC is no longer evaluated. The version is automatically detected during import.
However, when exporting IFC files, the parameter will still be evaluated.

Set BOM-relevance

For IFC import, an additional option is now available for determining the BOM-relevance (HiCAD attribute #SR). For
this purpose, the previous checkbox in the dialogue window has been replaced by a selection box.

The following options are available for selection:

Delete The BOM-relevance of the imported parts is set to No, i.e. the imported parts are not BOM-rel-
evant.

Set The BOM-relevance is assigned to the imported parts.

From file The BOM-relevance is determined by the imported file or by the attribute mapping defined in the
Configuration Editor for the import.

Navisworks export
When inserting a NWC file created by HiCAD into the Navisworks Manager, attributes exported by HiCAD are also
displayed there. Which HiCAD attributes are transferred and how can be configured via a system file.

The group name of the HiCAD attributes displayed in Navisworks can also be changed if required.
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NCX-Export - Rotate beams and profiles
HiCAD offers the possibility to rotate beams and profiles during NCX export - from HiCAD 2023 onwards also by 90°
and 270°.

To use this option, the files

n BRW_3DTEIL_PROFIL_H.HDX und

n BRW_3DTEIL_PROFIL.HDX

in the HiC sys directory must be manually supplemented by the following line:

<H>::TEXT=""::ATTR="%NCROT"::TYP="COMBOBOX"::EDIT="NO":::E_WIDTH="401"::E_LIMIT-
T="130"::FILE="..\sys\H_NCRotation.txt"::TL_WIDTH="130"

This extends the Part attributes dialogue for beams and profiles by a selection box for the setting NCX beam
rotation.
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3D DXF/DWG-Import Transfer of layers to 3-D data structure
Until now, when importing 3-D DXF/DWG files created with flexijet, the part structure ( layer ) was transferred in the
form of layers. This meant that the complete flexijet model was transferred to HiCAD as one part. From HiCAD 2023
it is possible to transfer these layers also as 3-D parts into the HiCAD part structure. For this purpose, the dialogue
window has been extended by corresponding options.

Layer in part structure

If this checkbox is activated, an attempt is made to transfer the layers from the DXF file into the HiCADAD part struc-
ture. For this purpose, the points, lines and parts, which are assigned to certain layers, are collected in parts, which
are named according to these layers. Activating the checkbox can be useful, for example, when importing files cre-
ated with flexijet.

Dots as structure separators

This option is only available if the checkbox Layer in part structure is activated. If the checkbox Dots as structure
separators is active, it will be checked whether a highly detailed part structure is given by the layer names, namely
by dots as separators. Components of a layer name preceding a dot are then created in HiCAD as an assembly, the
associated remainders of the name then result in the parts lying under the assembly.
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2-D DXF/DWG import and-export: New dialogues
In order to be able to edit the import and export settings of 2-D DXF/DWG files more comfortably, new configuration
dialogues have been integrated into the HiCAD interface.

These replace the manual editing of system files (acadhcad.dat, hcadacad.dat), which are thus no longer neces-
sary.

However, settings from older configuration files can still be read in and taken into account accordingly.
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Sheet Metal

Service Pack 2 2023 (V 2802)

Coat parts

Using the optimised Coating function in Ribbon Sheet Metal and Steel Engineering, you define the coating
description, the coating colour (RAL, NCS and system construction colour) and the coating type (outside, back-

/inside and face) of sheets and plates as well as beams and profiles and 3-D parts. The Extend coating func-
tion, with which you transfer the coating to the new or processed elements, can now also be applied to profiles.

The coating description and the coating type are transferred to the part attributes and can thus also be made avail-
able to the bill of materials.

After selecting the function, a preview of the coating is displayed for the active part (in shaded mode). You can now
select other parts and apply the coating with OK.

An arrow is visible in the middle of sheets and hollow profiles after the selection. Use this to exchange the out-
side with the back of sheets or the inside with hollow profiles. For non-hollow profiles, the specification for the inside
has no meaning.

If you have already assigned an outer side to the sheet or plate with the function Determine visible side, this will be
taken over as the outer side when coating.

You can select a RAL or NCS colour from the catalogue or a system colour or drawing colour as the coating colour. If
you have selected a catalogue colour, you can also adopt the description from the catalogue. The description is
transferred to the part attributes.
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Surfaces to be coated

For sheets, you can coat the end faces and the processings either in the colour of the outer side or the back side. For
profiles, you can set the coating of front surfaces and processings separately. These settings are transferred to the
part attributes.

If Back side deviating is deactivated, the second colour selection is greyed out and both sides will get the same col-
our.

(1) Coating (outer side), (2) Back side/Inner side deviating, (3) Coat front surfaces and processings like back side of sheet, (4) Do

not coat front surfaces for hollow profiles, (5) Coat processings like inner side (for hollow profiles)

Attach flanges to surface
The Attach flanges to surface function has a new option for corner processing.

This option allows you to close the corners of sheets with milling edge zones , taking into account the Joint, i.e.
Inner edge, flush or Sheet edge as milling edge.
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Joint: Inner edge, flush

With the joint you determine whether the inner flange edges are shortened or lengthened flush.

(1) Clearance

Joint: Sheet edge as milling edge

For composite panels you can finish the flanges with a milling edge zone. For the milling edges, select the appro-
priate milling tool from the Groove form option in the Factory standards > Composite panels, groove form
catalogue.

(1) Milling edge closed

(2) Groove form V 90° for the flanges from the catalogue
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Copy flange or bend zone

If you copy the flange or bend zone of a Sheet Metal part using the Copy to HiCAD Clipboard function (in the
ICN toolbar or context menu), the entire Sheet Metal part is always copied if the feature is active.

You can then paste the Sheet Metal part as a new main or sub part into the current drawing or into a new drawing

using the Paste from HiCAD Clipboard function.

Clone/Transform multiple selections
If you select flanges and bend zones in multiple selections, as of HiCAD 2023 SP2 the complete Sheet Metal part is
always taken for transforming and/or cloning. Previously, an error message appeared and the function was can-
celled.

Please note:

For flanges and bend zones without feature, Transform and Clone operations applied to individual parts are still
allowed.
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New setting options for DXF/DWG export
The dialogue for setting the DXF/DWG export options has been further modernised.

n On the General tab the option Create blocks has been added. This replaces the previous keyword FIGBL.

n Use the table on the DXF layer assignment tab to assign HiCAD elements to corresponding DXF layers. This
table replaces the previous keywords LAYER, TXTLA and SONST.

n In addition, LAYER * and SONST * have been replaced by the checkbox below: Here you can choose for
wHiCADh elements DXF layers should be generated (and assigned accordingly) according to the HiCAD layer of
the elements.

n The properties of DXF layers can be configured on the DXF layer definition tab. This replaces the previous
keyword BYLAY.

n On the Line type assignment tab, the HiCAD line types can be assigned DXF line types with name and descrip-
tion. This replaces the previous keyword LTDEF.

For the two dimensioning rules, an isolated point was added to the agraffe in the bore pattern. This point serves as a
dimensioning point and has the designation Dim.
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Sheets form bend zones
In HiCAD you can now create and edit Sheet Metal parts consisting of bend zones only. For creation, the Sheet
along sketch function is available or you import a bend zone via the STEP interface. You can then perform a bending
simulation, development or a sheet thickness calculation, for example.

If you have created a Sheet Metal part with the Sheet along sketch function from bend zones, then you can edit the
sketch in the feature or change the bend zones via the dialogue. If the sketch contains arcs that do not merge tan-
gentially, a bend zone will beinserted.

(1) Sketch, (2) Arcs without tangential transition, (3) Bend zones inserted
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Sketch feature - Element snap mode
In HiCAD Sheet Metal, sketches are often used when creating and processing sheets. You can process these
sketches via the feature log. The user guidance for the Process sketch feature has been changed.

Previously, in Element snap mode, holding down the SHIFT key while right-clicking on a sketch element highlighted
the sketch and geometry in colour. This made the selection of sketch elements difficult in many cases and possibly
led to errors in HCM constraints.

As of HiCAD 2023 SP1, a sketch element is selected in the drawing in Element snap mode via SHIFT + right click
and then the Process sketch function is called in the context menu for edges. Afterwards, only the sketch is marked
in colour and the feature is calculated up to the initial position.

(1) Behaviour before HiCAD 2023 SP1
(2) Behaviour as of HiCAD 2023 SP1

Configuration of the graphic display
The display, e.g. when working with sketches, when lengthening sheets or filleting, can be configured. At System
settings > Identification you can set the Text colour, Text background colour, Display height and Line colour for the
preview dimension display.
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Check part orientation of Sheet Metal parts
For Drawing derivation you can check whether a particular Sheet Metal part has a part orientation. To do this, open
the Configuration Editor, go to Automatic drawing derivation > Production drawing and activate the checkbox
Check part alignment for Sheet Metal parts.

If you then have not defined a part orientation, a message will be displayed during drawing derivation.

If you choose Yes, the drawings will be created. If you choose No, you cancel the drawing derivation.

With the Part orientation function you determine the front view or top view of the sheet. You define the part ori-

entation with the functions Orient... (Drawing > Positioning/Detailing) or via the context menu of the Sheet
Metal part (Properties).

Please note:

When you create a sheet using the Sheet along sketch function, both the part orientation and the dimension ori-
entation are automatically set to the front view of the sheet.
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Change length

On the Sheet Metal tab, the lengthening of sheets in the same plane is summarised in the Change length
dialogue. With the dialogue you can lengthen flanges and bend zones as you like or shorten them by a negative
value or by selecting the direction. You can also change the length in the bending simulation.

Select via the icon whether you want to lengthen a flange or a bend zone, a milling edge zone or the entire sheet with
bend zones and flanges.

Only selected sur-
face

If you have activated this icon, you can change the length of a flange or a
bend zone or a milling edge zone.

All surfaces in
same plane

Bend zones and flanges that are in the same plane are lengthened in one
step.
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By identifying the edge, a top surface, a front surface and the front edge in between are now clearly determined. If
you activate the option Perpendicular to front, the direction is automatically determined and displayed on the
flange.

(A and B) The identification point of the edge determines the front side.

(1), (2) and (3), (4) When selecting the direction, an arrow is displayed for clarification.

You have three options for length specification:

n By value: This option lengthens a flange/bend zone or a complete sheet by the entered value, depending on the
previous selection.

n Total length: Lengthens a flange/bend zone or sheet by entering the new total length. The total length refers
either to the flange/bend zone or to the complete sheet.

n To point: Lengthens a flange/bend zone or a sheet in the selected direction over a point and a distance to the
point.

(1) and (2) Lengthening of the surface by selecting the front edge (right-click))

(3) and (4) Lengthening of the sheet perpendicular to the front by selecting the longitudinal edge.
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Develop surfaces (analytical)
The completely revised Develop surfaces function analytically develops the surface of a 3-D part (e.g. truncated
cone or free-form surface). Either a sheet thickness (offset) is queried for the depth of cut or, for example, the thick-
ness is adopted for hollow bodies.

You can derive several 3D developments with different parameter settings from one 3-D part. The parameter set-
tings are saved with the development. A new view is created for each development. The view and the 3-D part are
linked. If the sheet metal part is deleted, the view with the development also disappears.

In the ICN, the development appears below the 3D part and can contain sketches as a secondary part for later pro-
cessing with 3-D functions. If the development is active, the 3-D part is greyed out.

You have the option of defining the development parameters when creating the development. You can access the
functions for changing the parameters by right-clicking on the development.

After activating the function, the following dialogue appears.
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The 3 options Individual, Tangential and Tangential with angle are available for the selection of the surfaces to be
developed.

(1) Individual: Here you select the surfaces to be developed individually.

(2) Tangential with angle: Adjacent surfaces and tangential surfaces are automatically recognised taking into account an angle.

(3) Tangential: Tangentially adjacent surfaces are recognized automatically.
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With the help of the Annotation Editor, you can define additional texts, e.g. for production, or load the annotation via
the Favourites. The attributes that can be evaluated are displayed in the Annotation Editor. These can be sup-
plemented with your own notes.

In the Extended settings, the line colour, line type and the layer of the various edges are set. For example, you can
set the colour, line type and layer in the development for crosshairs.

(1) Tear-open point, (2) Sheet development edges, (3) Inner contours, (4) Bend zome, (5) Tear-open edges
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Connecting sheet
With the modernised Connecting sheet function you can connect two composite edges (guidelines), from a 3-D
sketch or a planar sketch, with a sheet. Depending on the selected function, the sheet is created as a main or sub-
part. As soon as your entries are sufficient, a preview is displayed. The feature log is available for changes.

Connecting sheets can be derived from planar sketches and 3-D sketches. In the 3-D sketches, both composite

edges can be in one 3-D sketch if the icon is active. If the composite edges are in two 3-D sketches or if you

are working with plane sketches, activate the following icon . Make sure that there is only one composite
edge in the sketch.

If you choose a semi-finished product from the Catalogue Editor , the sheet thickness is not requested. The
sheet thickness and, if applicable, the Article number are then taken over from the Catalogue Editor for the sheet. In
the General area you can also change the Article number for the selected semi-finished product. If you also want to
take over the bend radius from the Catalogue Editor, activate the checkbox next to the Bend radius input field. Pro-
ceed in the same way with the Allowance method.

Under Offset you select to which side the sheet thickness (material thickness) is to be removed.
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The following options are available for the processing of bend zones:

No special pro-
cessing

Bend zones that meet in a corner of the sheet are shortened to avoid over-
lapping.

Flush If several bend zones converge in one corner, the sheet is widened in the
corner to make room for the bend zones. The front surfaces of the bend
zones are flat surfaces. They are not adjusted to the adjacent flanges..

Flush and cor-
rected

If several bend zones converge in a corner, the sheet is widened in the
corner. The front surfaces of the bend zones are adjusted to the adjacent
flanges.

The arcs of the guidelines are approximated synchronously by polygon lines so that two lines lie in one plane and
thus define a flange. You define the accuracy of the resulting sheet metal flanges in the Accuracy criterion area.

Inputs that cannot be evaluated are marked with the symbol.

Once you have entered all the required data, the connecting sheet can be inserted as shown in the preview. If you
select Apply or press the middle mouse button, the flange is inserted, but the dialogue window remains open - in
contrast to OK. This way you can change the data and assign it to other sketches with Apply.

(1) First and second guideline in a 3-D sketch

(2) Connecting sheet

(3) Accuracy criterion: Angle 5
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New attributes for calculating the surface area of sheet metal parts
In HiCAD, new system attributes are available for sheet metal parts and coated surfaces:

§SOC Calculate surface area from the development contour, internal exclusions and processings are
ignored

§S2D Calculate rectangular surface area of the development from length * width

§CW Calculate weight from the rectangular surface area of the development

§SC Calculate the coated surface area for coated sheet metal parts

In the Configuration Editor, at Modelling > Part properties, you set the system attributes for when the calculation
should take place, e.g. for the creation of bills of materials.

The following three procedures are available for selection:

n Do not auto-calculate

n Only for automatic itemization

n Always

2-D DXF/DWG export with new settings
In order to be able to edit the settings more comfortably when exporting developments as 2-D DXF/DWG files, new
functions have been integrated.

These replace the manual editing of system files (acadhcad.dat, hcadacad.dat), which are thus no longer required
in this form.

However, settings from older configuration files can still be read in and taken into account accordingly.

You can load the ISD defaults with this icon , customise them with the Edit settings function and then save
them as Favourites under a new name. .
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Planar symbol for all processings in the development
For developments, symbols can be output for processings (bore patterns, punching tools, ...). To do this, the symbol
must be entered in the TOPSYMBOL and BOTTOMSYMBOL columns in the Catalogue Editor.

You can also extend tables (e.g. countersinks) with these columns yourself and thus output symbols during devel-
opment. To do this, add the TOPSYMBOL and BOTTOMSYMBOL columns to the table in theCatalogue Editor and
then enter a relative path to the symbol file. This can be 2-D/3-D parts (FGA, KRA) or HCM models (DCF).

In the development, select the option Planar symbol from catalogue on the Extended representation tab in the
Extended settings dialogue.

Please note:

To read out the symbol in the development, processing must be done in the sheet metal flange..

(1) The planar symbol from the catalog is displayed.

(2) Example of a bore pattern displayed in the development
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Part orientation in workshop drawings for New sheet along sketch function
Up to now, with the New sheet along sketch function, the part orientation of the front view was placed on the cross-
section surface. However, this is not useful for the workshop drawing, as the front view is evaluated for the drawings.
Therefore, the front view is now placed on the sheet so that the drawings can be evaluated better.

When creating a sheet along a sketch, both the part orientation and the dimension direction are set.

New groove form for milling edge zones
In the catalogue Factory standards > Composite panels, groove form, the table Standard groove form has been
extended by an entry for easy fiX side milling cutters V 135°, 3 mm. This groove form can be selected when attach-
ing flanges.
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Drawing derivation: New Usage for Sheet Metal assemblies
For Sheet Metal assemblies, i.e. assemblies with a Sheet Metal part as the main part, a new usage is available: Sheet
Metal Assembly. The catalogue Factory standards > Usage has been extended accordingly.

For assemblies with this usage, usage-dependent configurations can be used for the drawing derivation, which are
managed in the Configuration Editor as with other usages. For assemblies with the usage Sheet Metal Assembly the
configuration ASSEMBLY_SHEETMETAL is predefined.
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Steel Engineering

Service Pack 2 2023 (V 2802)

Insert new beam
The function for inserting beams and profiles has been redesigned and significantly expanded with SP2. With the

new Insert new beam function, not only 3-D standard beams and profiles but also multi-part standard beams,
prototype beams and elongated plates can now be inserted. The selection is made in the following catalogues:

n Semi-finished products > Plates,

n Semi-finished products > Cold rolled sections,

n Semi-finished products > Beams + Profiles,

n Factory standards > Multi-part standard beams and

n Factory standards > Prototype beams.
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Once you have now entered the required parameters, a preview of the beam is displayed. Another new feature is
that a fitting point can now be selected to simplify insertion.
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The previous functions for beam insertion (before HiCAD 2023), which are now integrated into the new functionality,
are still available in the menu under Up to HiCAD 2022.
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Coat beams and profiles
In addition to sheets and plates, as well as general 3-D parts, beams and profiles can now be processed with the

Coating function.

You can find the function at Steel Engineering > Further functions > Coating.

Purlin joint according to DAST PM/PQ (2415)
The previous design variants for purlin joints,

n Purlin joint acc. to DAST PM (405) and

n Purlin joint acc. to DAST PQ (415)

have been replaced with SP2 by the new Design Variant Purlin joint acc. to DAST PM/PQ (2415). This variant con-
nects two beams by beams of a rigid joint. Allowed are I- and U-beams, which have to be aligned accordingly. The
insertion can be carried out can be user-defined or - with corresponding beams - based on a table according to
DAST PM or PQ.

In the user-defined configuration, the joint can be created with one strap each on the upper and lower flange as well
as on the web, whereby all straps as well as the corresponding boltings and hole patterns can be set separately. U-
beams or flat steels are possible as straps. The connection can be created flush or with clearance.

(1) User-defined, (2) DAST PQ, (3) DAST PM
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Automatic dimension calculation for beams and plates
Beams

If the automatic dimension calculation is active in configuration management, the calculation for beams can now be
restricted so that only the length is determined by the automatic dimension calculation and any values for width and
height transferred from the catalogue are retained.

Plates

If the automatic dimension calculation is activated in the Configuration Editor, length, height and width are cal-
culated and assigned to the attributes Length ($03), Width ($02) and Height ($04). Length and width are sorted.
That is, the largest value is assigned to the length..

Steel Engineering plates - Development length and Development width
For Steel Engineering plates, the Length, Width and Height are now additionally assigned to the attributes

n Development length (§L2D),

n Development width (§B2D) and

n Sheet thickness (§T2D)

In this way, uniform bills of materials can be created for Sheet Metal parts and Steel Engineering plates..

Unlike Sheet Metal parts, the values are calculated automatically, i.e. the settings for Sheet Metal parts in the Con-
figuration Editor at Modelling > Part properties do not apply to Steel Engineering plates!

For drawings saved before HiCAD 2023 SP2 (V 2802), a feature recalculation must be performed in order for the val-
ues to be calculated.
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Laminated glass

Laminated glass - Definition of the article number

For the individual layer structure of laminated glass, various options are now available for defining the article num-
ber:

n Manual
The article number can be assigned as desired.

n Automatic
The article number is automatically generated based on the layer structure by combining the designations of the
individual layers separated by a separator. The default separator is "/". However, this can be changed in the Con-
figuration Editor at Steel Engineering > Products > Laminated glass pane > Separator for auto-generated art-
icle number of a laminated glass pane.
Example: ESG 8/RV ISD-08/ESG 6

n Automatic, with total thickness
Here, too, the article number is generated according to the layer structure as with the option Automatic, but
here the total thickness is also output.
Example: VSG 16,2 mm (ESG 8/Folie 0.2/TVG 8)
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Additional layer thicknesses

From SP2 onwards, the Laminated glass function makes additional film thicknesses available when installing
individual glass panes with foil layers - 0.38, 0.76 and 1.52, each in matt and clear version.
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Changed default setting for beam and profile representation
The default setting for the type of beam and profile representation has changed. Beams and profiles are represented
exactly by default from SP2 onwards. The default setting can be changed in the Configuration Editor at Steel Engin-
eering > Representation > Type of beam representation. The changed default applies to new installations only.

Rectangular plate - New function

For the insertion of rectangular plates the new function Rectangular plate is now available at Steel Engin-
eering > Plate, new. The previous function Standard has been moved to the sub-menu.

The new function can be used to install plates from the HiCAD catalogue Semi-finished products > Plates. The func-
tion basically corresponds to the Sheet Metal function Create base sheet.

n Semi-finished product selection,

n Insertion via points or value input,

n Referenced saving,

n Feature creation,

n Integrated preview function.
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Enhanced bar list
As of SP2, the Excel bar list displays not only the waste but also the actual length used. The BOM template for Steel
Engineering has been adapted accordingly. (see also: Report Manager - What's new?).

Enhanced Staircase Configurator
n Stairs can now also be created without platforms. For this purpose, the new variant Do not create is available on

the Platforms tab.

n If Standardized grating step is selected as the variant on the Steps tab, the direction of the bolted connection
can now be reversed. To do this, activate the new Bolts from inside checkbox.

Left: Bolts from outside, Right: Bolts from inside
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Gratings - Dimension calculations
In the dimension calculation, the bearing bar direction of gratings is assigned to the attribute Length ($03). The bear-
ing bar direction is ignored in the dimension calculation if the direction is set manually for the grating. This concerns
the following cases:

n The dimension orientation is set.

n The part orientation is set.

n The processing direction is set.

The bearing bar direction is also taken into account for the part and dimension orientation.

The part orientation results from the bearing bar direction (only for Grating steps DIN 24537).

The part orientation results from the bearing bar direction of the assembly main part (only for Grat-
ings steps DIN 24537).

The dimensions are up to date, the dimension orientation results from the bearing bar direction (only
for Gratings steps DIN 24537).

The dimensions are up to date, the dimension orientation results from the bearing bar direction of
the assembly main part (only for Grating steps DIN 24537).
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Unbend beams and profiles
Multi-part beams and profiles consisting of straight and circular curved sections can also be unbent. However, the
sections must merge tangentially.

With HiCAD 2023 SP2 (V 2802) the geometric algorithm of the unbending calculation has changed. Therefore,
there may be changes in the result. In particular, beams, which could also be unbent before, lie differently in space
(see image). However, beams already unbent with a version before HiCAD 2023 SP2 will not be changed.

(1) Unbending with HiCAD 2022, (2) Unbending with HiCAD 2023 SP2
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Railing Configurator - New variant for knee rails
Knee rails of a railing can now also be inserted into the post. For this purpose, the new variant Insertion into post is
available on the Infill tab for infills with knee rails.
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Service Pack 1 2023 (V 2801)

Railing Configurator - new base plate types
In the Railing Configurator, new base plate types are available on the Post - Sub-structure tab:
n One-sided, no bore,
n One-sided, 1 bore,
n One-sided, 2 bores in transverse direction
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(1) One-sided, no bore; (2) One-sided, 1 bore; (3) One-sided, 2 bores in transverse direction
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Purlin joints 3204 and 3206
The Purlin joints 1204 and 1206 have been modernised and adapted to the HiCAD standard. In this context, the
joint numbers have been changed to 3204 and 3206.
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For example, the current settings are now visualised in the model drawing during input, e.g. the insertion direction,
stiffeners and boltings.

In addition, there are now - compared to the previous purlin joints - more setting options available. Examples are the
offset of the purlin to the beam and the usages for the assemblies, etc.
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Cross-bracings 2601 / 2602 - Distance of the gusset plates from the flange
From HiCAD 2023 SP1 onwards, Cross-bracings 2601 and 2602 can also be installed with indication of the dis-
tance of the gusset plates from the front or back flange. This is used, for example, in hall construction. There it can
happen that a cross-bracing is to be installed between two differently sized beams whose upper flanges are on the
same level.

For this purpose, the Fixing tab has been extended accordingly.

In this case, however, the gusset plates cannot be fixed to the flange, i.e. the corresponding checkbox on the Con-
necting points tab must not be active.
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Example:

The Cross-bracing 2601 shown was selected with the following settings for the 1st and 2nd diagonal:
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Major Release 2023 (V 2800)

Dialogue windows for connections
Opening the dialogues of Steel Engineering connections and scrolling through the dialogues has been accelerated.

Circumferential seams for stiffeners
For stiffeners, circumferential seams are often used in practice, which also makes drawing in particular much
easier. For this reason, the corresponding tabs of the following design variants have been extended:

Design variant Tab

Stiffener (2401) n Others

Strap joint (2310) n Weld seams

Beam to web, with 2 plates + stiffener (1211) n Weld seams- Front plate
n Weld seams- Stiffener

Column connection, Frame corner (2203) n Weld seams- Front plate
n Weld seams- Tension plate / Top

plate

Column connection, Frame corner (2204) n Weld seams- Front plate
n Weld seams- Tension plate / Top

plate

Please note that circumferential seams cannot be applied to haunches and ribs.
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Beam to web, with 2 plates and stiffener - Optional 2nd stiffener
With the Beam to web, with 2 plates and stiffener (1211) connection, a second stiffener can now be optionally
installed - aligned with the first stiffener.
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Bar Configurator - Bars on free sketch
With the Bar Configurator, the area between the edges of a "free" sketch can now also be filled with bars. Until now,
only square sketches were allowed here.

After selecting the sketch, you determine the lower edge of the installation area and then the direction of the install-
ation or you select the installation perpendicular to the lower edge.

The installation of the bars is always determined by the sketch line defined as the Bottom (see A in the example), so
the entire sketch is not necessarily filled with bars.
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Example

The area between the six edges of the sketch shown is to be filled with bars..

A: (1) lower edge, (2) direction / B: (1) lower edge, (2) perpendicular to lower edge
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Railing Configurator - Elbow at hand rail end
On the Handrail tab of the Railing Configurator, elbows with/without end cap or steel plates can now be placed at
handrail terminations.
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3-D grid 
As with the 3-D function of the same name, the dialogue window of the 3-D grid function has been revised and mod-
ernised.

Also new is that you can use formulas instead of values for the distance specification - also in mixed units. The value
is then converted into the unit of measurement of the model drawing.

Example:
Unit of measurement of drawing: mm, Distance: 1 3/4" + 12.5 mm. Result: 56.5 (mm).
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Rectangular plates - Revised dialogue

The dialogue window of the function Rectangular plates has been revised and modernised.
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Settings for weight calculation
In the Configuration Editor, the settings for weight calculation have been moved. You can now find the parameters at
Modelling > Part properties.
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Drawing Management

Service Pack 2 2023 (V 2802)

Updating mounting drawings
When updating mounting drawings created with the setting

New view group via active assembly(-ies),

from SP2 onwards only the parts of the view group belonging to the selected assemblies are taken into account and
not all parts lying within the bounding box.

Example:

A mounting drawing with the setting New view group via active assembly(-ies) is to be created for the Assembly
Outer frame shown below.
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Now the two cross-beams (IPE200) are combined into one assembly, which is moved up one level in the hierarchy.
This means that both assemblies are now on the same level. Next, the drawing is itemised and saved. Then the
mounting drawing is updated with the function New view group via active assembly(-ies).

Although the IPE200 assembly is in the bounding box of the view group, it is now not included in the mounting draw-
ing because it does not belong to the Assembly Outer frame.
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Production drawings for mounting assemblies
In the Configuration Editor at PDM > Drawing Management > Production drawings the new parameter Production
drawings for mounting assemblies is available. With this parameter, mounting assemblies (Type: Bolted assembly)
can be excluded from the production drawings if required. The default setting is Yes.

If No is selected here, no production drawing is created for the mounting assembly. However, the drawings for the
individual parts of the assembly are created.
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Service Pack 1 2023 (V 2801)

Derive parts and assemblies
The following new Derive functions are now available:

Derive article masters and linked drawings of the active assembly, incl. sub-parts

With this function, a new assembly is derived (copied) from the active assembly - also possible
with structure assemblies - including all sub-parts and all links. This means that article masters,
indices, item numbers and all linked drawings are also copied.

Derive article master selected via HELiOS, incl. sub-parts and linked drawings

This function works essentially like the function above. Here, however, the active assembly is not
derived, but the part or assembly to be derived is selected by selecting the corresponding article
in HELiOS.
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Major Release 2023 (V 2800)

Check, release, index models
To change the workflow status and to index models (.SZA files) that have not been automatically created by Drawing
Management, it was previously necessary to switch to the HELiOS Desktop and call the corresponding function
there via the context menu for articles/documents.

As of HiCAD 2023, these options are now available directly in the Drawing Management Ribbon via the Release
function in the Model function group.

Output of PDF data in black and white
PDF files can now also be created in black and white. For this purpose, the settings in the Configuration Editor at
PDM > Drawing Management > External production documents have been extended accordingly.

Workflow when creating general documents
As with production drawings, mounting drawings and customer drawings, it is now also possible to select when gen-
eral documents in DXF, DWG and PDF format are to be created. For this purpose, the settings in the Configuration
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Editor at PDM > Drawing Management > External production documents have been extended accordingly.
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Metal Engineering

Service Pack 2 2023 (V 2802)

Extended transfer of LogiKal attributes
The HiCAD part attribute LogiKal item name ($LPN) was already assigned automatically in earlier HiCAD versions
for glass panes, beams and profiles imported from LogiKal.

As of Service Pack 2 of HiCAD 2023, this attribute assignment is available individually for glass panes, beams and
profiles.

Since this attribute is composed of several LogiKal attributes that are different for glass panes, beams and profiles,
the item name can now also be transferred to other HiCAD attributes if required.

In addition, the attribute mapping between HiCAD and LogiKal has been extended by some more number and text
attributes:

5 new, transferable numerical attributes are [Glass] Acoustic Performance, [Glass] Light Transmittance, [Glass]
Solar Factor and [Glass] Weight for glass panes, as well as the [Insertion] Handle height (from FFL) for profile
inserts.

These LogiKal attributes can be assigned to corresponding user-defined HiCAD attributes via the Configuration
Editor.

248 / 382 What's new?

Metal Engineering

../KonfigEinstellungen/logikal_konfig.htm
../KonfigEinstellungen/logikal_konfig.htm


New transferable text attributes for Hardware parts of profile inserts are also compiled from several LogiKal attrib-
utes: If Hardware parts exist, a total of ten attributes each contain a composite description text of the Hardware part
of an Insertion part.
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Importing all items of a LogiKal project
From SP2 onwards another import function is available:

All facades+insert elements

With this function all items of a LogiKal project can be imported into HiCAD in one step.

After calling up the function, the LogiKal Project Management dialogue is displayed as with the single import.

Select the desired project and click on Select Project.

The Fitting options dialogue window is then displayed.

Select the desired options and then OK.
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The LogiKal data for all items of the project are now prepared internally. This may take a moment, depending on the
size and number of items of the project.

The import will then be started. A progress bar is displayed during the import. The imported items will be auto-
matically placed in the origin of the drawing.

The import can be cancelled by pressing the ESC key. The item import currently in progress will be completed
before the prompt shown appears:

If you click Yes, the import will be cancelled.

If errors occurred during the import or if an item cannot be imported at all, an error log will be displayed:
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Major Release 2023 (V 2800)

Omission of the LogiKal login window
Until now, a login window was displayed the first time a LogiKal function was called up:

This window is no longer needed and will therefore be omitted from HiCAD 2023.
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Configuration of the name of LogiKal items in HiCAD
Up to now, when importing LogiKal items into HiCAD, the fixed setting Project name + Position was always used as
the name of the top assembly, both separated by commas and with the character # in front of the number of the
LogiKal item (e.g. Rounded glass, #001).

As of HiCAD 2023, only the item, the project name or the short description can be used as the name of the
assembly. The Fitting options dialogue window has been extended accordingly.

Please note:

n The setting for the level of detail and for the name of the top assembly Detail are defined once when import-
ing a LogiKal item. HiCAD remembers this setting for the built-in LogiKal item. A subsequent change is not
possible.

n When updating a LogiKal item imported into HiCAD, the name is also updated according to the selected
name setting.

n LogiKal items imported into a model drawing with a version before HiCAD 2023 do not have a name setting.
Here, the setting Project name + Position is used as the name of the assembly as before (before HiCAD
2023).
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LogiKal Interface - Transfer of Text Attributes to HiCAD
When importing LogiKal items (which are called "positions" in LogiKal), certain LogiKal text attributes can be spe-
cifically assigned to certain HiCAD attributes. The setting is made in the Configuration Editor at Interfaces > LogiKal.

This is possible for the following LogiKal attributes:

Attribute
Attribute
type

Example / Explanations

Description Position
attribute

e.g. window element

Description
short

Position
attribute

is defined by the user

Position num-
ber

Position
attribute

e.g. 001

Rule package Position
attribute

e.g. RC3

Subsystem Position
attribute

e.g. BL

Description 1 Glass attrib-
ute

is defined by the user for project glasses

Description 2 Glass attrib-
ute

is defined by the user for project glasses

U-value Glass attrib-
ute

The U-value is transferred to the HiCAD attribute §26=Heat trans-
fer coefficient (U- value). This setting is fixed and therefore
locked.

Type Insertion
attribute

e.g. fixed field

What's new? 255 / 382

News Overview

../KonfigEinstellungen/logikal_konfig.htm


Attribute
Attribute
type

Example / Explanations

Openiing dir-
ection

Insertion
attribute

e.g. L or R

Hardware pack-
age

Insertion
attribute

WIC 40001 REBATE GEAR 160 KG FITTING CONCEALED

In order to assign one of the listed attributes to a HiCAD attribute, simply select the desired HiCAD attribute in the
selection box in the corresponding line, e.g.

In addition to the attributes listed above, the following HiCAD attributes are automatically assigned:

n The LogiKal Position name is automatically assigned to the HiCAD attribute $LPN.

n For the top assembly of the LogiKal item the HiCAD attribute Article number $BB is determined by the settings
in the Fitting options dialogue when importing LogiKal positions (name of the top assembly).
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If one of the LogiKal item attributes listed in the table above is assigned to the HiCAD attribute $BB, then this
assignment has priority over the name setting in the fitting options.

If further LogiKal attributes are to be transferred, the use of customer-specific system attributes may also be
useful. You can find out more about this in the Help of the Catalogue Editor in the topic System Attributes and Sys-
tem Colours.

Please note:

n The attribute assignment settings are set once when importing a LogiKal item. HiCAD remembers this set-
ting for the installed LogiKal position. A subsequent change is not possible.

n When updating a LogiKal position imported into HiCAD the attributes are also updated according to the
noted attribute assignment.

n For LogiKal positions imported into a model drawing with a version before HiCAD 2023, no attribute assign-
ment is used.
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Element Installation

Service Pack 2 2023 (V 2802)

Feature - Enhanced Create new function
When editing an element installation, no complete recalculation is performed, but only the installation elements
selected for editing are handled. If, for example, you have edited parts of an installation element with functions out-
side the element installation, e.g. moved, deleted or drilled, and this installation element is not changed by selecting
another variant or changing the parameters, then these parts remain moved, deleted, drilled, etc.

This behaviour can be changed afterwards with the function Create new in the context menu of the feature Element
installation. Previously, dimensions and other edits, e.g. drilling, to parts of the installation elements were lost. As of
SP2, these are retained.

The same applies to sub-structures.

You can find an example here.
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Major Release 2023 (V 2800)

ALUCOBOND® SZ 20 tray panel (with accessories)

New tab

When installing ALUCOBOND® SZ 20 tray panels (with accessories), the settings for stiffener profiles are now avail-
able on a separate Bracing tab.

Bracing - Individual setting left/right

For the stiffeners, the settings for the left and right sides can be defined separately. To do this, select the new Indi-
vidual setting left/right option for Sub-type.
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Maximum spacing of screws for sub-structure

For ALUCOBOND® SZ 20 tray panels, the maximum spacing of the screws for the sub-structure can now be
defined. The Extended settings tab has been adapted for this purpose.

ALUCOBOND® SZ 20 Polygon (3-8) - Stiffener profiles
When installing panels of type ALUCOBOND® SZ 20 Polygon (3-8), further options are available for the edge con-
figuration:

n Stiffener profile
Stiffener profiles are always riveted to the sheet. You define the profile type and the maximum distance of the riv-
ets on the Extended settings tab.

n Double folding
Instead of inserting stiffener profiles on the edge, the material can also be double folded.
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(1) Standard, (2) 44024, (3) Without flanges, (4) 44025, (5) Stiffener profile, (6) Double folding
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Design variants - SZ20 Base point with projection
The dialogue window now has a Preview button, so that the result can be visualised and checked graphically on the
basis of the current entries before applying any changes.
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Revised Wall bracket ALUCOBOND U
The ALUCOBOND U-bracket table has been replaced by the Systea U-bracket table. These wall brackets consist of
two parts:

n Wall consoles (Systea )

n Thermostop (Systea )

As an example, the following brackets are provided:

n Fixed point:

l UH 60/55/60-160
l Thermostop 40/6-160 mm

n Sliding point :

l UH 60/55/60-70
l Thermostop 40/5-85 mm
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The following image shows a wall with an ALUCOBOND SZ20 element installation with an attic and a sub-structure.
The wall brackets have been installed with the settings shown.

Left: (1) Wall plane, (2) Roof plane, (3) Sub-structure/ Right: Result
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The wall brackets are installed as a structure assembly and combined in an assembly called Fixing.
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ALUCOBOND © easy fiX
When installing ALUCOBOND easy fiX profiles, you now have the option of selecting a Mode for their insertion:

Maximum distance
In this mode, the number of profiles created is calculated using the value specified here.

n Number
If this mode is selected, the value specified here determines how many profiles will be created. This value only
applies to profiles that are not continuous.
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Profile Installation

Service Pack 1 2023 (V 2801)

Part filters for sub-parts

With the Find function in the transparent toolbar, the sub-parts of the profile installation can also be easily
selected from SP1 onwards. This concerns the following parts:
n Contour, cut,
n Contour, uncut,
n Sandwich panel, outside sheet,
n Sandwich panel, inside sheet,
n Insulation and
n Others, e.g. sealing chords.

To filter these parts, the rule Profile sub-part type (Profile Installation) is available under Properties.

If you select this rule (is / is not), you can determine the sub-part type to be filtered.
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Example:

Let's take a look at the depicted part structure of a 3-D drawing. Only the first assembly consists of assemblies cre-
ated by the profile installation. However, both assemblies contain outside and inside sheets with the same name.

Now we define the following part filter:
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If this filter is executed, then only the Sandwich panel, outside sheet that was created by the profile installation will
be selected.
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Coating
Up to now, the inside and outside colour could be selected from the Textures and Colours catalogue in the profile
installation dialogue. As of HiCAD 2023 SP1, the coating type is selected from the catalogue Factory standards >
Surface treatment instead. This applies to the Other properties and Specializations tabs.
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Major Release 2023 (V 2800)

Cut lengthening - new part attribute
The Cut lengthening, i.e. the extension of diagonally cut installation elements, is now assigned to each installation
element as the attribute DWF_CUTTING_BUFFER. In this way, the value can also be output in annotation blocks,
for example..
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Changing the property of individual profiled sheets
HiCAD 2023 also offers the possibility to change the properties of individual profiled sheets. For this purpose, the
profiled sheet installation dialogue has been extended by a new Specializations tab.

With the options of this tab, you have the possibility to assign a profile type to individual or several profiled sheets
that differs from the basic settings of the installation surface. In addition, the selection of colour and interior colour is
possible.

The function also supports multiple selection.
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Plant Engineering

Service Pack 2 2023 (V 2802)

Eccentrically inserted pipes
The insertion of a pipe is often done by placing both pipes on the ground and then cutting/welding them together.
Accordingly, the inserted pipe must be able to have a distance 0 from the outer wall of the larger pipe. However, the
previous implementation in HiC 2023 (V 2800 and 2801) forces a distance of at least the wall thickness of the larger
pipe.

For this particular use case, the function Align component connection tangentially has been adapted in SP2.
Instead of the internal distance to the outer wall, the distance to the outer wall must now be specified.

In addition to the sensible input range, the wall thickness of the larger pipe is now displayed in the title line of the
input window. So if you want to emulate the previous behaviour (A) and assign an internal distance of 0 to the inser-
ted pipe, enter the wall thickness as the distance.
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(A) up to HiC 2023 SP1: Outer diameter of inserted pipe tangential to inner diameter of main pipe

(B) from HiC 2023 SP2 onwards: Outer diameter of inserted pipe tangential to outer diameter of main pipe, constructive distance

0.1 mm

Please note:

To avoid unaesthetic protrusions on the inserted tubes, the function ensures a minimum constructive distance of
0.1mm.
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Pipe parts: Prevent seals
The insertion of seals and gaskets can be prevented via the article master of a corresponding part. To do this, set the
attribute value for Seal in the article master to the value - (minus). This ignores seal settings at all connections of the
part, i.e. no seals are set. This also applies when other parts are connected to this part.

Example:

Nozzles for DIN EN 1092-1
With SP2, new variants are available for nozzles:

n STUTZEN_FL_PN10.vaa

n STUTZEN_FL_PN16.vaa

n STUTZEN_FL_PN25.vaa

n STUTZEN_FL_PN40.vaa

These are revisions of the variant STUTZEN_FL1.vaa, which still refers to the old standard DIN 2630.

The following seal variants have been added to the parts inventory to match the new nozzles:

n DIN1514-1-PN10.vaa

n DIN1514-1-PN16.vaa

n DIN1514-1-PN25.vaa

n DIN1514-1-PN40.vaa

These variants are summarised in the list file nozzles_1092-1.lst.
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New malleable cast iron fittings
The stock of Georg Fischer malleable cast iron fittings according to standard EN 10242 has been extended by two
further variants:

n GF10242_S330.VAA und

n GF10242_S331.VAA.

Welding neck flanges acc. to EN1092-1-11-C/D
The parts inventory for Plant Engineering has been expanded with SP2 to include the following variants:

Flanges with notch Flanges with groove

EN1092-1-11-C-PN10.vaa

EN1092-1-11-C-PN16.vaa

EN1092-1-11-C-PN25.vaa

EN1092-1-11-C-PN40.vaa

EN1092-1-11-C-PN63.vaa

EN1092-1-11-C-PN100.vaa

EN1092-1-11-C-PN160.vaa

EN1092-1-11-C-PN250.vaa

EN1092-1-11-C-PN320.vaa

EN1092-1-11-C-PN400.vaa

EN1092-1-11-D-PN10.vaa

EN1092-1-11-D-PN16.vaa

EN1092-1-11-D-PN25.vaa

EN1092-1-11-D-PN40.vaa

EN1092-1-11-D-PN63.vaa

EN1092-1-11-D-PN100.vaa

EN1092-1-11-D-PN160.vaa

EN1092-1-11-D-PN250.vaa

EN1092-1-11-D-PN320.vaa

EN1092-1-11-D-PN400.vaa
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Also new are the following variants:

EN1092-1_Insertring.vaa Insert ring to connect two grooved flanges to each other.

The insert ring is classified as a valve and behaves like an intermediate flange
valve when bolted together.

Seals

DIN2691_grooved_gas-
ket.vaa

EN1541-1_FLAT_
GASKET.VAA

EN1541-2_SPIRAL_
GASKET.VAA

The thickness of the gasket represents the thickness after installation.

Flanges up to and including PN63 have a seal according to EN1541-1 in their attribute DICHTUNG (Seal). The
flanges from PN100 onwards, on the other hand, have the seal according to EN1541-2.

All new variants are summarized in the list file EN1092-1-11-C+D.lst.
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New part attribute "Pipe clamp support type"
As of SP2, the attribute Pipe clamp support type - attribute name PIPE_SUPPORT_TYPE - can be assigned to pipe
clamps in the part attributes.
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By assigning this attribute, different pipe clamp types can be displayed in ROHR2.

BOM tables - Line breaks
Three BOM tables can be generated automatically in isometries and pipe spool drawings.

n Pipe BOM,

n Pipe length list and

n Weld seam list.

The cells of these tables are filled from the attributes of the parts or by fixed default values. You can define the width
of such a cell in the Configuration Editor.

What's new? 279 / 382

News Overview



On the other hand, this can also be done directly in the isometry or pipe spool drawing settings if you deactivate the
Column layout option.
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Previously, texts that were too long for a table cell were automatically shortened by HiCAD. The shortening was
marked by an ellipsis (...). As of HiCAD 2023 SP2, texts that are too long are wrapped.

(1) before HiCAD 2023 SP1, (2) as of HiCAD 2023 SP2

However, the automatic line break is only applied to BOMs that appear on the drawing. BOMs that are saved in files
contain the full text without shortening and without additional line breaks.

If you edit the BOM manually, no line breaks are inserted. If the lines become too long, the text is shortened. When
manually editing with the Edit list function, you have the option of forcing a line break with <CTRL>+<INPUT>.
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Part insertion - Check pipe class for reference parts

If a pipeline with a pipe class is active when selecting the Part insertion function, then the functions

n Select reference part and

n Select reference part depending on part type

a message is displayed if the pipe class of the selected reference part does not match the pipe class of the pipeline.
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However, the part can still be selected as a reference part.
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Isometry - Set reference coordinate system per pipeline
Normally the world coordinate system of the layout plan is used as the reference coordinate system for determining
coordinates in the isometries and pipe spool drawings. However, you can give pipelines a reference coordinate sys-
tem that is taken into account when generating isometries and pipe spool drawings, e.g. when displaying coordin-
ates in annotation tags.

To do this, use the Set reference CS for isometry function (Plant Engineering > Isometry/Pipe Spool Drawing >

Ref... ).

Previously, a reference coordinate system set with this function was valid for all pipelines in the drawing. It was not
possible to restrict this to individual pipelines.

For SP2 this function has been adapted so that it sets the reference coordinate system of individual pipelines.

The prerequisite is that a local coordinate system exists in the layout plan. For this purpose you can use, for

example, the function Plant Engineering > Settings > Settings > Set on connection . If no local coordinate
system is defined, a corresponding message appears:

If a local coordinate system exists, you are prompted to select a pipeline when you start the Ref... function. you
will be asked to select a pipeline.

As soon as the graphic cursor is moved over a pipeline, it is displayed directly at the cursor whether the pipeline
already has a reference coordinate system.

One of the three following messages can be displayed:

n Without reference coordinate system so far
By clicking on the pipeline the local coordinate system is taken over as the reference coordinate system of the
pipeline.

n Reference coordinate system corresponds to local coordinate system

n Reference coordinate system deviates from local coordinate system
The local coordinate system has been changed subsequently.
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In the dialogue of the isometry as well as the pipe spool drawing generation it is marked by the symbol whether a
pipeline has a reference coordinate system.

Likewise, the function Delete reference CS for isometry has been adjusted, i.e. the function deletes the ref-
erence coordinate systems of individual pipelines. As soon as the graphic cursor is moved over a pipeline, you are
informed directly at the cursor whether the pipeline already has a reference coordinate system. The messages are
the same as when setting a reference coordinate system.
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Display of projection lines in isometry and pipe spool drawing
To display the projection lines in the isometry and in the pipe spool drawing, use the settings in the Configuration
Editor at Drawing > Annotations > Dimensioning, 3-D > Interactive dimensions.

PartDataAutoSync / DBPlantDataImport

PartDataAutoSync - Deleting articles

The tool PartDataAutoSync deletes articles for which there is no sub-type in the variant file. If the deletion fails, the
message Data AutoSync incomplete is displayed directly in the dialogue. A list of the articles for which deletion failed
appears in the log, e.g.:

Unsynchronized articles:
Deletion of article failed: HELIOS:\\B00XIKCF0R3DD0000040F0_0
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Check of Consistency Between Archive File and HELiOS Article
In both PartDataAustoSync and DBPlantDataImport you can now get an overview of how the sub-types of an
archive file (i.e. VAA or PAA) are displayed as linked articles in HELiOS.

For a concrete variant, there is usually a linkage structure that looks something like this:

So in the VAA file several sub-types are defined, which are identified by an article type, which in turn is mapped in
HELiOS to the attribute HEL_TYPNAME.

When the VAA file is transferred to HELiOS, the following are created:

n a document master,

n an article master for the general type and

n one article master for each sub-type.

These articles together with the general type form the main section and are connected to each other by links. The
articles are characterised by the fact that identifiers are stored for them, which can be found again in the VAA file.
These are the Plant IDs.
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In addition, further sub-sections may have been created with the HELiOS function Derive variant .. These are
also linked to the document master, but have no unique identifiers. Instead, these items can be assigned to the sub-
types via the item type.

To get an overview of the current state of this linkage structure before matching a variant, use the function Con-
sistency check File <-> HELiOS. This function is available in the part data sync in the context menu of the file selec-
tion.
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After executing the function, the file compare_file_to_HELiOS_protocol.txt. can be found in the HiCAD Temp dir-
ectory. In addition, the Notepad opens automatic and displays the contents of the file. The content looks something
like this:

09.01 .2023 09 :14 :12 :

F i l e : A2RF1_100.vaa

Genera l type : HELIOS : \ \B00A137W6LK2UT00008TXJ_0

Status : Sub-sec t i on der ived v ia HEL iOS

Ar t i c l e t ypes o f sub- t ypes fo r wh ich no ar t i c l e ex is ts :

300

Ar t i c l es wi thout ar t i c l e t ype : none

Ar t i c l es wi th ar t i c l e t ype that does not ex is t in the arch ive :

HEL IOS : \ \B00A137W6LK2UT00008TXK_0

HEL IOS : \ \B00A137W6LK2UT00008TXN_0

Ar t i c l es that cou ld not be accessed : none

Genera l type : HELIOS : \ \B00A137W6LK2UT00008TXX_0

Status : Sub-sec t i on der ived v ia HEL iOS

Ar t i c l e t ypes o f sub- t ypes fo r wh ich no ar t i c l e ex is ts :

300

Ar t i c l es wi thout ar t i c l e t ype :

HEL IOS : \ \B00A137W6LK2UT00003NR8_0

Ar t i c l es wi th ar t i c l e t ype that does not ex is t in the arch ive :

HEL IOS : \ \B00A137W6LK2UT00008TXY_0

HEL IOS : \ \B00A137W6LK2UT00008TY1_0

Ar t i c l es that cou ld not be accessed : none

Genera l type : HELIOS : \ \B00DH4XULBEB5J000004FY_0

Status : E r ro r : Ma in sec t i on wi th add i t i ona l a r t i c l es

Ar t i c l e t ypes o f sub- t ypes fo r wh ich no ar t i c l e ex is ts :

300

Ar t i c l es wi thout ar t i c l e t ype : none

Ar t i c l es wi th ar t i c l e t ype that does not ex is t in the arch ive :

HEL IOS : \ \B00DH4XULBEB5J000004G0_0

HEL IOS : \ \B00DH4XULBEB5J000004G3_0

Ar t i c l es that cou ld not be accessed : none
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At the top of the file, the date and time of the check is shown, followed by the VAA file that was checked. Then fol-
lows one paragraph for each derived section. So in the above example there are three derivation sections. For each
section, the article of the general type is first output as a HELiOS link. This is followed by the status of the section, i.e.
main or sub-section.

Next, it is listed whether there are deviations from the ideal state in this section, such as:

n Article types of sub-types for which no article exists.
This is OK and occurs if there are additional sub-types in the VAA that have not yet been transferred to HELiOS.

n Articles without article type.
Articles that do not have an article type are linked to the general type. Either this has been deleted or an invalid
link has been created. In either case, this is an error.

n Articles with article type that does not exist in the archive.
Usually occurs when a sub-type has been deleted from the archive. This is not an error. However, it can also
occur if a link has been created to an article that does not come from the VAA file but has an article type. This
would be an error.

n Articles that could not be accessed.
Errors when accessing the article, this first says nothing about the link structure.

Part data sync - Restoring the main section for derivation

It can happen that the main section of a variant is no longer in the database, usually because articles were acci-
dentally deleted.

Until now, the only way to restore this main section was to remove the variant from the database and match it again.
This is particularly annoying if further derivations have already been created for the variant via the HELiOS function

Derive variant , because these are also removed in the process and have to be created again.

As of SP2, the part data sync restores the main section if it could not be found.
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Service Pack 1 2023 (V 2801)

Rotate part: Reverse orientation

The function Rotate part has been extended. You have now the option to reverse the orientation of a part.

However, this is only possible for parts that have two connections and could be placed on a straight piece of
guideline, i.e. parts for which a rotation cannot lead to inconsistencies with the possibly underlying guideline.
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Check article numbers of pipelines
As of SP1, HiCAD 2023 offers the possibility to check whether all pipelines in your drawing have an article number
and whether this number is unique.

For this purpose, the function

Check article numbers of pipelines

is now available at Plant Engineering > Pipeline Tools > Coll... > .... After the check has taken place, a dialogue
is displayed with information about the status of the pipelines. By clicking on an article number, the corresponding
pipeline can be selected directly.

The result list can be output as a CSV file.
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Divide pipeline into connection components
Sometimes it can accidentally happen that one pipeline has been constructed which should actually consist of sev-
eral pipelines. That is, the pipeline consists of several so-called connection components. The following image shows
such an example:

The Divide pipeline function has not supported the division of such a pipeline so far. As of HiCAD 2023 SP1,
the system checks whether the pipeline to be divided consists of several connection components and indicates this
- if so - at the cursor by a corresponding message.
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If the pipeline is to be divided, it is sufficient to click on the pipeline and to answer the subsequent query with Yes.
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Each connection component will then become a separate pipeline.
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Set weld seam gaps manually

At Plant Engineering > Pipeline Tools > Change > ...you can find the new Add/remove gap function.
With this function weld seam gaps can be added to or removed from a pipeline. The behaviour of the function
depends on whether the Consider weld seam gaps checkbox is active in the Plant Engineering settings on the weld
seam gaps tab.

Consider weld seam gaps is activated

After calling the function, HiCAD prompts you to select a connection. If you move the cursor near a weld seam, it will
be highlighted (1). To select the connection for editing, press the left mouse button. HiCAD then prompts you to
determine the way in which a gap is to be added or removed. For this purpose, selectable graphic elements are dis-
played in the drawing (2).

In the example shown you can make the connection

n on the left side,

n centrally, or

n on the right side.

These options are pointed out to you when you move the cursor over the respective graphic element.
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If end points of the pipeline are moved by adding or removing a gap, this is indicated. In the example shown above
(left) this hint appears because the pipeline is connected to a vessel.

With a right-click a context menu can be activated, which can also be used to deactivate the display of the inform-
ation texts.
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In addition, the consideration of maximum lengths can also be deactivated here, but this should be unnecessary as
a rule.

After you have edited a gap (or pressed ESC), you will be asked to select another connection. In the example, we
select the same connection that we have previously edited.

From the direction of the arrows you can see directly whether a gap is inserted or closed.

At mitres, the graphic elements are drawn according to the direction of the pipes involved.
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The position of components such as vessels and pumps is not changed by the function. Accordingly, only one pos-
sible action is offered here.
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Consider weld seam gaps is deactivated

If the Consider weld seam gaps option is deactivated in the Plant Engineering settings, then you still remove existing
gaps. Instead of inserting a gap, however, you are offered to create a space in the pipeline. You are no longer limited
to welded joints. You define the width of the space by entering a value in the calculator.
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Please note that such a space cannot be closed again with this function, as it interrupts the pipeline con-
nection and - unlike a weld seam gap - does not establish a relationship between the parts of the
pipeline. To close the space, use the function Close spaces. Or use the function Change route to drag
the now free end point to another position.
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VOSS-ZAKO flared flanges
The part inventory for Plant Engineering has been extended by ZAKO flared flanges from the manufacturer VOSS.
The following variants have been added:

1 Square pipe flange connection - high-pressure series Z-TTO_Q-
FLANSCHVERBINDUNG_
HD.VAA

2 Square flange connection - high pressure series Z-TPO_Q-NUTFLANSCH_
HD.VAA

3 Pipe-flange connection SAE - standard series Z-TTO_SAE-
FLANSCHVERBINDUNG_
HD.VAA

4 Connecting flange connection SAE - high pressure series with redu-
cer

Z-TPO_SAE-NUTFLANSCH-
HD-RED.VAA

5 Connecting flange connection SAE - high pressure series Z-TPO_SAE-NUTFLANSCH-
HD.VAA

6 Connecting flange connection SAE - standard series with reducer Z-TPO_SAE-NUTFLANSCH-
RED.VAA

7 Connecting flange connection SAE - standard series Z-TPO_SAE-
NUTFLANSCH.VAA

8 Straight pipe according to EN10305, the sub-types of which are
matched to the new VOSS-ZAKO variants.

Z-TPO_PIPE_10305.VAA

The nominal diameters in the manufacturer's specifications have been adapted to the usual nominal dia-
meters.
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Welding necks and handling of loose flanges

New part type and variants

In pipeline planning there is the situation that loose flanges can be inserted once as flanges and once as fasteners.
This leads to problems, especially in interaction with HELiOS, because in the worst case two articles have to be cre-
ated for one part, one as a flange and one as a fastener.

Therefore, existing loose flanges N2642_LF_R1.VAA and N2642_LF_R2.VAA classified as fasteners are additionally
offered classified as flanges as of SP1.

Series Variant * Standard designation

1 N2642_LFC_R1.VAA N2642 R1

2 N2642_LFC_R2.VAA N2642 R2

These loose flanges were previously used as fasteners for welding necks, which were previously designed as
flanges.

As of HiCAD 2023 SP1, there are now welding necks as a new part type. On the one hand, these are designed for
interaction with the regular loose flanges. On the other hand, they support functionalities that are otherwise found in
flanges. One example is the automatic setting at free ends and the automatic counterflanging.

The part families KM10357_WN_DIN.VAA and ROFI10357_WN_ISO.VAA (previously classified as flanges) are
available classified as welding necks:

Variant * Standard designation

KM10357_WNC_DIN.VAA Kieselmann
10357

ROFI10357_ WNC_
ISO.VAA

RO-FI 10357 contains all sub-types of the modelled welding neck

ROFI10357_ WNC_ ISO_
R1.VAA

RO- FI 10357
R1

each contains a share of the sub-types from ROFI10357_
WNC_ISO.VAA

ROFI10357_ WNC_ ISO_
R2.VAA

RO- FI 10357
R2

* The C in the file name of the adapted variants stands for collar (as short form of weld neck collar). The C in the file
name of the adapted parts therefore has an additional C in the name (for collar as short form of weld neck collar).

The loose flanges of Series 1 fit the variant ROFI10357_WNC_ISO_R1.VAA. The loose flanges of Series 2 fit the vari-
ants ROFI10357_WNC_ISO_R2.VAA and KM10357_WNC_DIN.VAA.
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Connection type attribute

Welding necks can provide loose flanges for their connection type. As there is no part type loose flange, it was
defined for welding necks that a loose flange is meant if the part type ID for flanges is used in the connection type,
i.e. 5100010. If welding necks are to be inserted with the loose flange from the connection attributes, the AutoFit
connecting parts option must be activated on the Part selection tab of the Plant Engineering Settings dialogue win-
dow.

To model your own welding neck, please read the information in the topics Part Type: Welding Neck or
Variant for Part Type: Welding Neck.
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Standards in the connection type attribute

As of HiCAD 2023 SP1, a part type ID can be used in the connection type definition without additionally specifying
the standard. For welding neck flanges, you can therefore specify that you want to automatically install a loose flange
without specifying the standard. If the loose flange is not unique, you will be offered a corresponding search mask
(catalogue or HELiOS). However, if you use HELiOS, you must first update HELiOS for Plant Engineering as
described in the next point. If you use the catalogue for part selection, you may have to use the tool vartocat.exe in
the HiCAD exe directory to be able to use the new part type.

New part type "Welding neck"

In HiCAD 2023 SP1, a new part type for Plant Engineering and thus a new article class is available in the form of the
Welding neck.
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If you use HELiOS, you must inform HELiOS of the new classification for welding neck flanges. This is done via the
programme DBPlantDataImport.exe, which you will find in the HiCAD exe directory. There you click on the button
Update HELiOS for Plant Engineering. Afterwards you can use the HELiOS search mask in your HELiOS Desktop.
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Function adjustments

Due to the new part type Welding neck, the functions listed below have been adapted accordingly.

n Part insertion
The new Part insertion function offers for welding neck also the options AutoFlange and In all similar places.

n Pipe parts V26 and Part exchange
In the dialogues of the old Part insertion and Part exchange functions the welding neck can now also be found.

n AutoPlace parts on guidelines
AutoPlacing of parts on guidelines supports welding necks with the new option Welding necks on free ends.
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If this option is activated, then welding necks are placed on all free guideline ends, as for example with the
option Flanges on free ends. If the option Counterflanges has been selected, welding necks that already exist
individually will be counterplaced. If the AutoFlange... option is also activated on the Part selection tab of the
Plant Engineering Settings dialogue window, welding necks are also automatically placed against the newly
placed ones.
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Loose flanges in the connection type attributes of straight pipes

As with welding necks, you can also define loose flanges in the connection type attributes for straight pipes. This is
especially helpful for pipes with (one-sided) welding necks. This allows you to explicitly define the pipe ends where
the loose flanges can be installed.

By eliminating the need to assign a standard in the connection type attribute, you also do not have to specify in the
VAA file which loose flange you want to insert.

For this purpose the following flared pipe have been adjusted accordingly:

n EN10357_PIPE_BEADED_BOTH_PN10_FME4.VAA

n EN10357_PIPE_BEADED_BOTH_PN10_FME8.VAA

n EN10357_PIPE_BEADED_SINGLE_PN10_FME4.VAA

n EN10357_PIPE_BEADED_SINGLE_PN10_FME8.VAA

Align component connection tangentially, via context menu
The function Align connection tangentially was previously only available in the context menu of a component con-
nection. These are sometimes difficult to identify, especially in drawings with a lot of parts..

To facilitate the use of this function, from HiCAD 2023 SP1 the function is also available in the context menu for pipe
parts.

In this way, the selection is possible even if the component connection is hidden by other parts.
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Isometry and Pipe spool drawing

Switch off symbol alignment

When creating an isometry or pipe spool drawing, HiCAD automatically aligns the symbolic representations of the
parts.

Here is the example of the symbol of a valve installed between two flanges:

This usually looks like this in the isometry:
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Until now, there was no way to bypass this automatism. As of HiCAD 2023 SP1, it is possible to disable this auto-
matism in the Configuration Editor at Plant Engineering > Isometry and Pipe Spool Drawing > Align symbolic rep-
resentations.

If the checkbox is deactivated, the result in the above example changes as follows:
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As a rule, you should leave the automatic symbol alignment switched on (ISD default set-
ting).Exceptions can arise in individual cases, for example, if the symbol of a valve is to reflect the angle
of its installation. In this case, you must manually adjust the symbol alignment in the layout plan. Please
note that symbols are preferably rotated in groups in layout plan as well. So you may have to tem-
porarily lock parts against editing, as shown in the following image for the two flanges in the ICN.
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Connection item numbers at the end of/within pipelines

For connection item numbers it is now possible to determine whether they are to be assigned at pipeline ends or
inside a pipeline. For this purpose the tab Connections in the isometry and pipe spool drawing settings has been
extended..
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Please note:
HiCAD tries to keep item numbers once they have been assigned. If you change one of these options, it
is usually necessary to call the function Renew connection item numbers (Plant Engineering >
Isometry / Pipe Spool Drawing > Spool) to get the desired result.

Update north arrow/crosshairs

From SP1 onwards, it is possible to update the alignment of the north arrow and crosshairs on the sheet with the
function Update all. The coordinate system of the active view is used for alignment. This is especially important in
pipe spool drawing, where there is often more than one view.

The dialogues have been adapted accordingly:
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For the pipe spool drawing, crosshairs and north arrow have been added to the dialogue of the function Add/Re-
move pipe spool drawing elements:

In the following example the alignment has been changed manually in the lower view of the pipe plan. To reflect this
in the crosshairs and the north arrow, the function Update is used.
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Since only one crosshairs and one north arrow are created, if there are several views you may have to adjust both fig-
ures on the sheet using the function 2-D Part > Transform > Move > Move part, free.
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Major Release 2023 (V 2800)

New parts - Y-pipes
The parts inventory for Plant Engineering has been expanded by two variants for the part type Y-pipe:

n Y_PIPE_WELDED_60.VAA with an opening angle of 60° and

n Y_PIPE_WELDED_90.VAA with an opening angle of 90°.

The geometry of these variants - in terms of outer diameter, wall thickness and the length of the "legs" - is based on
the Y-piece YS.S from the company HECO®.
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ROHR2 interface

Loose flanges

The program system ROHR2 does not allow overlapping pipe parts since version 33. Furthermore, parts cannot be
transferred in such a way that they are only assigned to a connection point for representation. For this reason HiCAD
2023 does not transfer loose flanges to ROHR2 any more.

Naming of NTR files

When creating NTR files via the ROHR2 interface , the part name of the pipeline was used as file name until
now. From HiCAD 2023 onwards the name can be configured flexibly via HDB files.

For this purpose the following parameters are available in the Configuration Editor at Plant Engineering > ROHR2.

n Configuration of NTR file name (without HELiOS) and

n Configuration of NTR file name (with HELiOS)

The files ICN3D_DESIGNATION and ICN3D_ DESIGNATION_DB are used as ISD default settings. These are the
HDB files which are also used for the display of the column Designation of the ICN window 3D Part Structure. This
means that the part number of the pipeline is used as the file name by default or - if this is not available - the part
name.

If you want to use a different file name, you can adapt the files accordingly or use your own files. For more inform-
ation, see the topic HDX and HDB Files.

When changing the ICN3D_DESIGNATION and ICN3D_DESIGNATION_DB files, please note
that these changes also affect the ICN display!

Alternatively, you can create your own HDB files and set them in the Configuration Editor. The
files must have the extension .HDB and be located in the HiCAD sys directory.
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Example:

You want to use Designation 1 (Attribute $01) or Designation 2 (Attribute $02) of the pipeline as the names of the
NTR files, but do not want to change the ICN display. Then you could create copies of the above files, e.g. ICN_
NTR_PLANT and ICN_NTR_PLANT_DB, adapt them accordingly and then set them in the Configuration Editor:

ICN_NTR_PLANT.HDB ICN_NTR_PLANT_DB.HDB

HDB

# Conf igurat i on f i l e fo r the output o f any num-
ber o f

# H iCAD par t a t t r ibutes ins tead of the par t
name in the 3-D browser .

# TEXT - Commentary (  w i l l no t be d isp layed )

# ATTR - At t r ibute to be d isp layed

# TYP - STRING(defau l t ) , DOUBLE

# NKS - Dec imal p laces

# <H> - HiCAD par t a t t r ibute

# <E> - Features

# _BEGIN_OR_ _END_OR_ - "ODER" l ink

_BEGIN_OR_

<H>: :TEXT="" : :ATTR="$01" : : TYP="WCHAR"

<H>: :TEXT="" : :ATTR="$02" : : TYP="WCHAR"

<E>: :TEXT-
T="Te i l ename" : :ATTR="NAME" : : TYP="STRING"

_END_OR_

HDB

# Conf igurat i on f i l e fo r the output o f any number o f

# H iCAD par t a t t r ibutes ins tead of the par t name in
the 3-D browser .

# TEXT - Commentary (  w i l l no t be d isp layed )

# ATTR - At t r ibute to be d isp layed

# TYP - STRING(defau l t ) , DOUBLE

# NKS - Dec imal p laces

# <H> - HiCAD par t a t t r ibute

# <E> - Features

# _BEGIN_OR_ _END_OR_ - "ODER" l ink

_BEGIN_OR_

<T>: :TEXT-
T="Normbeze ichnung" : :ATTR="NORMBEZEICHNUNG"

<T>: :TEXT="Sachnummer" : :ATTR="HEL_
SACHNUMMER"

<D>: :TEXT="Dokumentnr . " : :ATTR="HEL_
DOKUNUMMER"

<H>: :TEXT="" : :ATTR="$01" : : TYP="WCHAR"

<H>: :TEXT="" : :ATTR="$02" : : TYP="WCHAR"

<E>: :TEXT-
T="Te i l ename" : :ATTR="NAME" : : TYP="STRING"

_END_OR_
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Load meta data

In the Part attributes dialogue window of a pipeline you can specify the

n Design pressure,

n Working pressure,

n Design temperature,

n Operating temperature and

n Density of medium

These attributes will be transferred during export via the pipeline interface.
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The catalogue System settings > System attributes has been extended accordingly for this purpose.

New Part insertion function

Straight pipes

When inserting straight pipes with the Pipe part function , from HiCAD 2023 only the option Place pipeline
on edge is available in the context menu. This function has been extended and now places bent pipelines on bent
guidelines:
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Freely placeable parts

From HiCAD 2023 onwards, for parts that can be placed freely (e.g. T-pieces or branches), selecting an edge does
not directly lead to the part being dropped. When you move the cursor near an edge, a preview is first displayed as
follows:

Now you have two options:

1. You click on the edge. Then a preview of the part is displayed as usual.
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This part can now be flexibly aligned along the edges, for example at other connections. Only when the place-
ment or connection point is selected does the insertion take place.
Alignment to other connections is also indicated graphically. If a guideline edge is selected and then another
connection, the part will be aligned to that connection. This means that if the part can be rotated around the
guideline edge so that the connection of the part and the selected connection are aligned, this rotation is sug-
gested to you. A dashed line shows you that the connections are aligned with each other.

Otherwise, the next point on the guideline edge is used for placement.
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2. If the part is to be attached directly to another connection, select the desired connection or point without clicking
the guideline edge first. The part will then be placed directly.

Immediate insertion in all similar places

If the checkbox Insertion in all suitable places is active in the dialogue on the General tab, then it is now also pos-
sible to specify whether the part is to be inserted automatically in all suitable places. A corresponding checkbox has
been added to the dialogue.

This is possible for the following part types:

n Straight pipe,

n Elbow,

n T-piece,

n Knee,

n Branch and

n Flange.

First select an appropriate position, e.g. for an elbow.

The subsequently selected part is then installed at all suitable points (also applies to knees, T-piece and branches).
For straight pipes, it is sufficient to select a point on the desired pipeline.
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Flanges are a special case. Here there are two possible applications.

1. The insertion position is the free end of a guideline.
Then the selected flange is placed at all free ends of the pipeline.

2. The insertion position is the connecting point of a flange.
Then the same flange is installed as a counterflange at all points of the pipeline that have the same insertion situ-
ation.
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Changed context menus

The function Pipe parts is now also available in the context menus for guidelines and Plant Engineering
parts.
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Down-grade Editor - Mitre cut straight pipes

The Down-grade Editor has been extended by the option Mitre cut straight pipes. If this option is selected,
straight, divisible pipes are mitred in order to place them in the down-grade.

Note that the angle for the down-grade should not be too large in this case, as the mitre necessarily causes the pipe
cross-section to deviate from the circular shape and thus no longer matches exactly the connection of the following
pipe.
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The angle for the mitre cut should not be too large, as otherwise pipe protrusions may result from the cut.

To place a pipe section in the down-grade, the Down-grade Editor now proceeds as follows:

1. For pipes that already have a mitre (e.g. because it was set by the Edit arcs function), the mitre angle is
changed.

2. If the option Cut elbows is active, the angles of elbows are adjusted.

3. If the option Mitre cut straight pipes is active, straight pipes are mitred.

4. If none of the options apply, straight pipes are bent.
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Copy, paste, mirror and clone pipelines
It is no longer absolutely necessary to copy pipelines from the pipeline planning via the corresponding function. The
function takes care to keep the part name of the pipeline unique because the generation of isometry and pipe spool
drawing require this.

n To copy and paste pipelines, you can also use the corresponding clipboard functions in the ICN:

l Copy to HiCAD clipboard
l Paste from HiCAD clipboard

When pasting from the clipboard, HiCAD takes care not to insert a pipeline below another pipeline.

n Pipelines can also be mirrored and cloned using the functions on the 3-D Standard Ribbon.

Eccentriccally inserted pipes
Up to now, straight pipes could only be inserted into other parts in such a way that the end point of the inserted pipe
ends on the centre line of the other part. As of HiCAD 2023, this restriction no longer exists.

The prerequisite is that a connecting point is added to the part into which the tube is to be inserted,
which can then act as the end point of the inserted tube. To add such a connecting point, use the func-

tionInsert connection (via Part Tools > Exchange > ...).
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The insertion can then be carried out with the function Plant Engineering > New > PipePrt > Pipe parts v26

or Plant Engineering > Guideline Tools > AutoPlace parts on guidelines .

Common use cases are top-of-pipe or bottom-of-pipe insertion. The figure above shows the top-of-pipe insertion.

In both cases, the inserted pipe leads tangentially out of the thicker pipe, with the pipe placed as close to the edge of
the thicker pipe as its wall thickness allows. In the following figure, this is indicated by the red line:

When setting the connection point freely, it is rather cumbersome to enter this point correctly manually. For this pur-
pose, the outer diameter and wall thickness of the thicker pipe and the outer diameter of the pipe to be inserted

must be calculated with each other. For this purpose, the Align connection tangentially function is available
in the context menu for connections:

Extensive information and an example can be found ion the topic Eccentrically Inserted Pipes.
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In addition, the display of connections in the isometry and in the pipe spool drawing has been extended. The addi-
tional texts TOP, BOP and EX are now displayed at the connection numbers of inserted eccentric pipes. This is the
default setting for connections which are inserted:

n top-of-pipe (TOP),

n bottom-of-pipe (BOP) or

n otherwise eccentric (EX).

You can customize this representation by modifying the corresponding FTD files:

n ISD_inserted_top.ftd,

n ISD_inserted_bop.ftd and

n ISD_inserted_ex.ftd.

Especially if you want to have the concrete coordinates displayed at such points, these three text objects have to be
adapted.
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Delete multiple selection of parts
If several parts are selected in the drawing, then these parts can now also be deleted via the context menu of the
multiple selection.

As described above, a distinction is made between parts that have been placed on a guideline and parts that have
been placed in the drawing without a guideline.

Alternatively, you can also use the DEL key to delete parts in the ICN.
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Lock parts
HiCAD offers the possibility to lock parts for other users; for example to protect it from accidental changing of parts.

These parts are marked with a corresponding symbol in the ICN.

For some Plant Engineering functions, a note is displayed in such cases to indicate the lock. The form of the mes-
sage depends on the respective function.

n In some cases, the message is displayed directly during the selection of a pipeline, for example, in the case of

the Move pipeline function.

What's new? 333 / 382

News Overview

../../../hicad3d/Content/3dreferenzierung/referenzierungsfunktionen/ref3dfkt4.htm
../rohrleitungstool/anl_rohrltool_bewegen.htm


n In other cases, a corresponding message window is displayed, e.g.:

If a pipeline is locked, the following functions display a corresponding hint directly during the selection (some only if
they are not called via context menu):

Plant Engineering > Pipeline Tools > Move

Plant Engineering > Pipeline Tools > Assign > Edit flow

Plant Engineering > Pipeline Tools > Change > Merge

Plant Engineering > Part Tools > Exchange > Connect pipe

Plant Engineering > Pipeline Tools > Assign > Change colour

Plant Engineering > Pipeline Tools > Assign > Change name

Plant Engineering > Pipeline Tools > Change > Divide

The message window appears when choosing the following functions:

Plant Engineering > Part Tools > Exchange

Plant Engineering > Pipeline Tools > Change

Plant Engineering > Part Tools > Copy > Rotate

Plant Engineering > Part Tools > Exchange > Individual

Plant Engineering > Part Tools > Delete

Plant Engineering > Pipeline Tools > Change > In only one pipeline
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The function Plant Engineering > Pipeline Tools > Change > In all pipelines handles locks by applying
the desired change to all non-locked pipelines. The locked, i.e. not modified, pipelines are named in a message:
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Bills of Materials (new ISD Report Manager)

Excel-BOM with pipe length list

For the new ISD Report Manager (from HiCAD 2023), an XML configuration file adapted for Plant Engineering is
available with the name HiCAD_Anlagenbau.rm_settings . This configuration file allows the sensible creation of bills
of materials (BOMs) of mixed model drawings.

The file is located in the HiCAD sys directory and facilitates in particular the use of a new BOM template for Excel
export. This new template HiCAD_Anlagenbau.2800.0.xlsx can also be found in the sys directory of your installation
(or as HiCAD_Anlagenbau.EN.2800.0.xlsx in the sub-folder bomtemplates).

Proceed as follows:

n To create a BOM, choose the function Drawing > Itemization/Detailing > BOM.

n In the dialogue window, select HiCAD_Anlagenbau for Configuration in the XML Format section.
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n When the BOM is displayed in the ISD Report Manager, select the Create Excel document (with template or
script function there.

n After selecting a file name, Excel will open.

In the opened file you will now find the following BOMs (as Excel tables):

Table Content

Structure list Displays all individual parts and assemblies of a product on the basis of the HiCAD part
structure, i.e. a summary of all production stages with logical relationships

Quantity list Displays the quantity per item, i.e. without further summary

Quantity sum list Shows the quantity per article, where length, area and weight are summed up

Profile totals list A grouped layout of the quantity list for articles with length

Components list A grouped layout of the quantity list without even pipes or articles without length

Bar list Similar to the profile totals list, but grouped by delivery length with remainder

Bar - Summary Basically the table headers from the bar list, so a summary of the bar list

Example:
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BOM-creation with Plant Engineering functions

Adapted configuration files for the new ISD Report Manager are also available for the Plant Engineering functions at
Plant Engineering > Evaluation:

n Entire drawing: anlagenbau_szn.rms_settings

n Active pipeline: anlagenbau_rl.rms_settings

n Total length list: anlagenbau_geslen.rms_settings

These are preset in the Plant Engineering Settings, on the Bills of Materials tab.

Furthermore, as of HiCAD 2023, only two HDB files control which attributes are transmitted to the ISD Report Man-
ager:

n rm_anl_exportszn.HDB (für Konstruktionen) und

n rm_anl_exportpart.HDB (für Teile)

These contain HiCAD part attributes only. If you need additional attributes of the HELiOS PDM system, the prepared
files
n rm_anl_exportszn_db.HDB und
n rm_anl_exportpart_db.HDB

serve as templates. You will find the files in the HiCAD sys directory. In the simplest case, it is sufficient to rename
them accordingly:

n rm_anl_exportszn_db.HDB rm_anl_exportszn.HDB

n rm_anl_exportpart_db.HDB rm_anl_exportpart.HDB

Total length attribute

Prior to HiCAD 2023, when creating the total length list using the Total length list for straight pipes func-
tion, the total length was assigned to the Quantity1 attribute (§11). This attribute did not take into account any
length unit..

As of HiCAD 2023, when creating the total length list with an rm_settings configuration file of the ISD Report
Manager, the total length will be assigned to the attribute Total length (§22). Thus, the total length is also avail-
able in the ISD Report Manager as a length with a suitable unit..
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Rotate flange connections
When installing parts with sub-part flanges, e.g. valves, if you rotate the part after insertion, these flanges will now be
rotated as well. The same applies if the AutoFlange option is activated.

This functionality is only offered by the new Part insertion function, via the old one (V26) only the valve or similar is
rotated as before. If the parts are to be rotated together, either the new Part insertion function is to be used or one
places the parts first without rotation and then uses the function Rotate part.
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HiCAD - HELiOS Head ID
As of HiCAD 2023, it is no longer possible to specify the Head IDs of articles and documents in HELiOS. This ID was
previously used by the catalogue editor and the DBPlantDataImport/PartDataAutoSync tools to find articles again.

Now, unique IDs are assigned by the variant editor itself and transferred to HELiOS during matching. These IDs are
directly visible in HELiOS, as they are not a regular article attribute.

The new IDs are only directly visible in a few places in HiCAD:

n When matching with the catalogue via the tool VarToCat, an additional table column PLANTID is inserted.

n In P+ID, the new ID becomes visible in the attribute Database article ID when assigning article data.

n After a part has been installed, the PLANTID is also found in its part attributes.
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Notes on HELiOS Updates
For an update to HELiOS 2021 (Version 2600) from a version older than 2500 a central update of the supplied
HELiOS database is required.

Since conflict may occur during the update process in case of inconsistent data stocks, you should do the following:

n Data backup before updating

Make sure that a data backup was made before carrying out the update of your HELiOS database.
For the backup, either use the HELiOS Database Creator (further information can be found in the Installation
Notes) or your SQL Server Application.
In case of any questions, or if you need any help with regard to your customized system architecture , contact
the ISD Hotline.

n Log file for update

If any conflicts occur during the update, these will be recorded in the log file HeliosDbUpdate.txt (in the system
path %appdata%\ISD Software und Systeme\HeliosDbUpdate\).
Have this file ready when contacting the ISD Hotline in case of an unsuccessful update, so that they can help
you solve the problem and make a successful update.

n New mask format

Please read all notes on the new mask format introduced with HELiOS 2020 !

n MultiCAD interfaces

If you are working with a multi-CAD interface (e.g. the HELiOS-Inventor interface), please note that before
installing an update of an older version to HELiOS 2020 (Version 2500) or higher, some adjustments may have
to be made before the update.
In this case, please contact the Consulting department of the ISD Group.
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HELiOS Desktop

Service Pack 2 2023 (V 2802)

Utilized articles
In the context of the document detail window you will find the new result list tab Utilized articles.

This shows you the article contexts stored in the model structure for the document.

In contrast to the model structure, this result list can be sorted and filtered more easily and articles can also be dis-
played consolidated, i.e. they only appear once in the result list, as is not possible in the context of the model struc-
ture due to its model tree and instance approach.

The articles listed there may deviate from the bill of materials (product structure) if, for example, you are working
with assemblies that are not BOM-relevant.

For use cases such as the release of an assembly structure, the display of used articles based on the model struc-
ture, in the results list of the document context can therefore be very helpful.
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Print locally
In the context menu of documents or in the Output tab of the document detail window you will find the new function

Print locally.

With this function you can print documents such as Office or PDF files from the HELiOS Desktop via the Windows
standard printer.

The function can also be used for a multiple selection of documents. In this way, you can print documents from a
result list in the present order without having to select them individually for printing via the HELiOS Spooler.
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Project and folder change behaviour in the Combined search
In older HELiOS versions, when working with the Combined search, you could set the behaviour of how selected pro-
jects or folders are handled when the selection is changed: Should the change of a project or folder in a search mask
also affect the other masks of the Combined search, should projects or folders be set individually on each mask, or
should inactive search masks be set independently of projects or folders?

Old procedure: Combined search > Project change behaviour

With the update to HELiOS 2023 Service Pack 2, you will find the settings for this at HELiOS Options > General,
under General Settings > Find.

This has the advantage, among other things, that this option can then also be exported / imported and made avail-
able as uniform behaviour on other computers.
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Edit workflow status: Improved dialogue
In the Edit workflow status dialogue window you can either make changes by clicking OK, which will close the win-
dow, or by clicking Apply, which will keep the dialogue window open, so that you can also set the next Workflow step
directly, if desired.
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Attribute mappings for document input
The attribute mappings for file import, which you can configureat HELiOS Options > General > HELiOS Desktop,

also apply to document input via Input > Document and for template files, and can be selected accordingly in
a pull-down menu of the Enter document dialogue.
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Import

The re-import of files via Input > Serial input > Import has been adapted to reflect possible error sources
more transparently:

If files contained in the selected XML file are not found in HELiOS during the import, you will receive a corresponding
error message before the remaining existing files are offered for re-import.

If the target document is no longer contained in the database, you will also receive a corresponding error message
when attempting a re-import:
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Central configuration for date fields and time zone
In addition to the possibility to assign an Own date/time format or the Database time format to result list areas, the
possibility to further influence the default formatting of date values in HELiOS masks has been created.

For this purpose, you will find in the HELiOS Options under General > Units and formatting the new configuration
options for Standard formatting of date with time, if applicable and Standard formatting of date without time:

The selection lists are preset with a number of frequently used formattings, which you can select accordingly. A pre-
view of the selected formatting is displayed in the field to the right of the selection/input field.

You can also make your own entries for the date/time formatting in the field, as long as you use a correct syntax in
line with the date and time setting in result lists.

Changing the formatting will then have an effect in two places:

n The display of date fields in masks

n The display of date/time fields in result lists where the Date/time display is set to Standard.

The new setting Standard is also the new default for date/time fields in result lists, which applies to new installations
of HELiOS.

The desired Time zone (in which date/time display takes place) can be selected here via a combined list if required.

The default time zone is the local time set in your operating system.

If the set time zone supports a distinction between winter and summer time, this is automatically taken into account.
(I.e. in Germany UTC+1 (winter time) would automatically change to UTC+2 (summer time) on the corresponding
date).
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Performance
Especially in the area of the product structure tree and when generating HDE reports using many multilingual attrib-
utes, a significant performance increase of the HELiOS Database could be achieved with Service Pack 2.
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Service Pack 1 2023 (V 2801)

Optimised search result lists
In order to increase performance, only objects for which the logged-in user has corresponding read rights are dis-
played in result lists of HELiOS objects (articles, documents, projects, folders, pipe classes and user-defined
objects).

The sorting of result lists has been accelerated many times over due to a smaller number of internal queries, which
also improves the creation of result lists in particular, in which case the database has a somewhat higher latency.

Earlier database options, with which the display of objects without access rights could be set, are thus no longer
applicable.

Errors during printing or export
Errors that prevent documents from being printed or exported are displayed in the corresponding dialogue below the
document result list when you click OK.

Double-clicking on an error line also marks the corresponding document in the result list above.

Example: If the dialogue returns the error description "File for document is not in the Vault", it is recommended to
load the document once into the workspace.
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Context menu entry for saving to HELiOS
After an installation of HELiOS, the Windows context menu has been extended by default by the menu item Save to
HELiOS.

This makes it possible to save documents in the HELiOS database in connection with HELiOSScan in this simple
way if the automatic transfer did not take place (e.g. by cancelling the document dialogue or due to an error).

Under certain circumstances this feature is not desired. Therefore, as of version 2801 of HELiOS, it is no longer auto-
matically set up during a new installation. If the context menu entry is to be created in the process, you can activate
the checkbox Create context menu entry in Windows Explorer for saving files in HELiOS in the General tab of the
Extended settings installation step dialogue.

For update installations of older versions, the option is active and can be deactivated at the same point if desired.
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New data type for List attributes
The new data type "LIST" is available for list attributes in the Description of attributes with the help of the Attribute
Editor.

Under Selection list you can differentiate between a Predefined list and a free list (Option: None).

The separate area in the attribute editor, in which list attributes were displayed separately in earlier versions, is no
longer necessary.
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Installation DVD: Changed path of the default database
When importing the HELiOS standard database with the HELiOS Database Creator, please note that its path on the
installation DVD has changed.

As of HELiOS 2023 Service Pack 1, you will find the database there at ...\Databases\en.
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Major Release 2023 (V 2800)

Units in the context menu
When right-clicking in result list columns of (float) attributes with unit category, the context menu shows you the cor-
responding unit, with designation and abbreviation.

Copy and paste attribute values with unit category

The behavior of copying and pasting attributes with unit category using the Copy attribute value and
Paste attribute value context menu functions has been further improved.

Please read the corresponding notes.
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Export and import files
Both the export of HELiOS documents and the import of files to HELiOS have been revised.

In the export dialogue you have e.g. extended setting and attribute assignment options for the generation of file
names.

In the extended export dialogue you can de-/reselect linked objects and their contexts if necessary.

The file import, in turn, has been adapted to the common use case of re-importing exported HELiOS documents.
The simple selection of an XML file belonging to the export offers all documents in a clearly arranged import dia-
logue.

The previously necessary editing of the system file hel_fileimport.ini is no longer necessary. However, configurations
of older HELiOS versions stored there are still taken into account during the export.

Please also note the changes that result from this at HELiOS Options > Import/Export.
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Print documents: File name configuration
As with the new options for attribute mappings when generating file names for exporting files, you can also configure
the output file name by means of an attribute mapping when printing neutral formats in files (e.g. when outputting
PDFs via the HELiOS Spooler).

The contents of the hel_fileprint .ini system file previously used for this purpose are copied to the attribute mappings
when the file is first called. After that, the old ini file is no longer needed, but it is not automatically deleted from the
system.

Index up-to-dateness
In result lists, the column Index up-to-dateness indicates by a symbol whether it is the most recent version index of
a HELiOS object.

Most recent versions of objects are indicated by a green dot, old versions by an orange dot.
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HELiOS Options: Default configuration for product structure output
From HELiOS 2023 and/or HiCAD 2023 onwards, a new version of the ISD Report Manager will be introduced.

The old version of the Report Manager will initially remain installed in the system in parallel.

You can control which Report Manager version is used for the product structure output in the Database Options. In
the pull-down menu of the Default configuration for product structure output option, you can select which RMS or
RM_SETTINGS file is to be used for the output of the product structure with the Report Manager.

In the default delivery database (i.e. for new installations of HELiOS 2023) the template PRODUCT_ISD.RM_
SETTINGS is set. This new template file calls the new ISD Report Manager during data transfer.

However, existing settings of existing databases will not be overwritten by an update installation. A parts list template
(of file type .RMS) previously defined as default configuration is retained and still uses the old Report Manager.

In this situation, it is recommended to switch to the new Report Manager by using a template file of the type .RM_
SETTINGS.

Please note:

For printing result lists, the new ISD Report Manager is already used.

Detailed information on the new ISD Report Manager can be found here.
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Mark-up and Redlining
Note that when working with the extended markup and redlining functionality of HiCAD and HELiOS, the redlining
tool HiRedLine is only installed by a combined HiCAD/HELiOS installation. In a standalone installation of HELiOS
Desktop the tool is not available.

A failed call will return a corresponding system message.
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HELiOS in HiCAD

Service Pack 2 2023 (V 2802)

Automatic removal of documents from the HELiOS workspace
When HiCAD is closed, all documents not being processed are removed from the HELiOS workspace.

This also applies to neutral formats (e.g. PDF files) that were loaded into HiCAD via a HELiOS context menu.

Files with local changes (which have not yet been transferred to the HELiOS database) are not automatically
removed.

Message if HiCAD Integration module is missing
If, when starting HiCAD, a HiCAD basic module other than "HiCAD VI/AV" and a HELiOS basic module other than
"HELiOS Viewer" is selected during licence selection, while no licence for the "HiCAD Integration Module" can be
found in the system, then only viewing functionalities are available in HELiOS, regardless of the selected basic mod-
ule. You will receive a corresponding message.
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IFC interface: Show HELiOS attributes
In the attribute mapping configuration for the data transformation between IFC and HiCAD, you can also export
HELiOS attributes from Service Pack 2.

In the Configuration Editor at Interfaces > IFC > Default options for export > Attribute mapping configuration >
Define you will find the new checkbox Display HELiOS attributes.

If this is activated, HELiOS attributes are also available for mapping in the pull-down menu of the source attributes.

For further information, please refer to the HiCAD Help for Interfaces.
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Service Pack 1 2023 (V 2801)

Deleting the item numbers when deriving
If you use HiCAD and HELiOS in the context of a project-specific working method in which the referencing option
For main parts and sub-parts is set in the Configuration Editor at System settings > Referencing > Synchronize
item numbers/part attributes when updating file, item numbers for derived parts are automatically deleted when the
part structure is derived via the CAD structure or when a derivation is created via the HELiOS Desktop.

Open STEP file via HELiOS in HiCAD
When opening an object for editing in HELiOS with the Open+Edit function, it is intended that documents are
opened for editing in the corresponding application. For example, .SZA files are opened in HiCAD.

This also applies to other formats such as STEP files (.stp) if they have been assigned HiCAD as the opening applic-
ation via the Windows properties.

Under such conditions, if a STEP file is opened from HELiOS for editing, it is loaded for editing in HiCAD if HiCAD is
already running, or HiCAD is started for editing the file if necessary.

Of course, opening a STEP file in HiCAD also works outside the HELiOS context by double-clicking in Windows
Explorer.
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New article class for part type Welding neck
If you use HELiOS in connection with the HiCAD module Plant Engineering, a new HELiOS article class is available
from Version 2023 SP1 onwards with the new part type Welding neck.

You must inform HELiOS of the new classification for welding neck flanges. This is done via the programme
DBPlantDataImport.exe, which you will find in the HiCAD exe directory. There you click on the button Update
HELiOS for Plant Engineering.

364 / 382 What's new?

HELiOS in HiCAD



Afterwards you can use the HELiOS search mask in your HELiOS Desktop.

What's new? 365 / 382

News Overview



Major Release 2023 (V 2800)

Transfer of the HiCAD sheet structure
When saving SZA files to HELiOS, the HiCAD sheet structure is also transferred to HELiOS. This contains the num-
ber of sheets and the Type, Sheet number and Sheet name for each sheet.

The sheet structure of SZA documents can then be viewed in the document master on the tab Model structure:

When printing documents via HELiOS, this sheet structure is also displayed accordingly for the selection of the sheet
area to be printed:

Please note that when updating to HELiOS 2023 (V. 2800) in combination with a HiCAD version older than
HiCAD 2023 (V 2800), printing of SZA files via HELiOS is no longer possible due to this change.
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In this case, you will receive a corresponding message during the installation:

A migration of inventory data can then be automatically carried out when HiCAD is started with HELiOS.

This applies to the following HiCAD Versions:

n HiCAD 2021: As of Version 2601.6

n HiCAD 2022: As of Version 2702.3

n HiCAD 2023: As of Version 2800.0

HiCAD-specific HELiOS settings moved to Configuration Editor
As of version 2800, HiCAD manages some attributes that previously had to be defined in the HELiOS settings.
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A: up to HiCAD / HELiOS 2702 (HELiOS Options > Datenbank), B: from HiCAD / HELiOS 2800 onwards
(ISD Configuration Editor: PDM > HiCAD-HELiOS interface).

When updating the database scheme you will receive the following message:
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New ISD Report Manager
As of HELiOS 2023 / HiCAD 2023, a new version of the ISD Report Manager will be introduced for the issuance of
bills of materials, which is much simpler and more convenient, especially when configuring BOM templates.

Detailed information can be found in the Online Help chapter for the ISD Report Manager.

HiCAD - HELiOS Head ID
As of HiCAD 2023, it is no longer possible to specify the Head IDs of articles and documents in HELiOS. This ID was
previously used by the catalogue editor and the DBPlantDataImport/PartDataAutoSync tools to find articles again.

Now, unique IDs are assigned by the variant editor itself and transferred to HELiOS during matching. These IDs are
directly visible in HELiOS, as they are not a regular article attribute.

The new IDs are only directly visible in a few places in HiCAD:

n When matching with the catalogue via the tool VarToCat, an additional table column PLANTID is inserted.

n In P+ID, the new ID becomes visible in the attribute Database article ID when assigning article data.

n After a part has been installed, the PLANTID is also found in its part attributes.
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HELiOS Spooler

Service Pack 2 2023 (V 2802)

Performance
With Service Pack 2 a further performance increase of the HELiOS Spooler could be achieved.

The optimization becomes especially obvious when performing and displaying a very high number of active print/-
convert jobs.

Result list attribute to mark documents being updated by Spooler
In the user interface configuration of HELiOS document result list you will find the new attribute Update status (VA_
DocumentPendingUpdateJob).
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If the column has been added to result lists, it marks there, if applicable, documents that are currently being

updated by the Spooler and therefore cannot be currently displayed with a symbol.

PDF printing via Windows
As of Service Pack 2, the Spooler supports the possibility to use the Windows functionality Microsoft Print to PDF for
printing to PDF.

This output may be faster and an installation and setup of the ISD FilePrinter PS may not be necessary.
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Service Pack 1 2023 (V 2801)

Performance
By loading the document structure directly on the Spooler Server instead of from the Client side, a significant
increase in performance could be achieved during printing/conversion.

372 / 382 What's new?

HELiOS Spooler



Major Release 2023 (V 2800)

Support of RM3/ RMA files discontinued
Note that printing/converting RM3/ RMA files is no longer supported by the HELiOS Spooler as of Version 2800.

Server Monitor
With the help of the Server Monitor tool, you can monitor the runnability of HELiOS server applications such as the
Vault Server or the HELiOS Spooler and make any necessary adjustments in the event of problems.

HELiOS Task Starter
The new HELiOS Task Starter tool can be used for automatically re-starting the HELiOS Spooler after it has been
closed, or after a possible crash.
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HELiOS MS Office Interface

Service Pack 2 (V. 2802)

Combined search

Calling the functions Open + Edit or Open, read-only from the menu of a HELiOS-Office interface and
Attach document in an active Outlook mail opens the Combined search mask search of HELiOS as of Service Pack
2.
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Outlook: Attach preselected document
In addition to inserting E-mail attachments via the HELiOS function Find document, you can also attach a document

that you have previously marked for this purpose via the context menu function Preselect document, e.g. in a

result list of the HELiOS Desktop, by simply clicking on Attach preselected document in the context of an act-
ive E-mail.
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HELiOS Vault Server

Service Pack 2 2023 (V 2802)

Server Monitor: Communication port for article synchronisation during installation
The Port via which the Server Monitor communicates with HELiOS Article Synchronisation with ECAD/CAE applic-
ations such as EPLAN or Zuken E3 can be defined not only in the settings of the Server Monitor tool, but also during
the installation process of the part synchronisation.

The default port number is still 35727.
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Server Monitor: HELiOS Article Synchronization
The Server Monitor has been extended to include the option of monitoring the HELiOS Article Synchronization ser-
vice for HELiOS interfaces to ECAD/CAE applications such as EPLAN or Zuken E3.
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Server Monitor
With the help of the Server Monitor tool, you can monitor the runnability of HELiOS server applications such as the
Vault Server or the HELiOS Spooler and make any necessary adjustments in the event of problems.
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Legal notes

© 2023 ISD ® Software und Systeme GmbH. All rights reserved.
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All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers.
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